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First things first
We would like to thank you for making Acer handheld your choice for your handheld 
needs. Your new sleek Acer handheld is packed with user-friendly applications and 
utilities designed to make organising work-related information and synchronising it 
with your personal activities a time-efficient task. We hope you enjoy using your Acer 
handheld as much as we enjoyed creating it for you. 

Your guides
To help you use your handheld, we have designed a set of guides:

• First off, the Just for Starters poster helps you get started with setting up 
your handheld.

• This online Acer s50 and s60 Handhelds User Manual introduces you to 
the many ways your handheld can help you organise and manage both 
business and personal information so as to make your everyday activities a 
more productive and satisfying experience. This User Manual provides clear 
and comprehensive information about your handheld, so read it thoroughly.

• The handy Acer s50 and s60 Handhelds Quick Guide useful for taking a 
quick reference glance on your handheld’s basic functionalities. Keep it on 
your desktop or in your backpack for easy access. This Quick Guide is also 
available in PDF format on the Acer s50 and s60 Handhelds Installation 
CD.

• A Graffiti® pocket reference card to remind you of the standard writing 
strokes of this powerful writing software.

For more information about our products, services, and support information, please 
visit our web site at http://www.acer.com/.

http://www.acer.com
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Maintaining your Acer handheld
This section provides information on the following:

• Proper care and usage of your handheld
• Resetting your handheld

Proper care and usage of your handheld
Your handheld’s rugged and tough construction is designed to provide you with years 
of reliable and trouble-free service. Observing the following general maintenance 
procedures will help ensure this:

1 Take care not to scratch the screen of your handheld. Keep the screen clean. When 
working with your handheld, use the supplied stylus or plastic-tipped pens intended 
for use with touch-sensitive screens. Never use an actual pen or pencil or other sharp 
object on the screen surface. 

2 Your handheld is not waterproof and should not be exposed to rain or moisture. 
Under extreme conditions, water may enter the circuitry through the front panel 
buttons. In general, treat your handheld as you would a pocket calculator or other 
small electronic device.

3 Take care not to drop your handheld or subject it to any strong impact. Do not place 
your handheld in your back pocket; if you sit on it, you may damage it. 

4 Protect your handheld from temperature extremes. For example, do not leave your 
handheld on the dashboard of a car on a hot day or on a day when temperatures are 
below the freezing point. Also, keep it away from heaters and other sources of heat. 

5 Do not use or store your handheld in any location that is extremely dusty, damp or 
wet. 

6 Use a soft, damp cloth to clean your handheld. If the surface of the screen becomes 
soiled, clean it with a soft cloth moistened with diluted window-cleaning solution.

Battery considerations
Please note the following considerations for the battery in your handheld.

• Under normal conditions, your handheld battery should remain charged by 
placing it in the cradle for just a few minutes each day. You can conserve 
battery life by minimising the use of the backlight feature and changing the 
the Auto-off setting that automatically turns off the handheld after a period 
of inactivity. For more information on the Auto-off setting, refer to "Setting 
the Auto-off interval time" on page 247.

• If the battery becomes low in the course of normal use, an alert appears on 
the handheld screen indicating low battery status. If this alert appears, 
perform a HotSync operation to back up your data; then leave your handheld 
in the cradle to recharge the unit. This will prevent accidental data loss. 

• If the battery drains to the point where your handheld does not operate, it 
stores your data safely for about a week. In this case, there is enough residual 
energy in the battery to store the data, but not enough to turn on your 
handheld. If your handheld does not turn on when you press the power 
button, you should recharge your unit immediately. 

• If your battery drains and you have the unit in an uncharged state for an 
extended period of time, you can lose all the data stored in it. 
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• There are no serviceable parts inside your handheld so do not attempt to 
open the unit. 

• If you ever dispose of your handheld, please dispose it without damaging the 
environment. Take your handheld to the nearest environmental recycling 
center.

Assigning security options
The Security application in your handheld lets you set options to protect entries from 
unauthorised users in a variety of ways:

The security application lets you: 

• Mask or hide entries you have defined as private. 
– The Mask option displays a gray bar over private records.
– The Hide option completely hides private records. 

• Assign a password to viewing options to enhance security. 
– Assigning a password requires you to enter a password before private 

entries can be viewed. 
– Not assigning a password lets you view private entries when you select 

Show Records from the Security dialog box. 
• Lock and turn off your handheld so that a password must be entered before 

you can use the device again. 
• Hide records that you have defined as private, with or without a password. 

– Without a password, private records are hidden until you set the Security 
application to display them. 

– With a password, you must enter the password to view the private 
entries.

For more information on how to set these security features, refer to "Security" on 
page 16. 
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 1

1 Entering data in your 
Acer handheld
You can enter data into your handheld in several ways:

• Using Graffiti
• Using the onscreen keyboard
• Beaming data 

Entering data using Graffiti 
You can use Graffiti writing commands to create letters, numbers, punctuation, and 
symbols. 

The Graffiti alphabet
Draw Graffiti letters using the following strokes.

Letter Strokes Letter Strokes

A N

B O

C P

D Q

E R

F S

G T

H U

I V
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To write Graffiti letters
1 Tap the screen where you want to write letters, for example, on a line next to a time 

in Date Book. 

NOTE: A blinking cursor must appear onscreen above the Graffiti writing before you can 
begin writing text. 

2 Refer to the Graffiti alphabet table to find the stroke shape for the letter you want to 
write. For example, the stroke shown below creates the letter n. 

You use the same shape to create both the uppercase and lowercase version of a 
letter.

3 Position the stylus in the left hand side of the Graffiti writing area. 

4 Start your stroke at the heavy dot, and draw the stroke shape as it appears in the 
tables.

5 Lift the stylus from the screen at the end of the stroke shape.

Your handheld recognises your stroke immediately and displays the letter at the 
insertion point onscreen. As soon as you lift the stylus from the screen, you can begin 
the stroke for the next character you want to write.

Graffiti writing automatically capitalises the first letter of a new record or sentence. 
To write additional capital letters, you must first write the Caps Shift stroke to shift to 

J W

K X

L Y

M Z

Space Backspace

Carriage
Return

Period Tap twice.

Start stroke at 
heavy dot.

Lift stylus here.
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Caps Lock mode— just as you press the Shift key on a keyboard—and then write the 
desired character stroke.

When Caps Shift is active, an Up arrow appears in the lower right corner of the 
handheld screen.

If you accidentally activate the Caps Shift, draw the Backspace stroke to cancel it. 

To write capital letters:
1 Choose from the following options:

• To enter a single capital letter, write the Caps Shift stroke. Then write the 
character stroke. 

• To enter all capital letters (Caps Lock), write the Caps Lock stroke, as shown 
below. All subsequent letters are capitalised. 

2 To return to lowercase or release the Caps Lock, draw the Caps Shift stroke again.

The Graffiti numbers
Draw Graffiti numbers using the following strokes.

Caps Shift

Caps Shift

Caps Lock

Caps Lock

Number Strokes Number Strokes

0 5

1 6

2 7

3 8

4 9
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To write Graffiti numbers
1 Tap the screen where you want to write numbers.

NOTE: A blinking cursor must appear onscreen above the Graffiti writing before you can 
begin writing numbers. 

2 Refer to the Graffiti number table to find the stroke shape for the number you want 
to write. For example, the stroke shown below creates the number 3.

3 Position the stylus in the right hand side of the Graffiti writing area. 

4 Start your stroke at the heavy dot, and draw the stroke shape as it appears in the 
tables.

5 Lift the stylus from the screen at the end of the stroke shape.

Your handheld recognises your stroke immediately and displays the number at the 
insertion point onscreen. As soon as you lift the stylus from the screen, you can begin 
the stroke for the next character you want to write.

The Graffiti punctuation marks
You can create any punctuation symbol available from a standard keyboard using 
Graffiti writing. 

All punctuation marks begin with a single tap on the Graffiti writing area. This tap 
activates the Punctuation Shift, indicated by a dot displayed above the writing area. 
The next stroke you make with the stylus creates a punctuation mark. When 
Punctuation Shift is active, you can write a symbol stroke on either side of the Graffiti 
writing area (the letter or number side). 

Create punctuation marks using the following strokes:

Lift stylus here.

Start stroke at 
heavy dot.

Punctuation 
mark

Stroke Punctuation 
mark

Stroke

Period
.

Dash
—

Comma
,

Left Paren
(

Apostrophe
'

Right Paren
)

Punctuation Shift
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Additional Graffiti punctuation marks include the following:

The Graffiti symbols and extended characters

Draw symbols or extended characters using the following strokes:

The Graffiti accented characters
To draw accented characters, you first draw the stroke for the letter, and then draw 
the accent stroke. Graffiti writing then adds the accent to the letter.

For example, the following illustration shows the strokes required to draw an 
accented e.

Using these accent strokes, you can write the following accented letters:

Question
?

Slash
/

Exclamation
!

Dollar
$

Symbol
Shift

@     #     %     ^      &    *     <     >      –     +      =      | 

\      {      }     [       ]     ~     `         ;     :      "      tab

Symbol Shift

•                           , , ,, , .,

+ ± X : = =c Y

? !

ƒ ∅

= e
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à   á   â   ã   ä   å   è   é   ê   ì   í   î   ï   ò   ó   ô   õ   ö   ù   ú   û   ü   ÿ   D   ñ

The Graffiti non-English characters
You can write the following characters in the lowercase alphabet mode without 
special punctuation or shifting. You must write these non-English characters in the 
left side of the Graffiti writing area.

Graffiti navigation strokes
Graffiti writing includes additional strokes for navigating within text or fields in your 
applications. 

Using Graffiti ShortCuts
Graffiti ShortCuts let you easily enter commonly used words and phrases. You can 
create ShortCuts of up to 45 character using the ShortCut preferences. Refer to 
"ShortCuts preferences" on page 268 for detailed instructions on how to create a 
ShortCut.

Command Stroke

Move cursor right

Move cursor left

Previous field
(Address Book only)

Next Field
(Address Book only)

Open Address 
Record

(Address Book only)

a         a       a        a        a       a

c ae
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Predefined Graffiti ShortCuts
Your handheld includes the following predefined Graffiti ShortCuts for common 
entries. 

To use a ShortCut
Draw the ShortCut stroke followed by the ShortCut character(s). 

When you draw the ShortCut stroke, the ShortCut symbol appears at the insertion 
point.

To edit a ShortCut:

1 Tap the Applications icon .

2 In the All or System screen, tap the Prefs icon .

3 Tap the pick list in the upper right corner of the Preferences screen, then select 
ShortCut. 

4 Tap the ShortCut you want to edit.

5 Tap Edit.

6 Make the changes you want.

7 Tap OK.

To delete a ShortCut

1 Tap the Applications icon .

2 In the All or System screen, tap the Prefs icon .

3 Tap the pick list in the upper right corner of the Preferences screen, then select 
ShortCut. 

4 Tap the ShortCut you want to delete.

Entry ShortCut

Date stamp ds

Time stamp ts

Date/time stamp dts

Meeting me

Breakfast br

Lunch lu

Dinner di

ShortCut
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5 Tap Delete. 

6 Tap Yes.

Graffiti tips
When using Graffiti, keep the following tips in mind:

• For greater accuracy, draw letters with large strokes; strokes that nearly fill 
the Graffiti writing area are easily interpreted. 

• To delete characters, set the insertion point to the right of the character you 
want to delete, and draw the Backspace stroke (a line from right to left) in 
the Graffiti writing area.

• Write at natural speed. Writing too slowly can produce errors.
• Do not write at an angle. Vertical strokes should be parallel to the sides of 

the Graffiti writing area.
• When letters and numbers can be written using two different strokes, use the 

one that’s easiest for you. 
• Press firmly.

Using the onscreen keyboard
You can open the onscreen keyboard anytime you need to enter text or numbers on 
your handheld. 

NOTE: You can enter Graffiti characters while using the onscreen keyboard. 

To use the onscreen keyboard
1 Open any application (such as Address Book). 

2 Tap any record, or tap New.

3 Choose one of the following to display the alphabetic or numeric keyboard:

• Tap  on the Graffiti writing area to display the alphabetic keyboard. 

• Tap  on the Graffiti writing area to display the numeric keyboard. 

TIP: To select either keyboard, tap the Menu icon and then tap Edit. Tap Keyboard, and 
then select an option. 

4 Tap the desired characters or numbers.

Tap here to display the
alphabetic keyboard.

Tap here to display the 
numeric keyboard.
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5 Tap Done to enter the text or numbers.

Beaming data
Your handheld is equipped with an infrared (IR) port that you can use to beam 
information to another Palm OS handheld that is close by and also has an IR port. The 
IR port is located on the top part of your handheld, indicated by the Infrared icon 

, behind the small dark shield. 

Refer to "8 Beaming information" on page 207 for more information on beaming 
procedures.

Backspace

Carriage returnCaps Lock

Caps Shift

Tap here to display
alphabetic keyboard

Tap here to display
numeric keyboard.

Tap here to display
international keyboard.

InternationalNumeric

Alphabetic
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2 Managing your 
applications

Using Applications Launcher
By default, Applications Launcher displays all the available applications installed on 
the internal memory of your handheld. You can choose to display only selected 
applications by arranging applications into categories. 

NOTE: For instructions on how to display the applications stored in a Memory Stick, refer to 
"Switching memory source" on the Acer s50 and s60 Handhelds Quick Guide.

To open Applications Launcher

• Tap the Applications icon . 
The All category of Applications Launcher appears.

NOTE: The first time you launch Applications Launcher, it will display the All screen. If the 
Remember Last Category preference option is selected, next time you launch Applications 
Launcher, it will open in the last screen it was in from its last session. To set this option, refer 
to "Displaying the last selected category of applications" on page 15.

In addition to providing a way for you to open applications, Applications Launcher 
also displays the current time, battery level, and the category of the displayed 
applications. 
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Categorising applications
The category feature enables you to manage the number of application icons that 
appear in the Applications Launcher screen. You can assign an application to a 
category and then display a single category or all your applications.

NOTE: When you have a Memory Stick properly seated in the Memory Stick slot, the last 
item in the category pick list refers to the Memory Stick. 

To categorise an application 

1 Tap the Menu icon . 

2 From the App menu, tap Category.
 

3 Tap the pick list next to an application name to select a category.

4 Tap Done.

Tap here.

Tap here.
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To create a new category
1 Do either of the following to display the Edit Categories screen: 

• In the Category screen, tap any of the pick lists, then select Edit Categories.
• In the Applications Launcher screen, tap the category pick list on the 

upper-right corner of the screen, then select Edit Categories.
2 In the Edit Categories screen, tap New. 

3 In the New Category screen, enter a new category name.

NOTE: Category names are case-sensitive. You can have categories named 'GRAPHICS' and 
'graphics’ at the same time.

4 Tap OK.

To display applications by category: 
• In Applications Launcher, do one of the following:

– Tap the Applications icon  repeatedly to cycle through all the 
categories.

– Tap the pick list in the upper right corner of the screen; then tap the 
category you want to display.

Changing the Applications Launcher display
By default, Applications Launcher displays applications as icons. As an alternative, you 
can display applications in a list format. 

To change the view of applications 

1 Tap the Menu icon . 

Tap here.
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2 From the Options menu, tap Preferences.

3 In the Preferences dialog box, tap the View By pick list, and then tap List.

4 Tap OK. 

Icons in the Applications Launcher screen will now be shown in a list format.

Tap here.

Tap here.
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Displaying the last selected category of applications
The first time you launch Applications Launcher, it will display the All screen. If the 
Remember Last Category preference option is selected, next time you launch 
Applications Launcher, it will open in the last screen it was in from its last session. 

To display the last selected category of applications

1 Tap the Menu icon . 

2 From the Options menu, tap Preferences.

3 In the Preferences dialog box, tap Remember Last Category.

4 Tap OK. 

Each time you return to Applications Launcher, the category of the last application 
you opened is displayed.

Setting preferences for applications
You can set preferences for individual applications in the Preferences dialog box. This 
will allow you to customise your applications to fit your work methods. 

NOTE: Not all applications have preferences settings. 

To set preferences for an application
1 Open an application. 

2 Tap the Menu icon . 

3 From the Options menu, select Preferences.

4 Enter the desired preference settings. 

5 Tap OK.

Select check box.
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Security
The Security application in your handheld allows you to prevent unauthorised access to 
your records by setting such entries as private records. Private records remain visible 
and accessible until you select the security setting Hide Records.

NOTE: You can set records as private in all basic applications, except Mail.

You can mask or hide private records. When you mask private records, a gray 

placeholder appears where the record would normally be displayed and a Lock icon  
is visible opposite the masked entry; when you hide records, they are not visible 
anywhere in the list.

You can mask or hide records without assigning a password, or you can assign a 
password if you want records to remain masked or hidden until a password is entered.

To make a record private
1 Open one of the basic applications (except Mail), then display the entry you want to 

make private for editing. 

2 Tap Details.

3 Tap the Private check box. 

4 Tap OK. 

An alert box appears. 

5 Tap OK.

To mask a private record

1 From within any basic application you have a private record in, tap the Menu icon . 

2 From the Options menu, tap Security to display the Change Security dialog box. 

3 Tap the Current Privacy pick list. 

Tap here.
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4 Tap Mask Records.

5 Tap OK.

The Mask Records screen appears.
 

6 Tap OK. 

To mask all private records

1 In Applications Launcher, tap the Security icon  to display the Security screen.

Tap here.

Tap here.
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2 From the Current Privacy pick list, tap Mask Records.

3 Open one of the basic applications (except Mail) and view a record. 

Records marked as private are masked with a gray bar and are marked with the 
Lock icon .

To hide a private record

1 From within any private record, tap the Menu icon . 

2 From the Options menu, tap Security. 

3 Tap the Current Privacy pick list. 

Tap here.
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4 Tap Hide Records.

5 Tap OK.

The Hide Records screen appears.

6 Tap OK.

To hide all private records

1 In Applications Launcher, tap the Security icon  to display the Security screen.

Tap here.

Tap here.
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2 From the Current Privacy pick list, tap Hide Records.

3 Open one of the basic applications (except Mail). 

Records marked as private are not anymore displayed. 

Displaying private records
Using the Security application, you can also display private records that have been 
previously masked or hidden.

NOTE: If you have assigned a password to your device, you must enter it before 
private records are displayed. 

To unmask individual records
1 Tap a masked record. 

If you do not have a password, a masked record becomes visible.

If you have a password, the Show Private Records dialog box appears. Go to step 2.

2 Enter your password.

Tap here.
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3 Tap OK. 

To display all private records

1 In Applications Launcher, tap the Security icon  to display the Security screen.

2 From the Current Privacy pick list, tap Show Records.

If you do not have a password, masked and hidden records become visible. 

If you have a password, the Show Private Records dialog box appears. Go to step 3.

3 Enter your password.

4 Tap OK. 

Assigning and editing passwords
You can assign a password to protect your private records and to lock your handheld.

Once you define a password, you can change or remove it at any time. You must enter 
the current password before you can change or remove it. 

If you have forgotten your password, you can delete it. Refer to "Recovering from a 
forgotten password" on page 27.

Tap here.
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To assign a password

1 In Applications Launcher, tap the Security icon . 

2 Tap the Password box. 

3 Enter a password.

NOTE: You have the option to enter a specific text on the Hint line to help you remember 
your password if you forget it.

4 Tap OK. 

Another Password screen will appear for confirmation of the new password. 

5 Reenter the password. 

6 Tap OK.

To change or remove a password

1 In Applications Launcher, tap the Security icon . 

2 Tap the Password box.

A password prompt appears. 

Tap here.
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3 Enter your current password. 

4 Tap OK.

The screen below appears. 

5 Choose from the following options:

• To change your password and hint, enter a new password and hint, and tap 
OK.

• To remove your password, tap Unassign. 

Locking your handheld 
You can lock your handheld with a password to protect information. This password 
must then be entered to operate your handheld and gain access to the information 
stored in it. 

Locking your handheld automatically
You can set your password to lock automatically when any of the following occur:

• When you turn off the power
• At a time you specify

Tap here.
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• After a period of inactivity you specify

To lock your handheld when you turn it off:

1 In Applications Launcher, tap the Security icon . 

2 Tap the Auto Lock Handheld box. 

A password prompt appears.

3 Enter your current password.

The Lock Handheld screen appears.

4 Tap On power off.

5 Tap OK. 

To set your handheld to lock at a preset time: 

1 In Applications Launcher, tap the Security icon . 

2 Tap the Auto Lock Handheld box. 

A password prompt appears.

3 Enter your current password.

The Lock Handheld screen appears.

Tap here.
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4 Tap At a preset time.

5 In the Set Time screen, tap the arrows to set the time.

6 Tap OK.

The time you set for will be indicated on the Lock Handheld Screen.

To set your handheld to lock after a period of inactivity: 

1 In Applications Launcher, tap the Security icon . 

2 Tap the Auto Lock Handheld box. 

A password prompt appears.

3 Enter your current password.

The Lock Handheld screen appears.

Tap here.
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4 Tap After a preset delay.

5 Set the period of inactivity by entering the length of time and selecting a time unit. 

6 Tap OK.

Locking your handheld manually
You can turn off and lock your handheld manually using the Turn Off & Lock option. A 
password is required before using this option so set first a password as described in 
"To assign a password" on page 22 before performing the procedures below. 

To turn off and lock your handheld manually:

1 In Applications Launcher, tap the Security icon .

2 Tap the Lock & Turn Off button. 

Tap here.

Tap to select the unit of time - Minute(s) or Hour(s)

Enter the number of time units here. 
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3 In the System Lockout screen, tap the Off & Lock button. 

4 To start your handheld, turn it on and then enter your password on the prompt.

5 Tap OK. 

Recovering from a forgotten password
If you forget the password, your handheld will present the hint you have set (if you 
set one) to help you remember your password. If you still cannot remember your 
password, you must perform a hard reset to resume using your handheld. Performing 
a hard reset deletes all the records in your handheld; however, you can restore all 
synchronised data at the next HotSync operation. 

For instructions on how to perform a hard reset, refer to "Performing a hard reset" on 
the Acer s50 and s60 Handhelds Quick Guide; for more information on HotSync 
operations, refer to "9 Exchanging and updating data using HotSync operations" on 
page 213.

Tap here.
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If you forget your password when your handheld is unlocked, your you can delete the 
forgotten password. Deleting a forgotten password also deletes all entries and files 
marked as Private.

IMPORTANT: If you synchronise your handheld with your computer before deleting a 
forgotten password, private entries are restored the next time you perform a HotSync 
operation. 

To remove a forgotten password:

1 In Applications Launcher, tap the Security icon . 

2 Tap the Password box. 

3 In the Password dialog box, tap Lost Password. 

4 Tap Yes. 

Tap here.
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3 Working with your 
basic applications
Your handheld includes the following basic applications:

• Date Book
• Address Book
• To Do List
• Memo Pad
• Calculator
• Mail - refer to "7 Managing your desktop email" on page 177 for more 

information on using this application
This chapter is organised into two sections, namely: 

• Common application tasks
• Application-specific tasks

Common applications tasks
The tasks described in this section use the term record to refer to an individual item in 
any of the basic applications, for example, a single Date Book event, Address Book 
entry, To Do List item, or Memo Pad memo.

Creating records
You can use the following procedure to create a new record in Date Book, Address 
Book, To Do List, and Memo Pad.

To create a record
1 Select the application in which you want to create a record.

2 Tap New. 

(For Date Book only, select start and end times for your appointment and tap OK.)

3 Enter text for the record.

NOTE: The first letter of each field (except numeric and email fields) is automatically 
capitalised. 

4 As an option, tap Details to select attributes for the record.

5 In the Address Book and Memo Pad only, tap Done.

The new record is saved automatically.
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Editing records
After you create a record, you can change, delete, or add new information at any 
time. Two indicators will tell you when your screen is in edit mode: 

• A blinking cursor appears within the information, and 
• The information appears on a dotted gray line called an edit line.

You can enter text in any of the ways described in "1 Entering data in your Acer 
handheld" on page 1. 

Selecting text
Select the text you want to edit using one of the following techniques:

• Double-tap on a word in a field to select the word.
• Triple-tap on any word on a line to select the entire line.
• Drag across a line of text to select some or all of the information, or drag 

down to select text across multiple lines.

Using the Edit menu
The Edit menu is available from any screen where you enter or edit text. As a general 
rule, the Edit menu commands affect selected text. 

To use the Edit menu
1 Do one of the following to display the Edit menu.

• Tap the Menu icon ; then tap the Edit menu to display the edit commands. 
• Tap the inverted application title tab at the top of the screen; then tap the 

Edit menu to display the edit commands. 
• In the text Graffiti area, drag a diagonal line from the lower left to upper 

right to display the Command toolbar. To select a command, either:
– Tap the icon representing a command on the Command toolbar, or 

Cursor

Edit line
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– Draw the Graffiti shortcut in the text area of your screen

2 Choose from the following commands, depending on the application you are using.

Deleting records in your basic applications
You can delete records in any of the basic applications. 

To delete a record in any of the basic applications:
1 Select the record you want to affect.

2 Do one of the following: 

• Tap the Menu icon , open the Record menu, and then tap the Delete 
command. 
The Delete command differs depending on the application you are using: 

– Date Book: Delete Event
– Address Book: Delete Address
– To Do List: Delete Item 
– Memo Pad: Delete Memo

• Tap the inverted application title tab at the top of the screen, open the 
Record menu, and then select the desired Delete command. 

• In the Details dialog box of the application, tap Delete, and then tap OK.

Undo Reverses the action of the last edit command made. Undo also 
reverses deletions done using the backspace.

Cut Removes a selection from its current location and temporarily 
stores it in your handheld’s internal memory. You can then paste 
the text into another area of the current application or into a 
different application.

Copy Copies a selection and temporarily stores it in your handheld’s 
internal memory. You can paste the selection into another area of 
the current application or into a different application

Paste Inserts a selection from your handheld’s memory into a selected 
point in a record. Paste produces no result if you have not used the 
Cut or Copy commands

Select All Selects all the text in the current record or screen.

Keyboard Opens the onscreen keyboard. Tap Done to close the keyboard.

Graffiti Help Opens screens that shows all the Graffiti character strokes. Use this 
anytime you forget a stroke for a character or a shortcut for a 
command. 
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• In the text Graffiti area, drag a diagonal line from the lower left to upper 
right to display the Command toolbar; then tap the Delete icon  or draw a 
Graffiti 'D' in the text area.

• Delete the text of the record. 

NOTE: In Date Book, deleting the text of a repeating event deletes all instances of the 
event. 

A confirmation dialog box appears. 

If your want to archive a copy of the deleted file on your computer, select the Save 
Archive option. The record will be transferred to the archive folder on your computer 
the next time you perform a HotSync operation.

3 Tap OK. 

Purging records
Over time, as you use Date Book and To Do List, you’ll accumulate records that are no 
longer useful. For example, events that occurred months ago remain in Date Book, 
and completed To Do List items remain in the list.

Outdated records take up memory on your handheld, so it is a good idea to remove 
them by using Purge. If you think Date Book or To Do List records might prove useful 
later, you can purge them from your handheld and save them in an archive file. 

Purging is also available in Mail. See "Deleting email items" on page 193 for more 
information. 

Purging is not available in Address Book or Memo Pad; delete outdated records from 
these two applications manually.

Delete icon

Select check box to archive 
a copy of the deleted file 
to your computer.

Tap here to delete selected file.
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To purge records
1 Open the application from which you want to purge records. 

2 Tap the Menu icon , open the Record menu, and then tap Purge.

A confirmation dialog box appears.

3 Choose from the following options on the confirmation dialog box that appears.

• Date Book: Select the Delete Events Older Than pick list and select an 
option—1 week, 2 weeks, 3 weeks or 1 month.

• Date Book or To Do List: Select Save Archive Copy on PC to save a copy of 
purged records in an archive file on your computer the next time you perform 
a HotSync operation. Tap OK.

Select check box to archive 
a copy of the purged file 
to your computer.

Tap here to purged completed items.
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Categorising records
You can categorise records in the Address Book, To Do List, and Memo Pad 
applications for easy retrieval. (Date Book does not have categories.) 

NOTE: You can also categorise applications. Refer to "Categorising applications" on page 12 
for more information.

When you create a record, it is automatically assigned to the currently displayed 
category. If the All category is displayed, the record is assigned to the Unfiled 
category. A record can remain unfiled or it can be assigned to a category at any time. 

System-defined categories
Each basic application has a default set of categories: 

• Address Book: Business, Personal, and QuickList category 
In QuickList, you can store names, addresses, and phone numbers you might 
need during emergencies (hospitals, fire department, police stations, etc.). 

• To Do List: Business, Personal, and All category
• Memo Pad: Business, Personal, and All category

You can modify or delete the default categories. 

User-defined categories
In addition to the default categories, you have the option to create new categories. 
An application can have up to 15 user-defined categories.

To move a record into a category
1 Select the record you want to categorise.

2 Tap Details. (From the Address View screen, tap Edit first.)

3 In the Details dialog box, tap the Category pick list to display the list of available 
categories. 

4 Select the desired category. 

5 Tap OK. 

To display a category of records
1 Open the application from which you want to categorise records. 

2 Tap the pick list in the upper right corner of the screen. 

NOTE: In the Date Book Agenda view, the pick list is in the upper right of the To Do List. 

3 Select a category you want to display. 

The list screen will now display only the records associated with the selected category.
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To create a new category
1 Open the application from which you want to categorise records. 

2 Tap the pick list in the upper right corner of the screen. 

3 Tap Edit Categories. 

4 Tap New.

5 Enter the name for the new category. 

6 Tap OK. 

7 Tap OK to exit the Edit Categories dialog box. 

To rename a category
1 Tap the pick list in the upper right corner of the screen. 

2 Tap Edit Categories. 

3 Select the category you want to rename.

Tap here. 

Tap here. 
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4 Tap Rename.

5 Enter the new name for the category.

6 Tap OK.

7 Tap OK to exit the Edit Categories dialog box. 

TIP: You can move records from multiple categories into a single category by renaming all 
discrete categories with a single category name. For example, if you rename the Personal 
Category to Business, all records formerly associated with the Personal category will now 
appear under the Business category. 

Finding records 
Your handheld lets you find information in several ways: 

• All internal applications: Find locates a specified text, starting with the 
current application. 

NOTE: Find does not search through applications stored in a Memory Stick. 

• Date Book, To Do List, and Memo Pad: Use Phone Lookup to display the 
Address list screen and add the information from this list to a record.

• Address Book: Enter the first letters of a name in the Look Up line to 
immediately scroll to that name.

• Mail: Use Lookup to access information in your Address Book.

Finding Address Book records
You can look up Address Book records in two ways: 

• Use the scroll button on the front panel of your handheld. 
– In the Address list screen, the scroll button moves up or down an entire 

screen of records. Holding down the button will accelerate scrolling and 
display every third screen.

– In Address view screen, the scroll button moves to the previous or next 
address record. 

• Type the first few letters of a name in the Look Up line at the bottom of the 
Address screen. 
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The list scrolls to the first entry that begins with that letter. If you write 
another letter, the list scrolls to the first entry that begins with those two 
letters. For example, writing a "b" scrolls to "Bennet", and writing "br" 
scrolls further to 'Bristol'.

Using the Find option
The Find option lets you locate text in any or all applications. For example, if the text 
"dog" appears in Address Book and Date Book, the Find option displays both 
occurrences in the Find dialog box. 

To use the Find option

1 Tap the Find icon  to display the Find screen.

TIP: Select text in an application before tapping Find to automatically place the text in the 
Find dialog box. 

2 Enter the text you want to find. 

The Find option is not case sensitive; searching for "alex" also finds "Alex". 

Look Up line
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3 Tap OK. 

Find searches for the text in all records and all notes within all internal applications.

Find will locate all matches that begin with the supplied text. It will not find words 
where the supplied text appears in the middle or at the end of a word. For example, 
searching for 'break' will find 'breakfast' but not 'fastbreak'. 

As your handheld searches for the text, you can tap Stop to stop the search at any 
time. To continue the search after tapping Stop, tap Find More.

Using Phone Lookup 
The Phone Lookup option lets you add a telephone number from the Address list to 
an entry in another application. For example, you can add your dentist’s telephone 
number to your dental appointment date in Date Book. 

To use Phone Lookup
1 Display the record in which you want to insert a phone number. 

The record can be in Date Book, To Do List, Memo Pad, or Mail. 

2 Do one of the following to display the Phone Lookup screen: 

• Tap the Menu icon . Open the Options menu, and then tap Phone Lookup. 
• Tap the inverted application title tab at the top of the screen; then tap 

Options and tap Phone Lookup. 

Tap here to start search.
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• In the text Graffiti area, drag a diagonal line from the lower left to upper 
right to display the Command toolbar. In the text area, write an L, the 
shortcut for the Phone Lookup command. 

The Phone Lookup screen appears. 

3 Do one of the following: 

• Select a record. 
• Write the first few letters of the name you want to add. 

The List scrolls to the first record in the list that starts with the letters you 
enter. When you see the name you are looking for, tap it.

4 Tap Add.

TIP: You can also search based on selected text. Drag to highlight the text, then write the 
Graffiti Phone Lookup command stroke “L”. Your handheld replaces the selected text and 
adds the name and its associated information. 

Sorting records in your basic applications
In basic applications that display lists—Address Book, To Do List, and Memo Pad, you 
can sort listed records in various ways. Refer to following pages for instructions:

• Address Book - refer to page 59
• To Do List - refer to page 67
• Memo Pad - refer to page 70

Attaching notes
You can attach notes to records in all the basic applications except the Memo Pad. 
A note can be up to several thousand characters long. 

To attach a note to a record
1 Display the entry to which you want to add a note. 
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2 Tap Details. 

NOTE: In Address Book only, tap Edit first to be able to display and tap Details.

3 Tap Note. 

4 Enter your note. 

5 Tap Done. 

A Note icon  appears to the right of any item containing a note. 

To review or edit a note

• Tap the Note icon .

To delete a note

1 Tap the Note icon .

2 Tap Delete. 

3 Tap Yes. 

Choosing fonts
You can change the font style in all basic applications. You can choose a different font 
style for each application.

To change the font style
1 Open an application.

2 Do one of the following to display the Select Font screen: 

• Tap the Menu icon . Open the Options menu, and then tap Font.
• Tap the inverted application title tab at the top of the screen; then tap Font 

in the Options menu. 
• In the text Graffiti area, drag a diagonal line from the lower left to upper 

right to display the Command toolbar. In the text area, write an F, the 
shortcut for the Font command.
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3 Tap the font style you want, then tap OK. 

Getting information on an application
You can get information on any application by displaying its About box. The About 
box displays the name, version number, and copyright information of the application. 

To display the About box

1 Tap the Menu icon , then tap Options. 

2 In the Options menu, tap About. 

The text following the About command differs based on your location. For example, if 
you are in Date Book, the command is About Date Book; if you are in Address Book, 
the command is About Address Book. 

Application-specific tasks
This section explains how-to instructions specific for each task of your basic 
applications. 

Using Date Book

Scheduling events
An entry in Date Book is called an event. An event can refer to any activity that you 
associate with a particular day. 

You can schedule the following types of events in Date Book:

• Timed events, which have both times and dates
• Untimed events, for example, birthdays or anniversaries
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• Repeating events, such as a weekly meeting held on the same day at the 
same time

• Continuous events, such as a vacation or three-day conference
• All day events, which reflect the default hours of a day as set by the user 

When you schedule an event, its description appears on the time line, and its duration 
is set to 1 hour by default. You can easily change the start time and duration for any 
event. 

Scheduling timed events
You can schedule timed events for the current date or for future dates. 

To schedule a timed event for the current date:
1 Tap the time line next to the time that corresponds to the start of the event. 

2 Enter a description of the event. 

Event description can be up to 255 characters in length.

3 Set the event’s duration:

• If the event is 1-hour long, skip to the end of this procedure.
• If the event is longer or shorter than an hour, tap directly on the time to open 

the Set Time dialog box. Proceed to step 4.

Time bar shows 
default duration.

Tap a line next to 
desired time; then 
enter text.

Tap the 
time to 
display the 
Set Time 
dialog box.
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TIP: You can open the Set Time dialog box (to select a start time) by making sure no event is 
selected, and then writing a number on the number side of the Graffiti writing area.

4 Set the duration of the event in either of the following ways:

• Tap the time columns in the Set Time dialog box to set the Start Time; then 
tap on the End Time time columns to set the End Time.

• Tap All Day if the event lasts all day. The default hours of a standard business 
day are set by the user, and may be changed using the Preferences command 
in Date Book. See the section "Changing the displayed Start and End Times" 
on page 54.

5 Tap OK.

To schedule a timed event for another date:
1 Select the date you want in one of the following ways: 

• Tap the desired day of the week in the date bar at the top of the screen. If 
necessary, tap the Previous week or Next week arrows to move to another 
week.

Start Time 

Tap to scroll to 
earlier hours.

Tap to scroll to 
later hours.

Tap to change 
hours.

Tap to change 
minutes. 

Previous/Next 
week arrows 



3 Working with your basic applications
Using Date Book

44   

• Tap Go To at the bottom of the screen to open the Go to Date dialog box. 
Select a date by tapping a year, month, and day in the calendar.

2 After locating the desired date, follow the steps for scheduling an event for the 
current day.

Scheduling untimed events
You can schedule untimed events for any date. Untimed events appear at the top of 
the list of times marked with a diamond. 

To schedule an untimed event:
1 Select the event date you want, as described in the previous procedure, "To schedule 

a timed event for another date". 

2 Tap New.

3 In the Set Time dialog box, tap No Time.

You can tap OK instead but make sure nothing is entered for the start or end time.

Tap here. 

Tap here. 
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TIP: You can also create a new untimed event by making sure no event is selected and then 
writing letters in the Graffiti writing area. When you start writing, the untimed event appears 
at the top of the screen 

4 Enter a description of the event.

5 Tap a blank area on the screen to deselect the untimed event.

NOTE: If you create a timed event and later want to make it an untimed event, tap directly 
on the event time on the Date Book screen; then tap No Time and tap OK. 

Rescheduling events
You reschedule events using the Details option in Date Book. You can also use the 
Details option to convert untimed events into timed events. 

To reschedule an event:
1 Tap the event you want to reschedule.

2 Tap Details.

3 To change the time, tap the Time box, then select a new time. 

To change the date, tap the Date box, then select a new date

4 Tap OK.

Scheduling repeating or continuous events 
The Repeat function lets you schedule events that recur at regular intervals or extend 
over a period of consecutive days. 

Repeating events include a birthday or a weekly photography lesson that falls on the 
same day of the week and the same time of day. 

Continuous events might include a business trip or a vacation.

To schedule a repeating or continuous event:
1 Tap the event. (Be sure to tap the event and not the time next to the event.)

Typically, a continuous event is an untimed event.

2 Tap Details.

3 Tap the Repeat box to open the Change Repeat dialog box.
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4 Tap Day, Week, Month, or Year to set how often the event repeats. 

For a continuous event, tap Day.

5 Enter a number that corresponds to how often you want the event to repeat on the 
Every line. 

For example, if you select Month and enter the number 3, the event repeats every 
third month.

6 To set an end date for the repeating or continuous event, tap the End On pick list and 
tap Choose Date. Use the date picker to select an end date.

7 Tap OK. 

The new repeating event is indicated by the Repeat icon  on the far right on the 
event line.

Making changes to repeating or continuous events
When changes are made to a repeating or continuous event you have the option of 
applying the change to just the current event, the current event and all future 
occurrences of this event, or all occurrences of this event - past, present, and future.

To delete repeating events:
1 In the Event Details screen of the event you want to delete, tap Delete. 

The Repeating Event screen appears asking for confirmation of the delete.

Tap here.
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NOTE: You can also tap the Menu icon; select Record, and then tap Delete Event. This opens 
the Repeating Event screen.

2 Select one of the following options:

The event is removed from your Date Book and you are returned to the Day view 
where you started. These steps apply to all changes you make to repeating or 
continuous events.

About scheduling repeating or continuous events
Keep the following in mind when scheduling repeating or continuous events:

• If you change the start date of a repeating event, your handheld calculates 
the number of days you moved the event. It then automatically changes the 
end date to maintain the duration of the repeating event.

• If you change the repeat interval (e.g., daily to weekly) of a repeating event, 
past occurrences (prior to the day on which you change the setting) are not 
changed, and your handheld creates a new repeating event.

• If you change the date of an occurrence of a repeating event (e.g., from 
January 14 to January 15) and apply the change to all occurrences, the new 
date becomes the start date of the repeating event. Your handheld adjusts 
the end date to maintain the duration of the event.

• If you change other repeat settings (for example, time, alarm, private) of a 
repeating event and apply the change to all occurrences, your handheld 
creates a new event. The start date of this new event is the day on which the 
setting is changed. Past occurrences (prior to the day of the change) are not 
changed.

• If you apply a change to a single occurrence of a repeating event (e.g., time), 
that occurrence no longer shows the Repeat icon.

Current Deletes a single occurrence of this event.

Future Deletes the current event and all future occurrences of this event.

All Deletes all past, current, and future occurrences of this event.
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Adding Address Book information to an event
You can add a name, address, and telephone number to an event using the Phone 
Lookup option. For instructions, refer to "Using Phone Lookup" on page 38. 

Setting the alarm for an event
The Alarm setting lets you set an audible alarm for events in your Date Book, and 
display an onscreen reminder. For untimed events, only the reminder message 
appears.

To set an alarm for an event
1 Tap the event to which you want to assign an alarm.

2 Tap Details.

3 Tap the Alarm check box to select it.

The default setting, 5 Minutes, appears.

4 Set the alarm time:

• Select the 5 next to the Alarm check box and enter any number from 0 to 99 
(inclusive) as the number of time units.

• Tap the pick list to change the time unit; select Minutes, Hours, or Days.

5 Tap OK.

Once an alarm has gone off, a Reminder screen appears. You can tap the Snooze 
button to dismiss the alarm for a 5-minute period. Refer to "Using the Reminder 
command buttons" on page 174 for more information on working on the Reminder 
screen.

Tap here to 
select unit of time.

Enter number of 
time units here.
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Setting alarm options
You can use Preferences to set alarm options, including:

• For the alarm to go off automatically for each new event 
• Set a tone for the alarm
• Set the number of times the alarm sounds

To set alarm options

1 In Date Book, tap the Menu icon , open the Options menu, and then tap 
Preferences.

2 Select from the following options: 

3 Tap OK.

Start/End Time Let you set the start and end time for the Date Book view. See 
"Changing the displayed Start and End Times" on page 54. 

Alarm Preset Let you set an alarm for each new event automatically. The silent 
alarm for untimed events is defined by minutes, days, or hours 
before midnight of the date of the event. 

Alarm Sound Tap the pick list to set the tone of the alarm. Options include Alarm, 
Alert, Bird, Concert, Phone, Sci-fi, and Wake Up.

Remind Me Tap the pick list to define how many times the alarm sounds—once 
or twice; or three, five, or ten times.

Play Every Tap the pick list to define how often the alarm sounds—every 
minute; or every 5, 10, or 30 minutes.
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Changing the Date Book view
Date Book includes four views for displaying your appointments: 

• Day view
• Week view 
• Month view
• Agenda view

To display the Date Book views: 
Do one of the following:

• Repeatedly press the Date Book application button  on the front panel of 
your handheld to cycle through all the Date Book views. 

• Tap a view icon in the lower-left area of the Date Book screen. 

Working in Week view
Week view displays a calendar of your events for an entire week. This view lets you 
quickly review your appointments and available time slots. In addition, the graphical 
display helps you spot overlaps and conflicts in your schedule.

To work in Week view:
1 Do one of the following to display the Week view:

• Tap the Week view icon . 

• Press the Date Book application button  until the Week view appears. 
2 Tap the left and right navigation controls to move forward or backward a week at a 

time, or tap on a specific day to display the details of an event. 

NOTE: The Week view also shows untimed events and events before and after the range of 
times displayed.

Date Book view icons
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3 Tap an event to display a description of the event at the top of the screen.

Tips on working in Week view
Keep the following points in mind when working in Week view: 

• To reschedule an event while in Week view, tap and drag the event to a 
different time or day.

• Tap a blank time on any day to move to that day and have the time selected 
for a new event. 

• Tap any day or date that appears at the top of the Week view to move 
directly to that day without selecting an event.

• The Week view displays the time span defined by the Start Time and End 
Time in the Date Book Preferences settings. If you have an event before or 
after this time span, a bar appears at the top or bottom of that day's column. 
Use the scroll arrows to scroll to the event.

Previous week Next week

Dot indicates 
untimed event.

Bar indicates 
earlier event.

Bar indicates 
later event. 

Week view icon

Tap to show event details.

Event details
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Spotting event conflicts
With the ability to define specific start and end times for any event, it is possible to 
schedule events that overlap (an event that starts before a previous event finishes).

An event conflict (time overlap) appears in the Week view as overlapping time bars 
and in the Day view as overlapping brackets to the left of the conflicting times.

Working in Month view
The Month view screen shows which days have events scheduled. Dots and lines in the 
Month view indicate events, repeating events, and untimed events.

To display the Month view:
Do one of the following:

• Tap the Month view icon . 

• Press the Date Book application button  until the Month view appears. 

You can control the dots and lines that appear in the Month view. See "Display 
Options" on page 55 for more information.

Event conflict 
in Day view

Event conflict 
in Week view

Previous/next month 

Dots on right side indicate events.

Crosses below date indicate untimed events.

Month view icon
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Tips on working in Month view
Keep the following points in mind when working in Month view: 

• Tap a day in the Month view to display that day in the Day view.
• Tap the next/previous arrows in the upper right corner of the screen to move 

forward or backward a month. 
• Tap the Go To button to open the date selector and select a different month.
• Use the scroll buttons on the front panel of your handheld to move between 

months. Press the top button to display the previous month, the bottom 
button to display the next month. 

Working in Agenda view
The Agenda view lets you view appointments, untimed events, and To Do List items in 
a single screen. Although it is primarily a viewing option, you can also use the Agenda 
view to check off completed To Do List items. To go to the Day view of any event on 
the Agenda view screen, simply tap the desired event. 

To work in the Agenda view:
1 Do one of the following to display the Agenda view: 

• Tap the Agenda view icon . 

• Press the Date Book application button  until the Agenda view appears.
Tap the navigation bars to move forward or backward a day at a time or to display 
more events and To Do items.

Tips on working in Agenda view
• Tap any appointment while in Agenda view to display the Day view of the 

appointment. 
• Check off completed To Do List items in the Agenda view, or click a 

description of an item to go directly into the To Do List application. 
• You can change the category of To Do List items shown. Tap the pick list and 

select the new category. For more information on To Do List items, refer to 
"Using To Do List" on page 63.

Scroll the list 
for each view

Agenda view icon
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Changing the displayed Start and End Times

To change the start and end time in Date Book:

1 Tap the Menu icon , open the Options menu, and then tap Preferences.

The Start Time and End Time values are used by the various Date Book screens. The 
Day view schedules events to start and end at these times when the All Day option is 
selected. The Week view displays the time span defined by the Start Time and End 
Time values.

2 Tap Start Time and use the up/down arrows to select a new start time value for the 
Date Book screens. 

3 Tap End Time and use the up/down arrows to select a new end time value for the Date 
Book screens. 

NOTE: If the selected time slots for the Start and End time do not fit on one screen, you can 
tap the scroll arrows to scroll up and down.

4 Tap OK.

Displaying the current time

To display the current time:
1 Tap and hold down the stylus on the date in the date bar to display the current time.

2 Release the stylus to redisplay the date. 

Date Book menus
Date Book menus are shown here for your reference only. Features that are not 
explained in this section are discussed elsewhere in this User Manual.

Date Book has three menus: Record, Edit and Options.
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Options menu   

Display Options In Day or Month view, you can change which events appear in 
Date Book. In Day view, you can display time bars that 
highlight event conflicts. 

In Day view:

• Show Time Bars. Tap to display time bars showing 
the duration of an event and any event conflicts.

• Compress Day View. Tap to display start and end 
times for each event with the blank time slots on the 
bottom of the screen absent to minimise scrolling. 
Clear the option to display all time slots.

In Month view:

Select whether to display Timed, Untimed, or Daily Repeating 
events. You can activate any or all of these options. 
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Using Address Book

Creating an Address Book entry
A record in Address Book is called an entry. You can create entries on your handheld 
or you can use your Palm Desktop software to create entries on your computer and 
then download them to your handheld during your next HotSync operation.

Palm Desktop software also has data import capabilities that allow you load database 
files into the Address Book on your handheld. 

To create a new Address Book entry:

1 Press the Address Book application button  on the front panel of your handheld to 
display the Address screen.

2 Tap New.

3 Enter the last name of the person you want to add to your Address Book. 

NOTE: The first letter of each field (except numeric and email fields) is automatically 
capitalised. 

4 Tap the First Name field to move to it. 

TIP: You can also use the Graffiti Next Field Stroke to move to the next field. Refer to 
"Graffiti navigation strokes" on page 6 for more information.

5 Enter the individual’s first name in the First Name field.

6 If you want to be able to sort the Address Book by company name, enter the 
information you want in the Company field. 

7 Enter any other information that you want to include in the entry.

Tap here.

Cursor at 
Last name

Tap here to add a note.
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NOTE: As you enter letters in the Title, Company, City and State fields, text appears for the 
first logical match that exists in your Address Book. As you enter more letters, a closer match 
appears. As soon as the word appears, tap in the next field to accept the word. 

8 Tap the scroll arrows to move to the next page of information.

9 To attach a note to an entry, tap Note. Enter the information you want in the Graffiti 
writing area, and then tap Done.

10 When you have finished entering information, tap Done.

TIP: To create an entry that always appears at the top of the Address List, begin the Last 
name or Company field with a symbol, as in *If Found Call.* This entry can contain contact 
information in case you lose your handheld.

To view details of an address entry:
1 Tap the address entry in Address list view. 

The entry appears in the Address View screen.

2 Tap Done when you have finished viewing the entry.

Selecting different types of phone numbers and addresses
You can select the types of phone numbers or email addresses that an Address Book 
entry displays. Any changes you make apply only to the current entry. 

To select other types of phone numbers in an entry
1 In the Address View screen of the entry that you want to change, tap Edit.
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2 Tap the pick list next to the label you want to change.

3 Select a new label.

Duplicating an entry
You can duplicate existing entries, which can be helpful when you want to enter 
multiple people from a single organisation. When you duplicate an entry, the word 
Copy appears next to the name in the First Name field. 

To duplicate an entry
1 From the Address Book, tap a name you want to duplicate.

2 Do one of the following:

• Tap the Menu icon ; then tap Duplicate Address from the Record menu.
• Tap the inverted application title tab at the top of the screen; then tap 

Duplicate Address from the Record menu. 
• In the Graffiti text area of your device’s screen, drag a diagonal line from the 

lower left to upper right to display the Command toolbar; then write a T in 
the Graffiti text area to initiate the Duplicate Record command.

Tap here.

Tap the
pick list.
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3 Edit the record as necessary. 

Editing Address Book entries
You can change the type of information that appears in the Address screen, 
categorise an entry, and hide an entry for security reasons. You can also delete 
entries. 

To edit an Address Book entry
1 Tap the entry that you want to change in the Address list.

2 Tap Edit.

3 Tap Details.

4 In the Address Entry Details dialog box, select any of the following settings:

You can also use the Delete and Note buttons. 

• Delete. Tap to delete the entry.
• Note. Let you create a note. Tap the button, then enter information in the 

Graffiti writing area, and tap OK. 
5 Tap OK.

Sorting Address Book entries
You can change how Address Book lists are sorted by using Preferences.

To sort Address Book entries

Show in List Let you select which type of phone or other information to appear 
in the Address List screen. Options include Work, Home, Fax, Other, 
E-mail, Main, Pager and Mobile. The Identifying letters W, H, F, O, 
M or P appear next to the record on which information is displays. 
(There is no identifying letter when E-mail is selected.)

Category Let you select a category to which you want to assign the entry.

Private Let you hide the entry when Security is turned on.
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1 In Address Book, tap the Menu icon . 

2 Open the Options menu, and then tap Preferences. 

The Preferences screen appears.

3 Choose an option to sort Address Book lists from the List By pick list:

4 Tap OK.

Address Book menus
Address Book menus are shown here for your reference only. Features that are not 
explained in this section are discussed elsewhere in this User Manual.

Address Book has three menus: Record, Edit and Options. 

Record menu
The Record menu differs depending on whether you are viewing it from the Address 
list screen or from the Address View screen.

Last Name, First Name Address Book list is sorted alphabetically by an 
individual’s last name and then first name.

Company, Last Name Address Book list is sorted by the company name, and 
then an individual’s last name.
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Options menu
The Options menu differs depending on whether you are viewing it from the Address 
list or from the Address View screen.

Address list Address View 

Dial Initiates dialing of an infrared-equipped mobile phone by sending 
the telephone number through the IR port of your handheld to the 
phone.

Address list Address View 
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Preferences

• Remember Last Category. Determines how Address 
Book appears when you return to it from another 
application. If you check on the box, Address Book 
shows the last category you selected. If you clear it, 
Address Book displays the All category.

• Enable Tap Dialing. Allow automatic dialing by 
tapping a telephone number in Address Book. You must 
have an infrared-equipped mobile phone near your 
handheld to use this feature.

Rename Custom 
Fields

These custom fields appear at the end of the Address Edit screen. 
Rename them to identify the kind of information you enter in 
them. Names of these custom fields appear in all entries. 
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Using To Do List

Creating To Do List items
A To Do List item is a reminder of some task that you have to complete. A record in 
the To Do List is called an item.

To create a To Do List item

1 Press the To Do List application button  on the front panel of your handheld to 
display the To Do List screen.

2 Tap New.

3 Enter the text of the To Do List item. 

The text can be longer than one line.

TIP: If no To Do List item is currently selected, writing in the Graffiti writing area 
automatically creates a new item.

4 Tap anywhere onscreen to deselect the To Do List item.

TIP: You can add a name, address, and phone number to a To Do List item using the Phone 
Lookup option. For more information, refer to "Using Phone Lookup" on page 38.

Setting To Do List priorities
You can set priorities for tasks in your To Do List according to their importance or 
urgency. By default, items are arranged by priority and due date; on top of the list are 
priority 1 (most important) items. Changing an item’s priority may move its position in 
the list. 

Tap here.

New To Do 
edit line
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New To Do List items automatically have a priority level of 1. If you select another item 
first, before creating a new item, the item you create appears beneath the selected 
item with the same priority as the selected item. 

To set the priority of a To Do List item
1 If priorities are not visible in the To Do List, tap the Show button at the bottom of the 

screen. Tap Show Priorities, and tap OK.

2 Tap the Priority number on the left side of the To Do List item. 

The drop-down column of priority levels appears.

3 Tap the Priority number that you want to set for the item, with 1 as the most 
important and 5 as the least important. 

Checking off a To Do List item 
You can check off a To Do List item to indicate that you have completed it. 

To check off a To Do List item
Tap the check box on the left side of the item. The check mark indicates that the item 
has been completed already.

Tap here.

Tap here to select priority level.

Completed To Do List item
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To remove a completed To Do List item
1 At the bottom of the To Do List screen, tap the Show button to display the To Do 

Preferences dialog box.

2 Tap the Show Completed Items check box to deselect it.

Your completed To Do items disappear from the list. 

NOTE: Items that no longer appear on the list because Show Completed Items is turned off 
have not been deleted. They are still in the internal memory of your handheld. You must 
purge completed items to remove them from memory. Refer to "Purging records" on page 32 
for more information.

Changing To Do List items details
You can change the details of a To Do List item including the priority level, the item 
category, the assigned due date, and the security status. 

To change the To Do List item details
1 In the To Do List screen, tap the item that you want to change.

2 Tap Details to display the To Do Item Details screen.

Tap the check box to turn off this option.Tap here.
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3 Choose from the following options:

Tap here.

Priority Tap the Priority number that you want to set for the item, with 1 as 
the most important and 5 as the least important.

Category Tap the pick list to select a category for the item. 

Due Date Tap the pick list to open the Due Date pick list, then tap the date that 
you want to assign the item. Options include: 

• Today. Assigns the current date.
• Tomorrow. Assigns tomorrow’s date.
• One Week Later. Assigns the date exactly one week from 

the current date.
• No Date. Removes the due date from the item.
• Choose Date. Displays the date selector from where you can 

select a particular due date for the item.

Private Tap Private to hide this item when Security is turned on.
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You can also use the Delete and Note buttons. 

• Delete. Tap to delete the item.
• Note. Let you create a note. Tap the button, then enter information in the 

Graffiti writing area, and tap OK. 
4 Tap OK.

TIP: If you turn on the Show Due Dates option in the To Do Preferences dialog box, you can 
tap directly on the due date in the To Do List to open the pick list shown in step 3.

Sorting To Do items
After setting the item’s option details, you can then sort To Do List items by priority, 
due date, or category.

To sort To Do List items
1 In the list screen of To Do List, tap Show.

2 Tap the Sort By pick list.

Tap here. 

Tap here. 
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3 Select an option from the Sort by pick list:

4 Tap OK.

Displaying completed and due items
You can have the To Do List display completed items and their completion dates, as 
well as due items and their due dates. 

To display completed and due items in the To Do List:
1 At the bottom of the To Do List screen, tap the Show button to display the To Do 

Preferences dialog box.

2 In the To Do Preferences dialog box, tap any of the following settings to activate it. 

Priority, Due Date Sort items by priority first, and then due date.

Due Date, Priority Sort items by due date first, and then priority

Category, Priority Sort items by category first, and then priority

Priority, Category Sort items by priority first, and then category.

Tap here.

Show Completed Items Displays completed items in the To Do List. If this 
setting is turned off, completed To Do items disappear 
from the list, but are kept in the internal memory of 
your handheld. You must purge completed items to 
remove them from memory.

Show Only Due Items Displays only the items that are currently due, past 
due, or have no due date specified. When this setting 
is active, items that are not yet due do not appear in 
the list until their due date.

Record Completion Date Replaces the due date with the actual date when you 
complete (check) the item. If you do not assign a due 
date to an item, the completion date still appears 
when you complete the item.
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3 Tap OK.

To Do List menus
To Do List has three menus: Record, Edit and Options. 

Using Memo Pad

Creating memos
A record in Memo Pad is called a memo. A memo can contain up to 4,000 characters. 
The number of memos you can store is limited only by the free space available in your 
handheld’s internal memory.

When you create a new memo, you can add information to it from the Address Book 
application, such as a phone number or address, using the Phone Lookup option. 
Refer to "Using Phone Lookup" on page 38. 

To create a new memo

1 Press the Memo Pad application button on the front panel of your handheld to 
display the Memo List screen.

2 Tap New.

Show Due Date Displays the due dates for items in the To Do List and 
displays an exclamation mark next to items that 
remain incomplete after the due date passes.

Show Priorities Displays the priority setting for each item.

Show Categories Displays the category for each item. 

Tap here.
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TIP: You can also create a new memo by beginning to write in the Graffiti writing area in 
the Memo List screen. The first letter is automatically capitalised and begins your new memo. 

3 Enter the text you want to appear in the memo. Use the Graffiti carriage return stroke 
to move down to new lines in the memo.

Refer page 6 for more information on Graffiti navigation strokes.

4 Tap Done. 

NOTE: You can categorise memos. See "Categorising records" on page 34. 

Reviewing memos
The Memo list displays the first line of a memo. This makes it easy to locate and review 
your memos. 

To review a memo
1 In the Memo List, tap the text of the memo.

2 Review or edit the text in the memo. 

3 Tap Done.

Sorting memos
You can use the Memo Pad Preferences menu to change the order memos appear in 
the Memo List screen. 

To automatically sort memos
Sort new and existing memos in numerical and then alphabetical sequence.

1 In the list screen of Memo Pad, tap the Menu icon . 

2 From the Options menu, tap Preferences. 

Tap a memo 
to review its 
contents
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3 In the Preferences dialog box, tap the Sort by pick list and select Alphabetic.

4 Tap OK. 

To manually sort memos
Sort new memos in the sequence in which you create them.

1 In the Memo Pad Preferences dialog box, tap Manual from the Sort by pick list.

2 In the list screen, tap and drag a memo to a new location in the list. 

TIP: To display the list of your memos on your computer as you arranged them manually on 
your handheld, open Memo Pad in the Palm Desktop software, click List By, and select Order 
on Handheld.

Memo Pad menus
Memo Pad menus are shown here for your reference only. Features that are not 
explained in this section are discussed elsewhere in this User Manual.

Memo Pad has three menus: Record, Edit and Options. 

Tap here. 
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Record menus
The Record menu differs depending on whether you are viewing it from the Memo 
List screen or from an open memo. 

Options menus
The Options menu differs depending on whether you are viewing it from the Memo 
List screen or from an open memo.

Memo List Open memo 

Memo List Open memo 
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Using Calculator

Using the Calculator buttons
The Calculator includes several buttons to help you perform calculations.

Displaying recent calculations
The Recent Calculations command lets you review the last series of calculations and 
helps you confirm a chain of calculations.

To display recent calculations

1 Tap the Menu icon  to display the menu bar. 

2 Tap Options. 

3 Tap Recent Calculations.

Clears the entire calculation and enables you to begin a fresh 
calculation.

Clears the last number you entered. Tap this button if you make a 
mistake while entering a number in the middle of a calculation. 
This button enables you to reenter the number without starting the 
calculation over.

Places the current number in memory. Each new number you enter 
with the M+ button is added to the total stored in memory. The 
number that you add can be either a calculated value or any 
number you enter by pressing the number buttons. Tapping this 
button has no effect on the current calculation (or series of 
calculations); it merely places the value into memory until it is 
recalled.

Recalls the total stored value from memory and inserts it in the 
current calculation.

Clears any value that is stored in the Calculator memory.

Calculates the square root of a number. Enter a number then tap 
this button. 

Toggles the current number between a negative and positive value. 
If you want to enter a negative number, enter the number first and 
then tap the +/- button.
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4 When you have finished reviewing the calculations, tap OK.

Calculator menus
Calculator has two menus: Edit and Options. 

Tap here. 
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4 Working with your 
supplementary applications

Your handheld includes several supplementary applications that provide innovative 
features to make your handheld a functional everyday companion: 

This chapter explains how to use your handheld’s supplementary applications.

* These applications are only available for Acer s60.

Installing handheld applications
By default, only the Service Launcher and Filer applications are factory-installed in 
your handheld. To use the other handheld applications you need to download them 
to your computer using the Acer s50 and s60 Handhelds Installation CD, then perform 
a HotSync operation to install them to your handheld. 

To install supplementary handheld applications
Downloading AudioBox and Recorder is only useful for Acer s60 handheld users. 
These two applications will not run even if installed in an Acer s50 handheld. 

1 Exit any open programs, including those that run at startup such as Microsoft® Office, 
and disable any virus-scanning software.

2 Insert the Acer s50 and s60 Handhelds Installation CD into the computer’s 
CD-ROM drive. 

3 Select the language of choice.

4 Select your handheld model.

5 Click Install Supplementary Applications. 

6 Click Install Handheld Applications. 

7 Select the check box before the application(s) you want to install.

8 If you are installing Clock, WalkReader, Backup, or PhotoWiz, click Execute to start the 
installation process.

If you are installing AudioBox or Recorder, on the confirmation prompt that appears 
after clicking Execute, click Continue to start the installation process.

Clicking the Execute button will transfer all selected application(s) to the 
Palm Desktop Install Tool. 

• Clock
• AudioBox *
• Recorder *
• WalkReader

• PhotoWiz
• Filer
• Service Launcher
• Backup
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9 Perform a HotSync operation to install selected application(s) to your handheld. 

For more information on performing a HotSync operation, refer to "9 Exchanging and 
updating data using HotSync operations" on page 213. 

Using Clock 
Clock makes it easy for you to check the date and time as well as set alarm reminders 
for your schedule. It also serves as a handy timer for time-critical activities.

Clock modes
Clock operates in three modes: City Clock, Big Clock and Timer, each one designed to 
suit a particular activity in your daily schedule. 

To switch between Clock modes
1 In the active Clock screen, tap the mode pick list on the upper-right corner to display 

the mode options.

2 Select a Clock mode. 

Clock shows the main screen of the selected mode.

Tap here. 
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City Clock mode
City Clock serves three main functions: date and time display for a local city, date and 
time display for two other preselected cities (default: New York and Tokyo) and an 
alarm function.

Big Clock mode 
main screen

Timer mode
main screen

City Clock mode 
main screen (default mode)
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Time display is in hh:mm:ss format. There are two possible display modes: 12H AM/PM 
(default) and 24H. Refer to "Preferences" on page 89 for more information. 

Date display is shown in mm/dd/yyyy format. Current weekday is also shown.

You can set up to three alarm reminders. When an alarm reminder is set, the 
corresponding alarm indicator on the City Clock main screen is highlighted. Refer to 
"Alarm setting" on page 83 for more information.

Date and time display
The City Clock mode shows the date and time display for the local city. This is based on 
the current settings under the Date & Time panel of Preferences. Refer to page 242 for 
more information. 

Display for two other preselected cities is also shown. By default, the date and time 
for New York and Tokyo is displayed. 

Editing the city display and city list
You can select a different city to display, edit the details of a current city entry or add 
a new city to the current city list.

To change the preselected city display: 
1 Tap the city pick list to display the available city options. 

2 Tap the city you want to display.

Local time and 
date display

Time and date 
display for two 
preselected cities

Alarm icon

Alarm indicators
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NOTE: When "DST" is visible, the displayed city has a preset Daylight Saving Time 
information. 

To edit city details:
1 Tap a city pick list to display the current city list. 

2 Select Edit Cities on the bottom of the city list to display the Edit Cities screen.

3 In the Edit Cities screen, tap the city entry you want to edit.

The City Details screen for the selected entry appears.

Tap a city pick list.

Tap a city pick list. Tap here.
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4 Edit the city details. 

City Defines the city name. 

GMT Offset Defines the GMT (Greenwich Mean Time) offset value. The first 
number frame represents the hour value from 1 to 12. The second 
number frame represents the minute value. Tap the individual 
frames then use the  control to set the values. Options include 00, 
15, 30, and 45. 

DST Tap the check box to apply DST information (if available) to the 
selected city. If no DST information is available for the selected city, 
tapping the check box will automatically display the Set DST screen. 

DST Tap the check box to apply DST information (if available) to the 
selected city. If no DST information is available tapping the check 
box will automatically display the Set DST screen. 

DST Setting Tap to define the DST settings. Follow the steps below:
1 Tap DST Setting to display the Set DST screen.

2 Tap the pick lists to define the DST information.
3 Tap OK.
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5 Tap OK on the City Details screen to apply the new city settings. 

To add a new city to the current city list:
1 Tap a city pick list to display the current city list. 

2 Select Edit Cities on the bottom of the city list to display the Edit Cities screen.

3 In the Edit Cities screen, tap New to display a blank City Details screen.

4 Define the detail settings for the new city entry.

You can tap DST Setting to define DST information for the new city entry.

Tap here.

Tap here to set DST information.



4 Working with your supplementary applications
Using Clock

82   

5 Tap OK on the City Details screen to add the new city to the current city list. 

6 Tap OK on the Edit Cities screen to revert to the City Clock main screen.

To delete a city from the current city list:
1 Tap the city pick list to display the current city list. 

2 Select Edit Cities on the bottom of the city list to display the Edit Cities main screen. 

3 Tap the city entry you want to delete. 

4 Tap Delete to display the Delete City dialog box.

New city entry

Tap here.
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5 Tap OK. 

If the city deleted is one of the two current preselected cities in the City Clock main 
screen, the deleted city will be replace by the local city defined in the system 
preferences settings. 

Alarm setting
City Clock enables you to set an alarm to remind you of scheduled activities. 

To set an alarm

1 In the City Clock main screen, tap the Alarm icon  to display the Alarm Settings 
screen. 

2 Define the alarm settings as follows:

Local city

Tap here.
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Alarm indicator Set the code for the alarm reminder. Follow the steps below:

1 Tap a number frame to set the alarm indicator. 
2 Tap the Active check box to enable it. 

Alarm time Define when the alarm will be activated. Follow the steps 
below:
1 Tap the number frame then use the  control to set the 
values. 
The first number frame represents the hour value (1 to 12). The 
second and third number frame represents the minute options. 

2 If the active time display format is 12H, tap an option from 
the AM/PM setting.

Tap here 
to select 
the alarm 
indicator.

Tap here 
to activate 
the alarm 
indicator.

Tap the hour
/minute 
frames to set 
alarm time.

If applicable, 
select an 
AM/PM 
option.
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Alarm Sound Define the background sound to use when alarm is activated. 
Tap the pick list to display the options which include Alarm, 
Alert, Bird, Concerto, Phone, Sci-Fi, and Wake-up.

NOTE: You can install MIDI files in your handheld that you can use 
as an alarm sound. To install MIDI files, follow the instructions on 
the "To install add-on applications on your handheld" section on the 
Acer s50 and s60 Handhelds Quick Guide. 

Repeat Define how often will the alarm be activated. 
Tap the pick list to display the options which include:

• None. The alarm will only be activated once.
• Daily. The alarm will be activated everyday. 
• Weekly. The alarm will be activated once every week 

based on the selected weekday.
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3 Tap OK. 

Big Clock mode 
The large time display in Big Clock mode makes it the mode of choice for those who 
prefer the visual manner of displaying time. The three pointers—hours, minutes and 
seconds, function just like a physical clock or watch.

Notes Enter a brief description about the alarm reminder. This 
description will appear on the Reminder page when the alarm 
is activated.  

NOTE: Refer to "6 Using the Attention Manager" on page 173 for 
more information on the Reminder page. 

The set alarm reminder is denoted 
by a highlighted indicator on the 
City Clock main screen.
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Depending on the time of the day, this mode also displays a background picture: a 
bright, sunny scene from 06:00:00 to 17:59:59, and a starry, moonlit skyscape from 
18:00:00 to 05:59:59. 

Timer mode 
In Timer mode, you can use your handheld as a stopwatch to measure time span for 
time-critical events such as a sports competition, a time-balancing experiment (or even 
in monitoring that east-to-west overseas call to your loved ones. Mind that phone bill 
please!). Time display is shown in hh:mm:ss format.

To work in Timer mode

1 Tap  to start timing an event. The timer will start to count and the button will 
changed to .
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2 Tap  to stop and reset the timer. 

Clock menu 
The Clock menu shown here is for your reference only. Features that are not explained 
in this section are discussed elsewhere in this User Manual.

Clock has one only menu: Options. 

For information on how to open and use menus, refer to "Using menus and menu 
commands" on the Acer s50 and s60 Handhelds Quick Guide. 

Options menu
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Using AudioBox
AudioBox lets you to play your favorite MP3 files saved in a Memory Stick. 

You can listen to AudioBox tracks either through your Acer s60’s built-in speaker or 
through an earphone (included in the package contents) you connect to the earphone 
jack found on of your handheld. 

NOTE: You cannot use the both the earphone jack and the internal speaker at the same 
time. Using one will disable the other. 

Refer to "Front panel" on the Acer s50 and s60 Handhelds Quick Guide for the 
location of the earphone jack and internal speaker. 

Copying MP3 files into a Memory Stick
1 On your computer, click Start > Programs > Palm Desktop > Install Tool.
2 In the User drop-down list, select the user name that refers to your handheld. 
3 Click Add to display the Open window. 
4 Browse for then select the for the MP3 file(s) you want to copy. 
5 Click Open. 

The file appears in the Install Tool dialog box. 
6 Click Done. 
7 Perform a HotSync operation with a Memory Stick installed in your handheld. 

Preferences

Time format. Defines the time display format for City Clock 
mode. Follow the steps below:
1 Tap the pick list to display the format options which include: 

• 12H (AM/PM) 
• 24H 

2 Tap OK.
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The MP3 file(s) you selected will be copied to the Memory Stick under the MP3 folder.

AudioBox main screen

Background playback
When the Background Playback function is enabled, AudioBox continues to play the 
selected tracks even after you press the Multi-function button (set as a Back button) or 
tap the Applications icon  or press any of the application buttons on the handheld’s 
front panel. 

NOTE: When the Background Playback function is disabled, pressing any of the application 
buttons will terminate the AudioBox operation and launch the application assigned to the 
pressed button. 

To enable background playback

1 Tap the Menu icon  then tap Preferences from the Options menu.

2 Select the Background Playback check box.

Track number Current playback time

Storage pick list

Play 

Track filename 

Go to previous track Go to the next track 

Stop 

Backlight control

Repeat current/all tracks

Shuffle track

Repeat track section

Total playback time

Playback mode

Volume slider

Playback status slider

Display playlist
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3 Tap OK.

AudioBox functions
The smartly-designed user interface of AudioBox provides all the standard functions 
of a dedicated MP3 player built into your Acer s60. 

To select a track to play
1 In the AudioBox main screen, tap the Track pick list to display the available tracks in 

the Memory Stick. 

The track number and track filename are displayed on the list. 

2 Tap a track to select it for playback.

To play a selected track
1 Select a track to play. Refer to the procedure in the preceding section. 

Tap here.

Select check box.

Tap here.
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2 Tap  to start playing the track. 

While in playback mode, image changes to  indicating pause mode and the LED 
indicator flashes red. You can drag the playback status slider to rewind or 
fast-forward the track. If you tap the Applications icon  while in pause mode, 
AudioBox will automatically be terminated.

During playback, tap: 

•  to go back to the previous active track on the playlist. 

•  to skip to the next active track on the playlist.
• Shuffle to play the tracks in random order. 
• Repeat to repeat playback of the active track or the whole playlist. 

Refer to "Preferences" under the Options menu on page 96 for more 
information on how to configure this function. 

• LCD off to turn off the backlight during playback. To turn the backlight on, 
press any of the hardware buttons.

To adjust the volume
Do one of the following:

• Tap on the volume bar. 
• Drag the volume slider.
• Tap the (+) and (-) buttons.

• When the AudioBox main screen is active, press the scroll buttons on the 
front panel. 

To set the playback mode: 
• During playback, tap the Playback Mode button. 

Mode display changes every time you tap the button. Mode options include 
Normal (default), Rock, Latin, Dance, and Jazz.

Drag the volume slider.
Tap on the volume bar.

Tap the volume buttons.
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To repeat a section of the active track: 

1 During playback, tap  to select the starting point of the track section to be 
repeated. 

2 Tap  again to select the end point of the track section to be repeated. 

The selected section would then be repeatedly played until  is tap again. 

To stop playback: 
Do one of the following:

• Tap . 
• Press the power button. AudioBox is relaunched when you turn your 

Acer s60 back on. 

AudioBox playlist
The playlist displays the track information of all the available MP3 files stored in the 
Memory Stick. 

To display the playlist 
• In the AudioBox main screen, tap the Playlist button.

The Playlist Edit screen from the most recent AudioBox session appears. The 
screen displays the track number, title and corresponding playback time of all 
available MP3 files. In the lower part of the screen, the total playback time of 
the whole playlist is indicated.

NOTE: A maximum of six track entries will be displayed per frame. Tap the scroll bar on the 
right side of the screen to view the whole playlist.

You can do any of the following in the Playlist Edit screen:

A�B

A�B

A�B

Tap here.
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• Select a track to play.
Tap the check box before each entry to include that track in the next 
playback session.

If it is the first time that a Memory Stick is used for an AudioBox session, all 
tracks are automatically selected. 

• Rearrange the order b y which the selected tracks will be played. 
Select a track then tap  or  to move it up or down the playlist. 
Rearranging the tracks will not change the track number.

NOTE: When the selected entry is the first one on the list,  is disabled. In the same 
manner, when the selected entry is last on the list,  is also disabled. 

• Tap Select All to activate all tracks for playback. 
• Tap Clear All button to deactivate all tracks for playback. 

Tapping the Tips icon  will display the screen below.

To revert to the AudioBox main screen, tap Done. 

Deleting MP3 files
You have the option of deleting MP3 files from a Memory Stick to free up space in the 
card. 

To delete files

1 Tap the Menu icon . 

2 From the Options menu, tap Delete to display the Delete screen.

t u

t
u
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The Delete screen displays the filename and file size of all MP3 files stored in the 
Memory Stick. 

3 Tap the check box before each filename to select that MP3 file for deletion. 

When playback mode is active, the currently playing track is automatically selected in 
the Delete screen. 

TIP: Tap the check box on the header bar to select all MP3 files for deletion. 

4 Tap the Delete button. 

A confirmation dialog box appears.

5 Tap OK to confirm file deletion. 

After deletion, the playlist will automatically be updated. 

6 Tap Done to revert to the AudioBox main screen. 

Tap here.

Tap here.

Tap a check box to select 
a file for deletion.
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AudioBox menu
The AudioBox menu shown here is for your reference only. Features that are not 
explained in this section are discussed elsewhere in this User Manual.

AudioBox has only one menu: Options. 

Options menu  

Preferences 

• Repeated by. Set the repeat mode. Tap the pick list 
to display options. Options include:
– All. The whole active playlist will be played 

repeatedly until the Repeat button is tapped 
again.

– One. The current track will be played repeatedly 
until the Repeat button is tapped again.
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Using Recorder
Recorder allows you to conveniently record audio files whenever and wherever you 
need to. This application is especially useful when you need to record notes when 
jotting them down is not as efficient (or convenient for that matter especially if you 
don’t have a pen at hand) as in the case of a large number of figures or highly-
detailed procedures. 

Recorder main screen
When Recorder is launched by tapping the Recorder icon  in the Multimedia 
category of Applications Launcher, the Recorder main screen appears displaying a list 
of available audio files in the active storage medium. 

• LCD Off After. To minimize battery consumption, it is 
advisable to turn off the LCD backlight during 
playback mode. 
Tap the pick list to display the time interval options. 
Options include: 

– Never. The LCD backlight will remain on all 
throughout the playback period. This setting 
consumes the most battery energy. 

– 1/2/3 minutes. The LCD backlight automatically 
turns off after the set interval time.

• Sleep setting. Sets the number of minutes before 
AudioBox automatically turns off. Options include 15 
minutes, 30 minutes and 60 minutes.

Audio file list number 

Audio file creation date

Audio file playback time

Audio filename 

Available time left for 
recording in the active 
storage source

Storage pick list

Play 

Record 

Command buttons
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Storage media
In saving recorded audio or in playing audio files, Recorder provides two storage 
media:

Audio recording function
You have two options to activate the Record function and start recording audio. 

• Under the Multimedia category of Applications Launcher, tap the Recorder 

icon , then on the Recorder main screen tap .
• Use the Multi-function button (set to Record function). 

Refer to "Rear panel" on the Acer s50 and s60 Handhelds Quick Guide for the 
location of the Multi-function button. 

Before Recording mode is initialized, Recorder checks if the DSP (Digital Signal 
Processing) chipset is available. If it is being used by another application, the warning 
message below appears.

In the warning message box, you can either: 

• Tap OK to terminate the application currently using the DSP. This will start 
Recording mode, or

• Tap Cancel to continue with the original DSP task. The Recorder main screen 
will be shown.

NOTE: This DSP-related error also occurs when Playback mode is activated while the DSP 
chipset is occupied by another application. 

Recording mode Playback mode

• Internal Recorded audio will be saved 
in the handheld’s internal 
memory in .pdb format

Will play back .pdb files stored 
in the handheld’s internal 
memory

• Expansion Recorded audio will be saved 
in the a Memory Stick in MP3 
format

Will play back MP3 files stored 
in a Memory Stick
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During Recording mode: 

• The scroll buttons and the Graffiti area are disabled; the LED indicator flashes 
red. 

• If the Background Recording function is enabled, pressing any of the 
application buttons will launch another application with the recording mode 
still active on the background. 

• If the Background Recording function is disabled, pressing any of the 
application buttons will stop recording and terminate the Recorder 
operation. Recorded audio will automatically be saved to the active storage 
medium. 

To start recording using the Record button
1 In the Recorder main screen, tap the Storage pick list and select a storage medium. 

When Expansion is selected when no Memory Stick is available, recorded audio will 
automatically be saved to the handheld’s internal memory. 

2 In the Recorder main screen, tap . 
The Recorder status screen appears. The same screen appears when Recording mode is 
activated via the Multi-function button. 

.

The available recording time should be more than 10 seconds to start/continue with 
the recording. 

To start recording using the Multi-function button
Before performing the steps below, make sure that the Multi-function button is 
configured to perform the Record function. Refer to "To configure the function of the 
Multi-function button" on page 234 for instructions.

1 Press and hold the Multi-function button until a beep is heard. 

2 Release the Multi-function button to start recording. 

The Recording status screen appears.

3 Press the Multi-function button again to stop recording. 

Elapsed recording time

Remaining time 
available for recording 
in the active storage 
medium

Pause 

Stop 
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To pause Recording:

• Tap . Button image changes to , LED indicator stops blinking, and status 
shows Pause. 

Tap  to continue with the recording.

To stop recording
• Press the power button. 

When you turn on your Acer s60, the Recorder main screen will again be 
displayed. 

• Tap  or press the Multi-function button. 
The screen reverts to the Recorder main screen.

The recorded audio will automatically be saved to the active storage medium.

Audio playback function
The Playback function allows you to play audio files, stored either in your Acer s60’s 
internal memory or in a Memory Stick. 

You can listen to your audio files either through your Acer s60’s built-in speaker or 
through an earphone (included in the package contents) you connect to the earphone 
jack found on of your handheld. 

NOTE: You cannot use the both the earphone jack and the internal speaker at the same 
time. Using one will disable the other. 

Refer to "Front panel" on the Acer s50 and s60 Handhelds Quick Guide for the 
location of the earphone jack and internal speaker. 

During Playback mode: 

• The Graffiti writing area is disabled and the LED indicator flashes red.
• Tapping any of the application buttons will stop playback and terminate the 

Recorder operation. Application assigned to the pressed button will be 
launched. 
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• Pressing the scroll buttons will increase/decrease playback volume.
• Pressing the Multi-function button configured to perform Record function 

will not have any effect on the playback status. 
• Pressing the Multi-function button configured to perform Back function will 

stop playback. Screen shifts back to the Recorder main screen. 

To start audio playback
1 From the Recorder main screen, select the audio file you want to play. 

2 Tap . 
The Playback status screen appears displaying the following information: 

For instructions on how to work in Playback mode, refer to "AudioBox functions" on 
page 91. 

Recorder command buttons
The command buttons on the Recorder main screen allow you to view detailed 
information regarding the listed audio files; you can also rename or delete an audio 
file. 

Audio file list number Audio filename

Total playback timeCurrent playback time

Playback status slider
Go to previous audio file

Pause

Go to next audio file

Stop

Volume slider

Command buttons



4 Working with your supplementary applications
Using Recorder

102   

NOTE: You must first select an audio file before tapping any of the command buttons.

• Details. View detailed information regarding the selected audio file.

• Rename. Modify the filename of the selected audio file.

• Delete. Delete selected audio file.
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File Manager
File Manager is one of the Record menu options. Using this feature, you’ll be able to 
perform basic file management tasks. 

To access File Manager

1 Tap the Menu icon . 

2 From the Record menu, tap File Manager. 

The File Manager screen appears. 

File Manager command buttons
The File Manager command buttons allow you to move, copy or delete listed audio 
files. You must first select an audio file before tapping any of the command buttons. 

To select a source storage medium, tap the pick list on the upper-right corner of the 
screen. Options include Internal and Expansion. 

The Move and Copy commands are only available when there is an unlocked 
Memory Stick. Otherwise, buttons for these two commands are not visible in the File 
Manager screen. 

Before moving or copying audio file(s) between the two storage options, Recorder 
will perform file conversion on the selected files. This means that file(s) to be moved 
or copied from the internal memory to a Memory Stick will be converted from .pdb to 
MP3 format. In a similar manner, file(s) to be moved or copied from a Memory Stick to 
the internal memory will be converted from MP3 to .pdb format. 

TIP: You can tap the check box on the header bar to select or deselect all listed files. 

To move audio file(s): 
1 Select the audio file(s) you want to move. 

2 Tap Move. 

Tap here.



4 Working with your supplementary applications
Using Recorder

104   

3 Tap OK on the confirmation dialog box that appears.

To copy audio file(s): 
1 Select the audio file(s) you want to copy. 

2 Tap Copy.

3 Tap OK on the confirmation dialog box that appears.

To delete audio file(s):
1 Select the audio file(s) you want to delete. 

2 Tap Delete. 
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3 Tap OK on the confirmation dialog box that appears.

Recorder menus
Recorder menus are shown here for your reference only. Features that are not 
explained in this section are discussed elsewhere in this User Manual.

The Recorder menu bar can only be displayed when you are in Recorder main screen. 
The menu bar is inaccessible during Recording or Playback mode. There are two 
menus available: Record and Options. 

Record menu

NOTE: The Rename and Delete menu commands perform the same function as their 
corresponding command buttons on the File Manager screen.

Storage medium is Internal Storage medium is Expansion
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Beam. You can beam an audio file to another Palm OS-based, Acer handheld. This 
option is only applicable for audio files stored in the internal memory. 

1 From the Recorder main screen, select the audio file you want to beam. 

2 Tap the Menu icon . 

3 From the Record menu, tap Beam to display the Beam dialog box. 

When the Beam dialog box appears, point the IR port directly at the IR port of the 
receiving handheld.

TIP: For best results, the handhelds should be between 10 centimeters (approximately 
4 inches) and 1 meter (approximately 39 inches) apart, and the path between the two devices 
must be clear of obstacles. Beaming distance to other Palm OS handhelds may be different.

Options menu

Preferences. Tap to display the Preferences dialog box. Use this screen to define 
settings for the various Recorder features. 

Tap here.
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NOTE: Settings shown in the following screens are the default system settings. 

There are two Preferences tabs: Record and Other. 

• Record 

– Enable Background Recording. Select the check box to enable 
Recorder to continue with Recording mode even after closing the 
application. 

– (Record Hot Button) record to. Select storage medium for recorded 
audio. There are two options: 
- Internal. Saves recorded audio in your Acer s60’s internal memory. 

- Expansion Card. Saves recorded audio in a Memory Stick. 

– Recording Quality. Select quality level of recorded audio. There are 
two options: 
- Normal - 64 Kbps

- High - 128 Kbps

• Other 
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– Sort by. Select basis for viewing files in the audio file list. There are two 
options: 
- Time. Audio files are sorted based on the date they were recorded, with 
the earliest recorded file on top of the list. 

- Filename. Audio files are sorted alphabetically or numerically in an 
ascending order. 

– Beep. Select whether a beep will be sounded or not prior to initializing 
Recording mode via the Multi-function button. There are two options: 
On and Off.

To view related information on the Preferences options, tap the Tips icon .

Using WalkReader
WalkReader enables you to read your eBooks (Acer eBook format) with a few quick 
taps on your handheld. WalkReader can detect eBook files stored in the internal 
memory of your handheld or in a Memory Stick. 

Generating eBooks for WalkReader 
Use WalkReader Converter to convert your regular document files into Acer eBook 
format (.pdb file format), then perform a HotSync operation to transfer the generated 
eBooks to your handheld. 

See "Using WalkReader Converter" on page 161 for more information. 

eBook categories
By default, when WalkReader first detects an eBook file, it is categorized as Unfiled. 
To organize your eBooks, four default categories based on genre is available—History, 
Novel, Poem and Science. For instructions on how to edit these categories, refer to 
"Categorising records" on page 34. 

Online tip for Record tab Online tip for Other tab
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To display eBooks by category
In the WalkReader Manager screen, you can choose to display eBooks by category. 

1 Tap the category pick list on the upper-left corner of the screen. 

2 Tap a category of eBooks to display. 

Working on the WalkReader Manager screen
Using the command icons on the WalkReader Manager screen, you can open your 
eBooks, view detailed information about them, or if you no longer need them, delete 
them. 

To open an eBook
1 Select the eBook file you want to open. 

2 Do any of the following: 

• Tap the Open icon .
• Double-tap the eBook file.

• Tap the Menu icon , then from the Options menu tap Open. 

Tap here.
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The selected eBook file is shown in Browse mode. 

For more information on working on Browse mode, refer to page 112. 

To view detailed information about an eBook
1 Select the eBook file you want to view detailed information about. 

2 Tap the Details icon  to display the Details screen. 

NOTE: The Details command has a corresponding option on the Options menu—accessible 
from both the WalkReader Manager screen and from the Browse mode.

The first four fields display general information regarding the selected eBook and are 
not configurable. The values in these four fields are defined in the File Properties 
screen of eBook Converter during source file conversion.

Refer to "Options menu" on page 167 for more information about the File Properties 
screen.

Tap here.
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The last two fields are user-configurable. 

3 Tap OK. 

To delete an eBook file
1 Select the eBook file you want to delete. 

2 Tap the Delete icon . 

3 Tap OK on the confirmation dialog box that appears.

Title Indicates the eBook’s title. The filename can be up to 16 
alphanumeric characters in length (including blank spaces).

Author Indicates the name of the eBook creator (may have a blank 
value).

Publisher Indicates the name of the eBook’s publisher (may have a blank 
value).

Publish Date Indicates the eBook’s publish date (may have a blank value).

Size Indicates the file size of the eBook.

Category Tap the pick list to change the eBook category of the selected 
file. 

Privacy When the check box is selected (default), the current Privacy 
setting under the system Security preferences is applied. 

NOTE: For information on setting Security preferences, refer to 
page 16.

Tap here.
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File Manager
File Manager is one of the Record menu options. Using this feature, you’ll be able to 
perform basic file management tasks. 

Refer to "File Manager" on page 103 for instructions on how to work on the File 
Manager screen. 

Working in Browse mode
Use the command icons on the Browse view to perform various document viewing 
tasks.

To revert to the WalkReader Manager screen

• Tap the Go Back icon . 
All the current eBook settings are retained and will be applied when you 
reopen the file. 

To define the font type in viewing an eBook

1 Tap the Font icon  to display the Font Selection screen. 

2 Tap on any of the font type frame to select an option.
 

3 Tap OK. 

NOTE: Font settings are saved separately for each eBook file. It does not affect font display 
in other eBook files or in files in other applications. 

To search for text in an eBook

1 Tap the Find icon  to display the Find screen.

Tap here for 
large font.

Tap here for large, 
bold font.

Tap here for 
bold font.

Tap here for standard 
font (default).
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NOTE: The Find command is also available in the Options menu when viewed in Browse view. 

2 Enter the text you want to search for. 

If you have previously used the Find function, the Find screen appears with the last 
text searched highlighted on the Find field. 

3 Define the search mode. 

4 Tap OK. 

When a match is found for the searched text, the matched word is highlighted and is 
moved to the first line of the screen. 

Case Sensitive Tap the check box to consider text case in 
searching for the specified text.

From top of the document Defines the search range. Tap the check box to 
start the search from the top of the document; 
otherwise, search will start from the first line of 
the current screen.

Matched 
word

Tap here.
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When no match is found for the searched text, a message window appears. 

Tap OK. Screen reverts to the Browse view. 

To move around in Browse mode 
Do any of the following: 

• Tap on the top half of the screen to scroll the text up half a page; tap on the 
lower half of the screen to scroll the text down half a page (default action). 
You can change the result of the tap action in the Preferences dialog box. 
Refer to page 124 for more information.

NOTE: Pressing the stylus on the top/bottom half of the screen for more than a second will 
scroll the screen up/down continuously. Release the stylus to stop scrolling. 

• Press the top scroll button to scroll the text up one screen; press the bottom 
scroll button to scroll the text down one screen.

• Tap  to activate Autoscroll mode. This will continuously scroll the screen 
down based on the settings made on the Preferences dialog box. Command 

icon changes to . Tap this icon or any part of the screen to cancel Autoscroll 
mode. 
For more information on setting options for Autoscroll mode, refer to 
page 124. 

• Use bookmarks, refer to page 114.
• Use the Jump To function, refer to page 117. 
• Use hyperlinks, refer to page 118.

Working with bookmarks
Bookmarks help you navigate through your eBook by jumping to the specific location 
referred to by its marker. 
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To create a bookmark
1 In Browse view, define the location for the new bookmark by moving the referred 

text to the first line of the screen. 

2 Tap the Bookmark icon .

TIP: You can also use the Add menu command under the Note menu to add a bookmark. 

3 In the Bookmark screen, tap the New button. 

By default, the first 20 characters (including spaces) on the first line of the selected 
bookmark location serves as the title for the new bookmark. You can define a specific 
title by deleting the default title and entering a new one.

4 Tap OK. 

NOTE: You cannot create bookmarks with the same name in the same eBook but you can 
create bookmarks of different names on the same location in the eBook.

Tap here.

Tap here.
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To go to a bookmark location
1 In the Bookmark screen, tap a bookmark. 

2 Tap the Go To button.

The screen reverts to Browse view with the location referred to by the selected 
bookmark moved to the first line of the screen. 

To delete a bookmark
1 In the Bookmark screen, tap the bookmark you want to delete. 

2 Tap the Del button. 

3 Tap OK on the confirmation dialog box that appears. 

To delete all bookmarks
1 In the Bookmark screen, tap the Del All button.

Tap here.

Tap here.
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2 Tap OK on the confirmation dialog box that appears. 

Using the Jump To function
Another navigation tool provided by WalkReader is the Jump To function. 

To use the Jump To function
1 In Browse view, tap the percentage value pick list to display the Jump To options.

2 Select a Jump To option:

Tap here.

Tap here.

Top The screen will jump to display the first line of the document.

Bottom The screen will jump to display the last line of the document.

Percentage values The screen will jump to the location corresponding to 
selected percentage value. Percentage values increase in 
10% increments.
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Working with hyperlinks
Hyperlinks embedded in your eBook let you jump from one location to another within 
the same eBook. Hyperlinks appear with a dotted underline.

To use hyperlinks
1 Tap the hyperlink (Figure 1) to jump to the linked location (Figure 2) it refers to.

Hyperlink

Tap here

Figure 1 Figure 2
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2 Tap the Back icon  that appears on the linked location to revert to the hyperlink 
location (Figure 3).

3 After you go back to the hyperlink location, the Back icon  is replaced by the 

Forward icon . Tap this icon to revert to the linked location referred to by the last 
tapped hyperlink. 

Using the eBook notes feature 
You have the option to attach descriptive notes to your eBooks. 

To attached a note to an eBook
1 In Browse view, define the location for the new note by adjusting the referred text to 

the first line of the screen.

2 Tap the Menu icon . 

3 From the Note menu, tap Add to display the New Note screen.

4 Enter related note information.

Tap here

Figure 2 Figure 3

Tap here
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5 Tap OK.

NOTE: You cannot create notes with the same name in the same eBook but you can create 
bookmarks of different names on the same location in the eBook.

Note Manager
Use the Note Manager command buttons to manage the notes attached to your 
eBook. 

To access Note Manager

1 Tap the Menu icon .

2 From the Note menu, tap View.

Note Manager command buttons
The Note Manager command buttons allow you view and delete notes attached to 
your eBook. 

The View and Delete buttons are disabled when no note entry is selected. 

To revert to Browse view, tap Done.

To view a note:
1 Tap the note entry you want to view.

2 Tap the View button to display the View Note screen.

Title The maximum length for a note title is 20 alphanumeric 
characters (including blank spaces). A note title that exceeds 
this limit will be automatically cut off.

Content The maximum length for the note content is 280 
alphanumeric characters (including blank spaces). A note 
content that exceeds this limit will be automatically cut off.

Tap here
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The title and content of the selected note entry is displayed on the View Note screen. 
There are three command buttons on this screen: 

– Done. Tap to revert to the Note Manager screen.
– Go To Page. Tap to display the page where the note entry was added.
– Delete. Tap to delete note. A confirmation dialog box appears. Tap OK.

To delete a note:
In addition to the Delete option on the View Note screen, there are two command 
buttons on the Note Manager you can use to remove notes attached to your eBook. In 
both instances, a confirmation box will appear. 

• To delete a single note, tap the note entry you want to delete then tap the 
Delete button. 

• To delete all notes, tap the Delete All button. 

Tap here.

Tap here.
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WalkReader menus
WalkReader menus are shown here for your reference only. Features that are not 
explained in this section are discussed elsewhere in this User Manual.

WalkReader has three menus: Options, Bookmark and Note.

Options menu 
The Options menu differs depending on whether you are viewing it from the 
WalkReader Manager screen or in Browse view. 

Options menu in WalkReader Manager screen:

Rename. Select this menu option to rename an eBook file. Follow the steps below: 

1 If you want to rename an eBook file stored in a Memory Stick, make sure the card is 
unlock. 

2 Select the eBook file you want to rename. 

3 Tap the Rename menu option. 

The Rename screen appears with the current eBook filename highlighted.

4 Enter a new filename. 

Options menu in 
WalkReader Manager screen

Options menu in 
Browse mode
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5 Tap OK to rename the eBook file.

Beam. You can beam an eBook file to another Palm OS-based Acer handheld. This 
option is applicable for eBooks stored in both the internal memory and in a 
Memory Stick. 

1 From the WalkReader Manager screen, select the eBook file you want to beam. 

2 Tap the Menu icon . 

3 From the Record menu, tap Beam to display the Beam dialog box. 

When the Beam dialog box appears, point the IR port directly at the IR port of the 
receiving handheld.

TIP: For best results, the handhelds should be between 10 centimeters (approximately 
4 inches) and 1 meter (approximately 39 inches) apart, and the path between the two devices 
must be clear of obstacles. Beaming distance to other Palm OS handhelds may be different.

Tap here.

Device ID Displays the unique identification number assigned to your 
handheld. 
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Options menu in Browse mode: 

Large Line Space Sets the space between lines to four pixels. 

Median Line Space Sets the space between lines to three pixels. 

Small Line Space Sets the space between lines to two pixels. 

Preferences Opens the WalkReader Preferences dialog box. 

You can use the Preferences screen to define default 
settings in viewing the active document.

• Tap Action. Defines the scrolling behavior after 
tapping the top/bottom half of the screen. 
Options include: 

– 1/2 Page. Scrolls the screen up/down half a 
page. 

– Page. Scrolls the screen up/down one page.
– Line. Scrolls the screen up/down one line.

• Autoscroll Page Speed. Defines the scrolling 
speed when Autoscroll mode is activated. 
Options include: 

– every (5, 10, 15, 20, 25, 30,3 5, 40, and 45) 
seconds. Default value is 10. 

• Show line from previous page. Enabling 
(default) this option will scroll up the screen minus 
one line of text. This means that the last line of 
the screen after scrolling is the same line that was 
at the top of the screen before scrolling.
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Using PhotoWiz
PhotoWiz lets you view image files stored in either your handheld’s internal memory 
or in a Memory Stick. 

Selecting image source
To view the image files stored in either your handheld’s internal memory or in a 
Memory Stick, you need to select them first. 

To select image source 
• Tap the pick list in the upper-right corner of the screen, then select an image 

source. Available image files are displayed in Thumbnail mode.
Options include:

– Internal 

– Expansion
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Working in Thumbnail mode
In Thumbnail mode, all available image files in the active image source are displayed 
in thumbnail format. Use the command buttons on this screen to perform different 
application tasks. 

If a third party card reader is used to copy a source .jpeg file to a Memory Stick, 
instead of a thumbnail image, Photowiz will display a default file icon. In some cases, 
an inherent file icon, if one is available as in the case of image files captured using a 
digital camera, will be displayed instead of the PhotoWiz file icon. 

NOTE: You must first select an image file before tapping any of the command buttons.

To open an image for select viewing 
1 Tap the thumbnail of the image you want to view in View mode. 

2 Tap View. 

Screen shifts to show the processing status after which the selected image is displayed 
in View mode where the image is enlarged. For more information on this mode, refer 
to "Working in View mode" on page 130. 

NOTE: While in the processing stage, you can press the scroll button on the front panel of 
your handheld to skip to another image. Pressing it down will display the next image in the 
current folder. Pressing it up will display the previous image. This also applies when image 
files are selected for Slide Show mode.

TIP: You can also double-tap a thumbnail to open it in View mode. 

To display image in Slide Show mode
1 Tap an image thumbnail. 

2 Tap Slide Show. 

Tap here.
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• If the Show Prefs before slide show check box in the Preferences dialog box is 
selected, the Preferences dialog box appears. 

a. Define image settings for the slide show. 

Refer to page 133 for details on Preferences settings.

b. Tap OK. 

Screen shifts to show the processing status after which the selected image is 
displayed in Slide Show mode.

• If the Show Prefs before slide show check box in the Preferences dialog box is 
not selected, the image is automatically processed for Side Show mode 
display. 

In Slide Show mode, selected image is enlarged in a clear screen—no command 
buttons are visible. You can do the following while in Slide Show mode: 

• Scale image size for preferential viewing - refer to"To scale image size" on 
page 130.

• Press your stylus on an image that does not fit in the display area in its 
entirety and drag it in the desired direction to pan the image. 

• Adjust color balance - see "To adjust color balance" on page 132. 
• Press the scroll button on the front panel of your handheld to skip to another 

image. Pressing it down will display the next image in the current folder. 
Pressing it up will display the previous image.

To return to Thumbnail view from Slide Show mode:

1 Tap the Menu icon . 

2 From the Options menu, tap Exit. 

Tap here.
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To view image attributes
1 Tap an image thumbnail. 

2 Tap the Image Info icon . 

The Image Info screen appears.

The Image Info icon has a corresponding command icon  as well as a menu 
command when the image is displayed in View or Slide Show mode.

Tap here.

Tap here

Filename Indicates the image filename. 

Width Indicates the horizontal length of the image, expressed in pixels. 

Height Indicates the vertical length of the image, expressed in pixels.

File size Indicates the size of the image file, expressed in KB.

Color Model Indicates the color model used to display the image. 
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To delete an image file
1 Tap the thumbnail of the image you want to delete. 

2 Tap the Delete icon . 

3 Tap Yes on the confirmation dialog box that appears.

To set a default folder
To make accessing image files from your Memory Stick faster, Photowiz lets you set a 
folder in the card to serve as the default image source.

1 Using the Browse for Folder icon , select the folder you want to set as the default 
image source, then tap it to open.

2 Tap the Menu icon . 

3 From the Options menu, tap Set Default Folder. 

Tap here

Tap here.
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To attach a note
When the active image source is Expansion, the Note icon  is visible on the 
Thumbnail screen, use this icon to attach a descriptive note to your image files. 

1 Tap the thumbnail of the image you want to attach a note to.

2 Tap the Note icon . 

3 Enter note text.

4 Tap Done.

After a note has been attached to the image file, you can then use the Note icon  
to view, edit, or delete note text. 

Working in View mode
You can do the following while in View mode: 

• Use the View mode command icons to perform various application tasks.
• Scale image size for preferential viewing.
• Press your stylus on an image that does not fit in the display area in its 

entirety and drag it in the desired direction to pan the image.
• Adjust image brightness.
• Press the scroll button on the front panel of your handheld to skip to another 

image. Pressing it down will display the next image in the current folder. 
Pressing it up will display the previous image.

To revert to Thumbnail mode
Do either of the following:

• Tap the Go Back icon . 

• Tap the Menu icon , then from the Options menu, tap Exit. 

To scale image size
Do any of the following to scale the image size to suit your viewing preferences. 

• Use the Image Scaling function
• Use the Image Scaling commands under the Image menu

Tap here
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• Double-tap on the image to zoom in
When scaling an image to the point that it does not fit in the display area in its 
entirety, press your stylus on the image and drag it in the desired direction to pan 
the image.

Image Scaling function
1 Tap the Image Scaling pick list to display the scaling options. 

2 Select a scaling value. 

Options include 200%, 100%, 50%, 25%, and ,12%. These percentage values are in 
relation to the dimension of the source image file, 100% being the actual image 
dimension. 

Image Scaling commands

1 Tap the Menu icon . 

2 From the Image menu, select an image scale.

Options under the Image Scaling command correspond to the percentage values in 
the Image Scaling pick list. 

Tap here.

Select an image scale
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To adjust color balance 

1 Tap the Menu icon . 

2 From the Image menu, select Color Balance. 

3 From each of the color channel bars, you can:

• Tap to the left or right of the slider to adjust the brightness level in small 
increments.

• Drag the slider across the bar to adjust the brightness level in larger 
increments.

The Equal Values check box lets you adjust the slider of a single color channel and 
have the rest of the color channel sliders to automatically adjust to the initial level set.

Tap the Default button to reset the color balance settings to its default level.

4 Tap OK. 

PhotoWiz menus
PhotoWiz menus are shown here for your reference only. Features that are not 
explained in this section are discussed elsewhere in this User Manual.

PhotoWiz has two menus: Options and Image.

• Scale 2 = 200% • Scale 1/4 = 25%

• Scale 1 = 100% • Scale 1/8 = 12%

• Scale 1/2 = 50%

Tap here.
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Options menu 
The Options menu differs depending on whether you are viewing it in Thumbnail 
mode or in Slide Show/View mode.  

Options menu in Thumbnail mode: 

Preferences. Displays the Preferences dialog box where you define viewing settings 
when an image file is displayed in Slide Show or View mode. Settings defined here are 
applied to all image files.

Options menu in 
Thumbnail mode

Options menu in 
Slide Show or View mode

No sleeping in view 
mode

Select this check box to disable your handheld’s Auto-off 
setting when viewing image files in Slide Show or View 
mode. 

Use EXIF thumbnail if 
available

Select this check box to display the image as an EXIF 
(Exchange Image File) thumbnail. 

For more information on EXIF, in Slide Show or View mode, 
select the Help command from the Options menu.
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Image Duration Set the time duration by which an image file is displayed in 
Slide Show mode. 

Options include: 

• Manual - image file stays in Slide Show mode until 
the Exit command under the Options menu is 
selected. 

• 3, 5, 10, and 30 seconds; 1 minute - screen 
automatically displays the next image after the set 
time duration is met. 

NOTE: To stop the slide show, double-tap anywhere on the 
Graffiti® writing area. 

Initial Scale Set the default image scale when viewing images in Slide 
Show or View mode. 

Options include: 

• Auto Scale - Images are scaled to a maximum so 
that the entire screen is used to display it.
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File Manager. Displays the File Manager screen where you can perform basic file 
management tasks. 

Refer to "File Manager" on page 103 for instructions on how to work on the File 
Manager screen. 

Options menu in Slide Show or View mode: 

Help. Displays the PhotoWiz Tips screen.

Exit. Reverts screen to Thumbnail mode. 

The options below are based on the dimension of the 
image file— scaled image to actual image dimension ratio. 
To illustrate, the 2/1 scale will scale the image to twice the 
actual image dimension.

• 2/1 Scale
• 1/1 Scale
• 1/2 Scale
• 1/4 Scale
• 1/8 Scale
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Image menu 

View EXIF Thumbnail Displays the image as an EXIF thumbnail, if the format is 
available.

View Original Displays the image using the dimension captured by the 
digital camera. 
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Using Filer
Use Filer to conveniently perform file management tasks with a few quick taps of your 
stylus. 

Filer main screen
The first time you launch Filer, it will display a list of the files and folders in the 
handheld’s internal memory. The next time you access it, the last accessed path will be 
displayed. 

Title bar Source pick list

Active path
Header bar

File list

Filter area

Command buttons

View directory icon

Title bar Displays the application name and various information 
regarding the active source medium. It is a toggle area which 
alternately displays the available free space (default), total 
space capacity, and number of selected files. Tap the bar to 
change information display. 

Source pick list Tap the pick list to change source medium: Internal 
(handheld’s internal memory) or Expansion (Memory Stick). 

NOTE: When no Memory Stick is available, pick list only displays 
the Internal option. When a Memory Stick is inserted, the contents 
of the Memory Stick are automatically displayed.

Active path This option is only visible when the active source medium is 
Expansion. Indicates the current directory displayed onscreen. 
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Header bar Consists of three cells for managing the file list. 

• Selection box. Tap the box to select all files or to 
clear all file selection. 

NOTE: The File menu on the menu bar includes corresponding 
Select All and Clear All commands.

• Name. Displays the filename of files, folders, and 
database available in the active source medium. Tap 
the heading to change sorting option based on 
alphanumeric order. 

• Information pick list. Tap the pick list to choose an 
information variable to display. Options include: 

– Size - displays the file size of the entry 
– Date - displays the date when entry was created. 
– Ext - display the file extension of the entry

Tap the heading to change sorting option based on 
alphanumeric order. 

File list Displays a list of files, folder, and database available in the 
active source medium. Tap the file icon before each entry to 
select it before tapping any of the command buttons or you 
can tap the entry’s filename and select a command option 
from the pop-up menu that appears. 

Filter area Tap the selected filter option to choose a file category to 
display based on format. Options include: 

• *.* - displays all file formats
• *.pdb 
• *.prc
• *.pqa 

When the active source medium is Expansion, two additional 
options are displayed. 

• *.mp3
• *.jpg, *.gif, *.bmp

Command buttons Use these buttons to perform file management tasks. 
Available buttons vary based on active source medium.

• Internal: Move, Copy, Delete, and Beam
• Expansion: Move, Copy, Delete, and View Directory 

(icon) 

You can use these command buttons to perform file 
management tasks on multiple files.

NOTE: Options for these command buttons are also available 
from the File menu on the menu bar and from the pop-up menu 
that appears when an entry is selected. 
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File management commands
Before performing any file management task, select first an item file list, otherwise, 
the dialog box below appears: 

The Move and Copy commands don’t work when there is no available Memory Stick or 
when the Memory Stick is locked. 

To move or copy a file
1 Select the file you want to move or copy. 

2 Tap Move or Copy. 

When the active source medium is Internal, screen shifts to display the Expansion Card 
directory. 
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When the active source medium is Expansion, the Filer dialog box appears. 

3 Select a destination to which the selected file will be moved or copied. 

• From the Expansion Card directory. 
a.Tap a folder to select it. 

The folder icon will open to identify it as the selected destination. 

b.Tap OK. 

• From the Filer dialog box. 
a.Tap a destination tab. 

– Tapping the To Expansion Card tab will shift the screen to display the 
Expansion Card directory. Follow the substeps above for selecting a 
destination location. 

– The To Internal tab is only valid when the selected file is of a .pdb, .prc, 
or .pqa format. If the selected file is not of any of these format, the 
message below appears.
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Once a valid destination is selected, the move/copy command proceeds. A progress bar 
appears to display the operation status.

To delete a file
1 Select the file(s) you want to delete. 

2 Tap Delete. 
.

3 Tap OK on the confirmation dialog box that appears. 

To beam a file
This command is only available when the active source medium is Internal.

1 Select the file(s) you want to beam. 

2 Tap Beam. 
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3 When the Beam dialog box appears, point the IR port directly at the IR port of the 
receiving handheld.

TIP: For best results, the handhelds should be between 10 centimeters (approximately 
4 inches) and 1 meter (approximately 39 inches) apart, and the path between the two devices 
must be clear of obstacles. Beaming distance to other Palm OS handhelds may be different.

Folder operation 
When using Filer with Expansion as the active source medium, the View Directory 
icon  is visible on the command bar. Tap this icon to display the Expansion Card 
screen where you can perform various folder management tasks including viewing 
directory contents, creating a new folder, and deleting a folder you no longer need. 

The Expansion Card screen shows the active directory. 

To create a new folder
1 Tap the directory where you want the new folder to be located.

Tap here.
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2 Tap New. 

The New screen appears. 

3 Enter a name for the new folder. 

NOTE: The maximum number of characters for the name of a new folder also applies when 
renaming an existing folder. 

4 Tap OK. 

To rename a folder
This command is not available when the active folder is a system default folder; the 
Rename button is not visible on the screen.

1 Tap the folder you want to rename.

2 Tap Rename. 

The Rename screen appears with the current folder name highlighted.

3 Enter a new name for the selected folder. 

4 Tap OK.

Tap here.

Tap here.



4 Working with your supplementary applications
Using Filer

144   

Filer menus
Filer menus are shown here for your reference only. Features that are not explained in 
this section are discussed elsewhere in this User Manual.

Filer has two basic menus: File and Help; when the active source medium is Expansion, 
an additional menu option is visible: Card. 

File menu 
The File menu differs depending on which source medium is active.  

Card menu 

File menu when active 
source medium is Internal

File menu when active source 
medium is Expansion



4 Working with your supplementary applications
Using Filer

 145

Format Opens the Format dialog box. 

Tap Yes if you want to format the Memory Stick.

IMPORTANT: When you format a Memory Stick, all data stored in 
it will be lost.

Rename Opens the Rename dialog box.

Enter a new name for the card, then tap OK.
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Help menu  

Medium Info Opens the Medium Info screen. It shows related system 
information about the active source medium.

Medium Info screen when active 
source medium is Internal

Medium Info screen when active 
source medium is Expansion
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Using Service Launcher
Use Service Launcher to view icons of applications under the Service category of 
Applications Launcher. These icons are displayed in the Personal Service screen. Simply 
tap the icon in the Personal Service screen to launch the corresponding application.

When no application is available under the Service category, the screen below appears 
instead. 

QuickLaunch function
By default, tapping the Service Launcher icon  on the upper-right corner of the 
Graffiti writing area will launch Service Launcher displaying the Personal Service 
screen. Using the QuickLaunch function, you can choose to reassign this icon to a 
specific Service application. 

To define QuickLaunch setting
1 In the Personal Service screen, tap the QuickLaunch pick list. 

Only names of applications categorised under the Service category of Applications 
Launcher are indicated in the pick list. 

2 Select an application.

The selected application will now be launched every time you tap the Service 
Launcher icon . 

If you select None from the pick list, the QuickLaunch setting revert to its default 
value, that is tapping the Service Launcher icon  will display the Personal Service 
screen. 
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Using Backup
Backup allows you to back up data files and applications from your handheld’s 
internal memory to a Memory Stick and to restore data back to your handheld. This 
feature enables you to manage the contents of your handheld’s internal memory 
based on your current space requirements.

NOTE: During a backup or restore process, all application buttons are disabled.

Backup function
The Backup function has two operating modes based on the scope of files to be 
backed up:

• Complete Backup. Scope of backup files includes all data and program files, 
including applications and databases stored in your handheld’s internal 
memory. 

• Partial Backup. Scope of backup files only includes PIM — referring only to 
your basic applications. Your handheld’s basic applications include Date 
Book, Address Book, To Do List, Memo Pad, and Mail. 

To perform a complete backup: 
1 Insert a Memory Stick into your handheld’s Memory Stick slot. 

Make sure the card has enough free space to accommodate the intended backup file.

2 In the Backup main screen, tap Complete Backup. 

The Complete Backup screen appears.

Tap here.
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3 Tap OK. 

During the backup process, a progress screen displaying related backup information 
appears.

Tap Cancel to stop the backup process. No files will be saved and the backup process 
will be disregarded. 

When the complete backup process is completed, a message box will appear to 
confirm it.

To perform a partial backup: 
The procedure in performing a partial backup is similar to that of the complete 
backup. 

1 Insert a Memory Stick into your handheld’s Memory Stick slot. 

Make sure the card has enough free space to accommodate the intended backup file.

Tap here.

Status bar for the 
backup process

Total size of the files 
to be backup 

Size of free space in the 
Memory Stick

Estimated time for the 
backup process to be 
completed
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2 In the Backup main screen, tap Partial Backup. 

The Partial Backup screen appears. 

3 Tap OK. 

Elements in the Partial Backup progress screen are similar to those shown in the 
Complete Backup progress screen. 

Tap Cancel to stop the backup process. No files will be saved and the backup process 
will be disregarded.

When the partial backup process is completed, a message box will appear to confirm 
it.

Restore function
The Restore function has two operating modes based on the type of backup data to 
be restored:

• Complete Restore. Enables you to restore backup data generated by a 
complete backup process from a Memory Stick to the internal memory of 
your handheld. 

• Partial Restore. Enables you to restore backup data generated by a partial 
backup process from a Memory Stick to the internal memory of your 
handheld. 

NOTE: Only backup files generated from the same handheld (same device ID) are available 
for selection in the Restore screen.

To perform a complete restore: 
1 Insert the Memory Stick ,where the Backup-generated file was stored, into the 

Memory Stick slot.

2 In the Backup main screen, tap Complete Restore. 

The Complete Restore screen appears.

Tap here.
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3 Tap the Source pick list to select which backup file to restore.

The Complete Restore screen displays the following information regarding the 
selected backup file:

Tap here.

Tap here.

Device (handheld) ID 
from where the backup 
file was generated

Date and time when 
backup file was created

Size of the selected 
backup file
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4 Tap OK. 

During the restore process, a progress screen appears displaying related information 
on the restore process. 

When the complete restore process is completed, a message box will appear to 
confirm it.

To perform a partial restore: 
The procedure in performing a partial restore is similar to that of the complete 
restore. 

1 Insert the Memory Stick, where the Backup-generated file was stored, into the 
Memory Stick slot.

2 In the Backup main screen, tap Partial Restore. 

The Partial Restore screen appears.

3 Tap the Source pick list to select which backup file to restore.

Status bar of the 
restore process

Size of the selected 
backup file Estimated time for 

the restore process to 
be completed

Tap here.
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The Partial Restore screen displays the same elements as the Complete Restore screen. 

4 Tap OK. 

Elements in the Partial Restore progress screen are similar to those shown in the 
Complete Restore progress screen.

When the partial restore process is completed, a message box will appear to confirm 
it.

Deleting a backup file from a Memory Stick 
To increase the size of available free space in a Memory Stick, you have the option to 
delete backup files that you no longer need. 

To delete a backup file from a Memory Stick
1 In either the Complete Restore or Partial Restore dialog box, tap the Source pick list to 

select the backup file you want to delete. 

2 Tap Delete. 

A confirmation dialog box appears. 

Tap here.

Tap here.
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3 Tap OK. 

A status screen appears to show deletion progress. When deletion is completed, a 
message box appears to confirm it. 

Backup menu
Backup has only one menu—Options. 

Options menu
The Options menu differs depending on whether you are viewing it from the Backup 
main screen or from either of the Restore screens with a backup file selected from the 
Source pick list. 

Options menu when viewing 
the Backup main screen

Options menu when viewing 
a Restore screen

Error Log Opens the Error Log screen. This screen displays a list of processing 
errors, if any, encountered during the backup process that 
generated the selected backup file. The log also indicates the 
cause of the processing error. 
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5 Working with your 
PC utilities
Your handheld includes PC utilities designed to complement the functions of your 
handheld applications.

• Palm Desktop software *
• IntelliSync Lite *
• Voice Converter - the use of this application is only useful for users of the 

Acer s60 handheld since they’re the ones who can access Recorder .pdb files 
from their handheld.

• WalkReader Converter
• PhotoWiz Converter

* For more information on using these utilities, refer to each utility’s online Help.

This chapter explains how to use your handheld’s PC utilities. 

Installing PC utilities
You will first need to install the PC utilities into your computer before you can use 
them. The installation program are located on the Acer s50 and s60 Handhelds 
Installation CD. For instructions, refer to the Acer s50 and s60 Handhelds Quick Guide.

Selecting files when using the PC utilities
To select files in the source file list of any of the converter applications discussed here, 
do any of the following: 

• Left-click. Selects a single file in the source file list. 
• Click and drag or Shift + Left-click. Selects sequential files in the source 

file list.
• Ctrl + Left-click. Selects non-sequential files in the source file list.
• Left-click on an empty area. Deselects all selected file(s).

Also, the toolbar icons on the application main screen perform the same function as 
their corresponding commands on the menu bar and on the pop-up menu that 
appears when you right-click a source file. 

Using Palm Desktop
The main function of the Palm Desktop software is to perform data sychronisation so 
that information in your handheld and your computer remains in sync with each 
other.
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For more information on using this utility, refer to the Palm Desktop online help.

To launch Palm Desktop
1 In the Windows taskbar, click the start Button.

2 Select Programs > Palm Desktop.

Using IntelliSync Lite
IntelliSync Lite is a conduit that will allow you to synchronise the PIM data on your 
handheld with the Microsoft Outlook files on your computer. This application is 
automatically installed in your computer if you choose the Palm Desktop and 
Microsoft Outlook option as setup type during the Palm Desktop installation.

For more information on using this utility, refer to the IntelliSync Lite online help.

Using Voice Converter
With Voice Converter you can convert the .pdb audio files generated by Recorder into 
MP3 files that you can play from any regular MP3 player. 

NOTE: Voice Converter only supports conversion of Recorder-generated .pdb files. 

After conversion, you can transfer the converted files to your Acer s60 via HotSync. 

Refer to page 213 for more information on performing HotSync operations. 

To open Voice Converter
1 In the Windows taskbar, click the start Button.

2 Select Programs > Acer Handheld > Voice Converter.

The Voice Converter main screen appears. 
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Voice Converter toolbar
Use the four command icons on the toolbar to easily perform basic application tasks. 

The Remove and Convert icons are disabled (grayed-out) when no file is 
selected in the source file list. 

NOTE: These commands are also available on the menu bar. 

To add a file to the source file list

NOTE: Adding a file to the source file list does not remove that file from its original 
location; only a copy of that file is added to the source file list.

1 Click the Add icon  to display the Add window.

2 Define the source path of the file you want to add. 

3 Select the file you want to add. 

TIP: You can select and add multiple files at the same time. 

4 Do one of the following: 

• If you selected a single file, click the Open button or double-click the selected 
file.

• If you selected multiple files, click the Open button.

NOTE: The first time you add a file, the default destination folder is the program’s path you 
defined during the installation process. After which, the default path will be change to the 
last folder from which you accessed a file for conversion.

Menu bar

Toolbar

Source file area

Status bar
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To remove a source file from the source file list
1 In the source file list, select the file you want to remove. 

TIP: You can select and remove multiple files at the same time. 

2 Click the Remove icon . 

TIP: You can also use the Delete key in your keyboard. 

A confirmation dialog box appears.

3 Click OK. 

To define the destination path for file conversion
The Convert to field in the toolbar shows the directory path where converted files will 
be saved to. By default, this path will be in the following format: 

Drive:\Palm path\User path\Backup

where: 

• Drive is the hard drive where Voice Converter was installed
• Palm path is the folder where Palm Desktop was installed
• User path is the user name selected for HotSync operations
• Backup is the system default folder where converted files will be saved

If you want to define a different destination path: 

1 In the toolbar, click  to display the Browse for Folder window.

2 Select a folder. 

3 Click OK.

To convert a source file
1 In the source file list, select the file you want to convert. 

TIP: You can select and convert multiple files at the same time. 

2 Click the Convert icon . 

To convert all listed source files

• Click the Convert All icon .
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Voice Converter source file list
The Voice Converter source file list displays four columns of information:

Voice Converter menus
Voice Converter menus are shown here for your reference only. Features that are not 
explained in this section are discussed elsewhere in this User Manual.

Voice Converter has four menus: File, View, Action, and Help. 

Name Displays the filename of the source file.

Size Displays the file size of the source file.

Modified Date Displays the date when the source file was last modified.

Status Displays the conversion status of the source file. 

• Cancelled. Indicates that the user has chosen not to 
overwrite an existing file. 

• Converted. Indicates that the source file has been 
successfully converted to MP3 format.

• Failed. Indicates that an error occurred during file 
conversion. No MP3 file was generated.
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File menu

View menu
.

Help menu  

Remove All Removes all files from the source file list. 

Exit Closes Voice Converter.

Toolbar Check to show the toolbar (default). To hide the toolbar, uncheck this 
option.

Status Bar Check to show the status bar (default). To hide the status bar uncheck 
this option. 

• When a file is selected on the source file list, it shows the 
number of files selected and the total file size. 

• When no file is selected on the source file list, it shows the 
total number of files in the list and the total file size.

Help Topic Click to display the Voice Converter online Help.
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Using WalkReader Converter
With WalkReader Converter, you can convert regular document files into Acer .pdb 
format files that you can access from your handheld using WalkReader. 

To launch WalkReader Converter
1 In the Windows taskbar, click the start Button.

2 Select Programs > Acer Handheld > WalkReader Converter.

The WalkReader Converter main screen appears. 

WalkReader Converter toolbar
Use the seven command icons on the toolbar to easily perform basic application tasks.

The first time you use the Open, Add, Save and Save As commands, the default 
destination folder is the program’s path you defined during the installation process. 

During subsequent WalkReader Converter sessions, the default path will be change to 
the last folder you opened or saved a list to For the Open, Save and Save As 
commands. For the Add command, it will be the last folder from which you accessed a 
file for conversion. 

The Remove and Convert icons are disabled (grayed-out) when no file is 
selected on the source file list.

NOTE: These commands are also available on the menu bar. 

Menu bar

Toolbar

Source file area

Status bar
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To create a new list file

• Click the New icon . 
A new list file appears (.aec format).

If there is an open, unsaved list file, a dialog box prompting the open list file 
to be save appears. 

Click Yes to save the open, unsaved list file; otherwise, click No. 

To return to the open, unsaved list file, click Cancel.

To open an existing list file

1 Click the Open icon  to display the Open window.

2 Define the source path of the list file you want to open. 

3 Select the list file you want to open. 

4 Do either of the following: 

• Click the Open button. 
• Double-click the selected list file.

To save a list file

• Click the Save icon . 

To add a file to the source file list

NOTE: Adding a file to the source file list does not remove that file from its original 
location; only a copy of that file is added to the source file list.

1 Click the Add icon  to display the Add window. 

2 Define the source path of the file you want to add. 

3 Select the file you want to add. 

TIP: You can select and add multiple files at the same time. 

4 Do one of the following: 

• If you selected a single file, click the Open button or double-click the selected 
file.
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• If you selected multiple files, click the Open button.
If an existing file in the source file list has the same filename and of the same file 
format as the file you intend to add, the dialog box below appears. 

Click Yes to overwrite the existing file; otherwise, click No.

The maximum file size for a source file to be converted by WalkReader Converter is 
10 MB. When you try to add a file bigger than 10 MB, a warning message appears and 
the attempt to add the file to the source file list will be disregarded.

To remove a file from the source file list:
1 In the source file list, click the file you want to remove. 

NOTE: You can select and remove multiple files at the same time. 

2 Click the Remove icon . 

To convert a source file
1 Select where to install the converted file during HotSync operation. Options include: 

• Handheld 
• Expansion Card

The User and Install to fields are disabled if the Select a Palm Desktop User for Auto 
Installation option on the Destination window is unchecked.

Refer to "Options menu" on page 167 for more information.

2 In the source file list, select the file you want to convert. 

TIP: You can select and convert multiple files at the same time. 



5 Working with your PC uti l it ies
Using WalkReader Converter

164   

3 Click the Convert icon . 

If an existing eBook file in the destination folder has the same filename as the source 
file that is to be converted, the following dialog box appears: 

Click Yes to overwrite the existing file; otherwise, click No.

When an error is encountered during file conversion, the warning message below 
appears. 

Click OK to revert to the WalkReader Converter main screen.

NOTE: The message boxes above also appear under similar circumstances during conversion 
of all listed source files. 

To convert all files in the source file list:

• Click the Convert All icon .

Conversion reminders
Note the following reminders before converting a source file:

1 When converting an .html file, remember to:

• Keep only the internal hyperlinks (i.e., hyperlinks with target location within 
the same document). WalkReader does not support external hyperlinks. 

• Remove all images from the file. WalkReader only supports text material, not 
images. 

2 When converting a Microsoft Word .doc file with hyperlinks, convert it first to HTML 
format. 
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WalkReader Converter source file list 
The WalkReader Converter source file list displays six columns of information which 
include:

WalkReader Converter menus
WalkReader Converter menus are shown here for your reference only. Features that 
are not explained in this section are discussed elsewhere in this User Manual.

WalkReader Converter has five menus: File, View, Action, Options and Help. 

Source Displays the filename of the source file.

Title Displays the eBook’s title defined in the File Properties screen. If no 
title is defined, this column will be left blank.

User Displays the name of the Palm Desktop user defined in the 
Destination screen. If no user name is defined, this column will be 
left blank. 

Destination Displays the full path of the eBook’s destination folder. 

Size Displays the file size of the source file.

Status Displays the conversion status of the source file. 

• Converted. Indicates that the source file has been 
successfully converted to Acer eBook format; the file size of 
the eBook is also shown. 

• Failed. Indicates that an error occurred during file 
conversion. 

• Cancelled. Indicates that the user has chosen not to convert 
the source file. 
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File menu

View menu

Remove All Removes all files from the source file list. 

Save As Saves the active list file based on user-defined specifications.

File History Displays the last five list files accessed during previous WalkReader 
Converter session.

Exit Closes WalkReader Converter. 

Toolbar Check to show the toolbar (default). To the hide toolbar, uncheck 
this option.

Status Bar Check to show the status bar (default). To hide the status bar 
uncheck this option.

• When a file is selected on the source file list, it shows the 
number of files selected and the total file size. 

• When no file is selected on the source file list, it shows 
the total number of files in the list and the total file size.



5 Working with your PC uti l it ies
Using WalkReader Converter

 167

Options menu

File Properties. Click to display the File Properties screen. This option is disabled 
when multiple files are selected in the source file list.

TIP: You can also display the File Properties screen by right-clicking a source file, then 
selecting Properties from the pop-up menu that appears. 

Use this screen to define general information for the eBook file. This information is 
displayed in the Details screen of WalkReader when you open the eBook from your 
handheld. 

The first two items are non-configurable.

• Source Location. Shows the path of the eBook’s source file. 
• Size. Shows the file size of the corresponding eBook.

The last four items are user-configurable. Except for the Publish Date, you may choose 
to left the remaining fields blank.

• Author. Enter the name of the eBook’s author.
• Publisher. Enter the name of the eBook’s publisher.
• Publish Date. Click the pick list to display the date selector window and 

specify the eBook’s publish date. 
• eBook Title. Enter an eBook title. 
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Destination. Click to display the Destination screen.

Use this screen to define default destination properties for all files in the source file 
list. 

• Select a Palm Desktop User for Auto Installation. Select this option to 
choose a Palm Desktop user name where converted files will be installed 
during HotSync operation. The selected user name will appear in the 
toolbar’s User field. When this option is deselected, the User and Install To 
fields on the toolbar will be disabled. 
There are two options:

– Install to Handheld. eBook files will be installed to your handheld’s 
internal memory. 

– Install to Expansion Card. eBook files will be installed to a 
Memory Stick. When no Memory Stick is available during HotSync 
operation, converted files will automatically be installed in the 
handheld’s internal memory.

• Save a Copy to. Select a folder where a copy of the eBook file will be save 
to. 
There are two options:

– Same folder as source file. A copy of the eBook will be created in the 
same folder as the source file.

– Specified folder. A copy of the eBook will be created in a defined path. 
Default path is the system Temp folder. Click the Browse button to select 
another path.
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Help menu  

Using PhotoWiz Converter
Use PhotoWiz Converter to convert regular image files into a format viewable from 
your handheld using the PhotoWiz application. Converted images can be stored in 
three locations: 

• In your handheld’s internal memory - PhotoWiz .pdb format
• In a Memory Stick - .jpeg format
• In a local folder in your computer’s hard disk - same file format as the source 

file
File formats supported by PhotoWiz Converter include .jpg, .gif, and .bmp. 

To open PhotoWiz Converter
1 In the Windows taskbar, click the start Button.

2 Select Programs > Acer Handheld > PhotoWiz Converter.

The PhotoWiz Converter Add Files screen appears. 

Help Topic Click to display the WalkReader Converter online Help.
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Converting image files
1 Add image source files by doing either of the following: 

• Click the Add Files button, then from the Browse for Folder window, select 
the folder where the image source files are located, then click OK. 

All image files contained in the selected folder will be added to the File Path 
box. 

NOTE: When the Also search sub-folder check box is selected, image files contained in any 
sub-folder under the selected folder will also be added to the FIle Path box. 

• Drag and drop image files from a file browser window or from your desktop 
to the File Path box, then click OK on the Add Files dialog box. 

2 Click Next. 



5 Working with your PC uti l it ies
Using PhotoWiz Converter

 171

3 Select image size for the converted files by clicking any of the radio buttons.

If you want to retain the original dimension of source image file, click Do not resize. 

4 Click Next.

5 Choose a destination location where the converted files will be saved to. 

Options include: 

• HotSync 
Converted files will be automatically added to Palm Desktop Install Tool list. 
From the User Name pull-down menu, select the user name of the Acer 
handheld you wish to install the converted files to. If you wish to install the 
files in a Memory Stick, select the Transfer to expansion memory card check 
box. 
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The next time you perform a HotSync operation, converted files are installed 
to the selected handheld. 

• Directory 
Converted files will be saved to a selected folder. Select a folder by doing 
either of the following:

– Click the Choose a Folder button, then from the Browse for Folder 
window, select a destination folder, then click OK. 

– Drag and drop a folder from a file browser window to the Destination 
area. This will set the selected folder as default saving directory.

6 Click Next to start file conversion. 

Window displays the processing status. 

7 After file conversion is completed: 

If selected destination option is HotSync, click OK on the HotSync dialog box. 

To terminate the PhotoWiz Converter session, click Finish.

If you still wish to convert other files, click the Process More Files button. Window will 
revert to the Add Files screen. Settings defined from previous PhotoWiz Converter 
session are retained. 

Use the Remove Files or the Remove All buttons to clear the source file list.

When PhotoWiz Converter is closed then reopened, all conversion settings revert to 
their default values.
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6 Using the Attention 
Manager
Except for Calculator and Service Launcher, all applications in your handheld will try to 
get your attention with some sort of alarm whenever an previously set alarm 
reminder is activated. Attention Manager allows you to conveniently manage all of 
these notifications in one place. Appointments and messages can stack up while you 
are away from your handheld. Attention Manager lets you view them from a single 
list, where you can selectively dismiss or follow up on each event.

Applications will signal for your attention at two different levels: insistent and subtle. 
Each will be discussed in detail below.

Insistent alarms
Insistent alarms open the Reminder dialog screen, and may play a sound or flash the 
LED indicator depending on your Alarm Preferences settings. Alarms continue until 
you snooze or dismiss them. If the sound can be interrupted, you can tap anywhere on 
the screen, or press any button to silence it. The Reminder dialog screen will always 
open immediately when new insistent alarms are posted.
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Using the Reminder command buttons
The Reminder dialog screen has three buttons for responding to an alarm. 

Setting the alarm preferences
You control the alarm preferences globally in the Alarm panel of the Prefs menu. 
Refer to "Alarm preferences" on page 232 for detailed instructions. 

Setting alarm sound effects
Some applications allow you to set a song or a sound effect to use as an alarm, 
determine how many times to play it. For example, to set alarm preferences for a Date 
Book alarm, do the following:

1 In Date Book, tap the Menu icon .

2 Tap the Options menu. 

3 Select Preferences to display the Preferences screen. 

4 Tap the Alarm Preset check box.
 

OK Tap to make the reminder go away, with no further notification.

Snooze Tap to shift to the application that was running when the alarm went 
off. The Reminder dialog screen will again be displayed after five 
minutes, or you can tap the blinking indicator in the upper left corner 
of the screen to go back to the Reminder dialog screen right away. 
For more information, see "Understanding the blinking alarm 
indicator" on page 176. 

Go To Tap to shift to the application that created the alarm, and show the 
record that caused the alarm. You may have to navigate within the 
application. There will be no further notification.

Tap here.
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5 If you want alarms to sound, select a value for the following by tapping on their 
respective pick lists:

Using the Reminders list screen
The Reminder screen changes to display a list of items under two insistent alarm 
conditions:

• When a second application attempts to get your attention and the first has 
not been dismissed or snoozed.

• When the same application makes a second attempt when the first Reminder 
screen has not yet been dismissed or snoozed.

Each listed reminder contains the date and time of the event. Depending on the 
application displaying the reminder, you may see an icon representing the application, 
and up to two lines of text.

Tapping on the text or icon will "Go To" that item and delete the event from the 
Reminders list screen.

Tapping the check box will clear that item, similar to a To Do list item. The Attention 
Manager will draw a line through the text lines, pause for a moment, and then 
remove the item from the list, although the original data remains in the application.

Alarm Sound Sets the alarm sound effects, for example, Bird or Concerto.

Remind Me Sets how soon you want the alarm to sound before the event.

Play Every Sets how many times the alarm repeats before giving up; the 
pause between each time the alarm sounds
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The Reminders list screen displays three buttons that are used to respond to all of the 
items in the list:

Subtle alarms
Some applications provide a visual, and an optional audible indication, but do not 
otherwise disrupt your workflow. Subtle alarms do not display a Reminders screen. 
Instead, a blinking indicator will flash in the upper left corner of the title bar when an 
alarm is activated. 

Understanding the blinking alarm indicator
A blinking alarm indicator appears in the upper left corner of the title bar under the 
following conditions:

• While viewing a Reminder screen, you tap the Snooze button or in the 
Reminders list screen, you tap the Done or the Snooze button.

• A subtle alarm is present.
The indicator appears in three different states:

• Off. The indicator is not shown at all when the list is empty.
• Blinking, two states: When the list is not empty and there are no new 

items, the “star” indicator will blink on and off until the list has been 
emptied.

• Blinking, three states: When a new subtle alarm is received, the star will 
alternately flash, explode, then off, until you view the new event.
Tapping the indicator opens the Attention Manager in list mode, even if 
there is only one item.

Done If the Reminders list appeared because of more than one 
insistent alarm, tapping Done closes the Reminders list screen, 
although the events will remain in the application that created 
them. The Reminders list screen will not appear again, unless you 
tap the blinking alarm indicator on the upper left corner of the 
screen.

If the Reminders list appeared after you tapped the Snooze 
button, then tapped the blinking alarm indicator, then tapped 
the Done button, the reminder continue to snooze.

Snooze Puts the Reminders list screen to sleep for five minutes. After this 
time interval, the Reminders list screen is displayed again. You 
can go directly to the Reminders list screen without waiting, by 
tapping the blinking alarm indicator. 

Clear All Removes all the items from the list. Tap this button to erase a list 
of events that have passed.
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7 Managing your 
desktop email 
Mail enables you to manage the email you send and receive through your computer’s 
email application. You can read, reply to, compose, and delete emails on your 
handheld once you have performed a HotSync operation.

You can send or receive email after you have performed a HotSync operation, either 
locally using your handheld’s cradle.

Mail synchronises the emails in the Inbox of your desktop email application with the 
emails in the Inbox on your handheld. 

Setting up Mail on your computer
Before you use the Mail application for the first time, make sure that your computer’s 
email application is installed and running. You must also set up the Palm Desktop 
software for use with your computer’s email application. 

NOTE: For instructions on how to set up Palm Desktop software, refer to "To install the 
Palm Desktop software" in the Acer s50 and s60 Handhelds Quick Guide.

Setting up the Mail application and HotSync options
The following instructions assume that you have installed Palm Desktop software on 
your computer, but have not yet set up Mail. 

To set up Mail on your computer
1 Choose one of the following options:

• If you have not yet installed Palm Desktop software on your computer, install 
the software now. You will be prompted to set up Mail as part of the Palm 
Desktop installation.

• If you already installed Palm Desktop on your computer, and set up Mail, skip 
to the next procedure, to set up the HotSync options for Mail.

2 Click the Start button on the Windows taskbar.

3 Select Programs, select Palm Desktop, and then click Mail Setup to begin the setup.

4 Follow the instructions onscreen to set up your handheld for use with your computer’s 
email application.
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To set or change HotSync options for synchronising 
the Mail application

1 Do one of the following:

• At the bottom right corner of the Windows taskbar (in the system tray), click 

the HotSync Manager icon . 

• If the HotSync Manager icon  does not appear on the taskbar, do the 
following to display the icon, then click it. Click the Windows Start button, 
then select Programs > Palm Desktop > HotSync Manager.

2 From the pop-up menu, choose Custom.

TIP: You can also choose Custom from the HotSync menu in Palm Desktop.

3 Choose Mail from the list box.

4 Click Change.

Click here. 

Click here. 

Select Mail. 
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5 Select one of the following options:

NOTE: When you first set up Mail, Synchronize the Files is the default setting.

• To turn off Mail, select Do Nothing and then select the Set As Default check 
box.

6 Click OK. 

Synchronising Mail with your email application
After you turn on and set up Mail, you must perform a HotSync operation to 
synchronise Mail with your computer’s email application. 

For complete information on using HotSync, refer to page 213.

Synchronize the Files Synchronises the email on your Palm Desktop software 
and your computer’s email application.

Desktop overwrites 
handheld

Replaces the email on your handheld with the email in 
your computer’s email application. Use this option only if 
the two inboxes get out of sync for some reason. This 
setting applies to only one HotSync operation and then 
reverts to the default.

Do Nothing Turns off communication between your handheld and 
your computer’s email application. This setting applies to 
only one HotSync operation and then reverts to the 
default.

Set As Default Changes the default setting for all HotSync operations.
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To open Mail

• In Applications Launcher, tap the Mail icon  to display the Mail list screen.

Viewing, creating, and replying to email
The Mail application lets you create emails that you can view, edit, and send from your 
computer’s email application. It also allows you to reply to emails received by your 
computer’s email application. The first time you open Mail, it displays the Mail list 
screen. 

Viewing email items
The Mail list displays a list of your incoming email items, who sent them, and the date 
they were received. 

A check mark indicates that the email have already been read. Email items in bold text 
indicates a high-priority level.

To view email items
• Tap an item in the Mail list. 

By default, the Mail application shows only the From and Subject fields. You 
can display complete information about the sender, receiver, and copied 
recipients, as well as the subject and the date the email item was created. 

Previously read 
email

Unread email

Folder pick list

Tap here to create 
new email.

Tap here to display 
Show Options box.
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To change header information
• Tap a header mode icon in the upper right corner of the screen:

NOTE: The header type you select is applied to all email items.

Recipient

Sender

Time and date sent

Email body

Subject

Header mode icons

Abbreviated header

Complete header 

Abbreviated Header Redisplay the abbreviated header.

Complete Header Display the complete information about the sender, 
receiver, and copied recipients, in addition to the subject 
and date the email item was created.
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To close an email item
• To close an email item, tap Done.

Creating email items
You create email items in Mail the same way you create email in your computer’s 
email application: 

• Identify the recipient of the email item (To field). 
• Define a subject (Subject field). 
• Create the email body. 

At a minimum, all email items must contain information in the To and Subject fields. 
You create original email items and replies in the New Message screen. 

To create an email item
1 Tap New to display the New Message screen.

TIP: You can also create an email item by tapping New in the Message menu.

Tap here.

Tap here.
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2 Enter the email address of the recipient, using the same format as you would from 
your computer’s email application. 

For example, if you are sending an email item to a user on the same network, you 
don’t have to add Internet information, such as @mycorp.com.

3 To send a copy of the email item to additional recipients, tap the CC field, and enter 
the email addresses of the additional recipients, separating the addresses with a 
comma followed by a space.

4 Tap the Subject (Subj:) field and enter a subject for your email item. 

5 Tap the Body field and enter the text of your email item.

Enter recipient’s address
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If the address, CC, subject, or body exceeds the capacity of the screen display, tap the 
name of the field (for example, tap “To:”) to expand that field. Tap Done to return to 
the New Message screen.

To reply to an email item
1 Tap an email item in the Mail list to display it. 

2 Tap Reply to display the Reply Options screen

3 Select who should receive the reply by tapping an option from the Reply To option 
frames. There are three options:

• Sender 
• All (recipients) 
• Forward. To reply to someone who didn’t see the original email item.

4 Tap the Include Original Text check box to include the original email message in the 
reply. Clearing the option creates a blank reply. 

If you selected Include Original Text, tap Comment Original Text to let you edit the 
original text. 

5 Tap OK.

Tap the name of the field to open it.

Tap here.
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6 Enter the text of your reply.

7 If you are forwarding the message, enter a recipient in the To field.

8 Tap Send to place your reply in the Outbox. 

See "Storing and editing email items" on page 188 for more information.

The email items you create are stored in your handheld’s Outbox folder until you 
perform a HotSync operation to synchronise your device with your computer. 

Looking up an address
To identify the recipient of an email item, you must enter that person’s email address. 
You can either enter the data directly in the To or CC field, or use the Look Up 
command to access the information from your Address Book. 

To look up an email address
1 In the Mail list, tap New. 

2 In the New Message screen, tap either the To or CC field name to expand it.

3 Choose from the following options:

• Tap Lookup to display the field’s Lookup screen. The Lookup screen lists all 
Address Book records that contain information in the email field.

• Enter the first few letters of the last name of the person whose address you 
want to find, and tap Lookup. If your handheld completes the desired 
address for you, tap Done to return to the New Message screen.

TIP: You can also display the Lookup dialog box from the New Message, To or CC screens by 
tapping the Menu icon on the front panel of your handheld; then tap Options and tap 
Lookup. Or use the Graffiti Command stroke /L. 

4 In the Lookup screen, enter the first letter of the entry you want, to scroll to the first 
entry that begins with that letter. Enter additional letters to have the list scroll to the 
first entry that starts with those letters.

5 Tap an address to select it, then tap Add.

Tap here.
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6 Tap Done to return to the New Message screen.

Adding details to email items
Before you send your email item, you can add additional information to the message 
if your computer’s email application supports the feature. For example, you can 
specify the message’s priority, create a blind carbon copy, add a signature, or confirm 
that the message was delivered or read. Your handheld cannot attach an email item 
details or attributes that your computer’s email application does not support. 

To add details to an email item
1 In the New Message screen, tap Details.

2 Choose from the following options:

Tap to 
select.

Tap here to enter address in field.

Tap here.

 Priority Tap the pick list to display the Priority options. There are 
three options: High, Normal, and Low priority. 

 BCC Creates a blind carbon copy field in the New Message screen. 

Signature Attaches a previously defined text at the end your email.



7 Managing your desktop email
Viewing, creating, and replying to email

 187

NOTE: The Priority and BCC setting must be set for each email item you create.

3 Tap OK.

4 If you selected the BCC option, in the New Message screen, tap the BCC field and 
enter an address.

Creating a signature for your email item
A signature refers to defining information, such as your name, address, phone and fax 
numbers, and any other text you want to include. It is automatically added to the end 
of every email item you create. The signature is visible only to the email recipient, and 
does not appear in your email item. 

To create a signature

1 Tap the Menu icon .

2 Tap Options, and then tap Preferences.

Confirm Read Requests a confirmation telling you when the email item was 
read.

Confirm Delivery Requests a confirmation telling you when the email item was 
delivered.

BCC field
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3 Tap the Signature text field and enter the text of your signature.

4 Tap OK.

Storing and editing email items
Sending an email item from your device stores it in the Outbox folder until you 
perform a HotSync operation. You can edit unsent email as long as you have not yet 
performed a HotSync operation. 

You can also draft email items and store them until you are ready to send them; 
another option is for you to file email items. 

Storing and editing unsent email items
The email items you send from your handheld are actually stored in the device’s 
Outbox folder until you perform a HotSync operation to synchronise your device with 
your computer. During synchronisation, your handheld transfers email items stored in 
the Outbox folder to your computer’s email application. The next time you send mail 
from this application, it sends the mail you created on your handheld.

When you edit an email item, your handheld removes the item from the Outbox 
folder and displays the New Message screen, where you can edit the item and resend 
it, save it as a draft, or delete it.

For instructions on synchronising Mail with your computer email application, refer 
to page 179. 

To store an email item in the Outbox folder
1 Create a new email item or reply to an item. 

2 Tap Send. 

Add signature text here.
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To edit an unsent email item
1 In the Mail list, tap Outbox from the pick list in the upper right corner of the screen.

2 Tap the email item you want to retrieve.

3 Tap Edit then change the email item as desired.

4 Choose from the following options:

• To return the email item to the Outbox, tap Send.
• To store the email item in the Draft folder, tap Cancel. When prompted, tap 

Yes.

Saving an email as a draft copy
You can save email items that you are drafting and not ready to send by storing them 
in the Draft folder. 

Tap here.

Tap here 
to select 
item.

Tap here 
to edit 
item.
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To save an email item as a draft
1 Create an email item.

2 Choose from the following options:

• Tap the Menu icon , tap Message, and then tap Save Draft.

• In the New Message screen, tap Cancel, and then tap Yes at the prompt.

To edit an email item saved as a draft
1 In the Mail list, tap Draft from the pick list in the upper right corner of the screen.

Tap here. 

Tap here. 
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2 Tap the email draft you want to display.

3 Tap Edit.

4 Enter any changes.

5 Choose from the following options:

• To resave the draft in the Draft folder, tap the Menu icon , tap Message, 
and tap Save Draft; or tap Cancel and when prompted, tap Yes.

• To transfer the item to your Outbox folder, tap Send.

Filing an email item
You can file email in your handheld’s Filed folder. During a HotSync operation, your 
handheld stores a backup copy of the Filed folder on your computer hard drive, but 
does not automatically synchronise the contents of this folder with your computer’s 
email application.

You can retrieve an email item from the Filed folder, edit it, send it, save it as a draft, 
or return it to the Filed folder.

Tap here.

Tap here 
to select 
item.

Tap here 
to edit 
item.
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To file an email item
1 In the Mail list, tap an email item to open it.

2 Tap the Menu icon . 

3 Tap Message, and then tap File.

4 Tap No to save the email item in the Filed folder. 

Tap Yes to file the item in the Filed folder and keep a copy in the Inbox.

Tap here.

Filed item.
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To retrieve an email item from the Filed folder
1 In the Mail list, tap Filed from the pick list in the upper right corner of the screen.

2 Tap the email item you want to restore.

3 Only for email items filed for sending, tap Edit to display and modify the item.

4 To store the email item, choose from the following options:

• Tap Cancel and tap Yes to store the item in the Draft folder.
• Tap Send to store the email in the Outbox.
• Tap Cancel and tap No to return the message to the Filed folder. 

Deleting email items
When you delete an email item, your handheld stores it in the Deleted folder until 
you purge the folder’s contents or perform the next HotSync operation. You can purge 
the contents of the Deleted folder to avoid having deleted emails occupy too much 
space in your handheld’s internal memory. Synchronisation deletes the email item, as 
well as purged items, from your computer’s email application.

You can restore a deleted email item by removing it from the Deleted folder, if you 
haven’t purged the folder contents or performed a HotSync operation yet.

To delete an email item
1 In the Mail list, tap the email you want to delete. 

2 Tap Delete. 

3 Tap Yes. 

Tap here.
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To display a prompt before an email item is deleted

1 Tap the Menu icon . 

2 Tap Options, and then tap Preferences. 

3 To display a prompt, tap the Confirm deleted message check box.
 

To restore an email item by moving it out of the Deleted folder
1 In the Mail list, tap Deleted from the pick list in the upper right corner of the screen.

Tap here.

Select this check box.
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2 Tap the email item you want to restore.

3 Choose from the following options:

• If you created the email item that you deleted, tap Edit to display and modify 
the item. You can send the item or save it as a draft.

Tap here.

Tap here to edit item.
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• If you received the email item that you deleted, tap Undelete to move the 
selected item to the Inbox and mark it as Read.

To purge the contents of the Deleted folder

1 Tap the Menu icon . 

2 Tap Message. 

3 Tap Purge Deleted.

4 Tap Yes. 

NOTE: You cannot restore email items after you purge them.

Tap here.

Tap here.
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Categorising and sorting email items
You can display email items by the folders provided for categorising mail, and 
according to the email date. 

NOTE: By default, the Date column is hidden in the Mail list to increase the available screen 
space. 

You can also sort email items by the date sent, by sender, or by subject. No matter how 
you sort the list, high-priority email items always appear first.

To select an email folder to display:
1 In the Mail list, tap the pick list in the upper right corner of your screen to display the 

list of folders.

2 Tap a folder you want to display in the Mail list screen. Options include: 

3 Repeat steps 1 and 2 to choose another folder. 

Tap here.

Inbox Contains email items received from your computer’s email 
application Inbox, except any excluded using filtering options. 
Refer to "Using filters to control downloading" on page 200 for 
more information on filtering options.

Outbox Contains email items you created and sent on your handheld since 
the last HotSync operation.

Deleted Contains any email you deleted since the last HotSync operation

Filed Contains email items that you have stored on your handheld

Draft Contains the email items you have created using your 
handheld but have not yet sent.
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To display the Date column in email items
1 In the Mail list, tap Show.

2 Tap the Show Date check box to select it. 

3 Tap OK.

To sort the email list
1 In the Mail list, tap Show.

2 Tap the Sort by pick list and tap one of the following options to select it, then tap OK.

Select this check box.

Tap here.

Date Sorts email by date and displays the most recent email item at 
the top of the screen.

Sender Sorts email by the sender’s user name and displays items in 
ascending alphabetical order, based on the first word on the 
From field.

Subject Sorts email by the subject and displays items in ascending 
alphabetical order, based on the first word on the Subject 
field.
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Managing your email application with HotSync
You can manage your email application more effectively by selecting HotSync options 
to control which email items to download when you synchronise your handheld and 
your computer. You can define different settings for local and remote synchronisation. 

Once your local and remote options have been defined, your handheld determines if 
synchronisation is occurring locally or remotely and uses the appropriate settings for 
the HotSync operation.

You can filter messages to control which ones to download, and you can set 
truncation options to download only part of lengthy email items.

Downloading transmits only email items and any text information, not attachments, 
to your handheld. Downloaded attachments are left in your computer’s email 
application. 

To set HotSync Options to control synchronising 
email items

1 In the Mail list, tap the Menu icon .

2 Tap Options, and then tap HotSync Options.

Tap here.
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3 Tap the Settings for pick list, and select Local HotSync or Remote HotSync.

For more information on Local and Remote HotSync operations, refer to page 213. 

4 Tap the filtering option you want to apply during synchronisation:

5 Choose from the following options:

• If you selected All, Send Only, or Unread, tap OK. 
• If you selected Filter, continue to the next section.

Using filters to control downloading
You can create special filters to control the type of email items that you download to 
your handheld during synchronisation. Special filters ignore or retrieve items that 
contain specific information in their header fields, according to what you have 
instructed your handheld to look for in the To, From, and Subject fields. 

Tap here.

All Download all email items in your computer’s Inbox to your 
handheld, and send all email items in your handheld’s Outbox 
to your computer’s email application.

Send Only Send only email items in your handheld’s Outbox to your 
computer’s email application; from there, your computer’s 
email application sends the items to their destinations.

Filter During synchronization, all email items in your handheld’s 
Outbox are sent to your computer’s email application, and 
email items in your computer’s email application that meet 
specific criteria is downloaded to your handheld. When you 
select the FIlter string, the HotSync Options dialog box opens 
and displays additional filter settings.
For more information, refer to ’Using filters to control 
downloading’ on the subsequent section.

Unread Download only unread email items from your computer’s 
Inbox to your handheld, and all items in your handheld’s 
Outbox to your computer’s email application
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To access the special filter screen
• In the HotSync Options screen, tap Filter.

To create the special filter settings
1 In the HotSync Options dialog box, choose from the following filter options:

• Retrieve All High-Priority. If your email application can flag high-priority 
items, tap this option to retrieve these items and override any filter settings

• To define whether to ignore or receive an email item that meets filter 
settings, tap the pick list on the middle of the screen. Options include:

Tap here.

Tap here.

Ignore Messages 
Containing

To have your handheld exclude email items that meet the 
defined criteria and download all other email items during 
synchronisation. In general, this filter downloads more 
email during synchronisation because it blocks only one 
defined subset of email item.
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• To define a filter string, fill-out the To, From, and Subject fields. 
• Truncate. To stop long email items from downloading. 

Tap the button and then specify a number of characters, between 250 and 
8,000 (the default is 4,000.) Tap OK.

A lower Truncate value reduces the time to synchronise your computer’s 
email and Mail; less email storage space in your handheld will also be used. 
Messages longer than 8,000 characters will be truncated.

2 Tap OK.

Defining filter strings
Your handheld filters email items based on information in their To, From, and Subject 
fields, called a filter string. You create a filter string by listing the words you want your 
handheld to find and separating them by either a comma or a space. Each word in the 
filter string is joined by an implicit OR; logical connectors like AND or OR are 
automatically added.

To create a more complex filter, you can define filter strings for the To, From, and 
Subject fields. Your handheld joins the filter strings for these fields using an implicit 
AND, and adds the logical connector for you.

For example, you might want to receive only email items from John Smith 
(jsmith@aol.com) or Jack Jones (jjones@aol.com) concerning the Apollo Project. You 
would create the following filter strings:

• In the To field: jsmith@aol.com, jjones@aol.com
• In the Subject field: Apollo Project

Your handheld interprets this as, "Accept email items about the Apollo Project from 
John Smith or Jack Jones. Do not accept email items from other people. Do not accept 
email items from John or Jack about any other subject."

Retrieve Only Msgs 
Containing

To have your handheld include only the email items that 
meet the defined criteria and ignore all other email items 
during synchronisation. This filter can block more email 
during synchronisation because it downloads only one 
subset of email item.

Tap here.
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When you define a string, your handheld searches for any instance of that sequence 
of characters. For example, if you define a filter that retrieves only email items with 
the string "info", appropriate matches would include "info", "rainforest" and 
"kinfolk". 

To define a filter string
1 Enter your filter string in the To, From, or Subject header field in the HotSync Options 

dialog box. Use commas or spaces to separate the words. Do not add connectors, such 
as AND or OR, between words in a string.

2 If your string exceeds the length of the field, tap the name of the field to display the 
Notes screen for that header field.

3 Tap Done to return to the HotSync Options dialog box.

4 Tap OK.

Mail menus
Mail menus are shown here for your reference only. Features that are not explained in 
this section are discussed elsewhere in this User Manual.

Mail has three menus: Message, Edit, and Options.

Tap here.

Enter 
filter data.
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Message menu
The Message menu differs depending on whether you are viewing an email item, 
creating an email item or viewing the Mail list. 

Message menu when 
creating an email item

Message menu when viewing 
an email item

Message menu when viewing 
the Mail list
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Options menu
The Options menu differs depending on whether you are viewing it from an email 
item or a Mail list or whether you creating an email item. 

Options menu when creating 
an email item

Options menu when viewing 
an email item or a Mail list 
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8 Beaming information
Your handheld is equipped with an IR (infrared) port that you can use to beam 
information to another Palm OS handheld that is close by and also has an IR port. The 
IR port is located at the top of the your handheld, behind the small dark shield. 

You can beam the following information between Palm OS handhelds:

• The record currently displayed in Date Book, Address Book, To Do List, or 
Memo Pad.

• All records of the category currently displayed in the Address Book, To Do 
List, or Memo Pad applications.

• A special Address Book record that you designate as your business card, 
containing information you want to exchange with business contacts.

• An application, audio file, or an eBook file installed in RAM memory.
• An application or an eBook file installed in a Memory Stick. 

NOTE: HotSync operations can also be done using the IR port. Refer to "IR HotSync 
operations" on page 220 for more information. 

Beaming a business card
To select a business card for beaming:

1 Press the Address Book button  on the front panel of your handheld.

2 In the Address List, do one of the following: 

• Create a new entry to contain the information you want on your business 
card.

• Select an existing entry containing the information you want on your 
business card. 

3 In Address view, tap Record. 

4 Tap Select Business Card. 

5 Tap Yes.

Beaming a record
To beam a record, business card, or category of records:

1 Locate the record, business card, or category you want to beam.

2 Tap the Menu icon .

3 Tap Record.

4 Choose from the following options:
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• Tap Beam to beam an individual item.
• In the Address Book application only, tap Beam Business Card.

• Press the Address Book application button  for about two seconds to beam 
your business card.

• Tap Beam Category (for records that are displayed in a category).
• Draw the Graffiti Command stroke to activate the toolbar, and then tap the 

Beam icon . 
• Use the Graffiti Command stroke /B to beam the current entry.

NOTE: You can set the full-screen pen stroke to beam the current entry. For instructions, 
refer to "To change what the full-screen pen stroke activates" on page 235. 

5 When the Beam Status dialog box appears, point the IR port directly at the IR port of 
the receiving handheld.

TIP: For best results, handhelds should be between 10 centimeters (approximately 
4 inches) and 1 meter (approximately 39 inches) apart, and the path between the two devices 
must be clear of obstacles. Beaming distance to other Palm OS handhelds may be different.

When the Beam Status dialog box indicates that the transfer is complete, you can 
resume working on your handheld.

Beaming an application
To beam an application

1 In Applications Launcher, tap the Menu icon . 

2 Tap App, and then tap Beam.

3 Tap the application you want to transfer, and tap Beam.



8 Beaming information
Beaming an application

 209

Some applications are copy-protected and cannot be beamed; this is indicated by a 
Lock icon.

4 When the Beam Status dialog box appears, point the IR port directly at the IR port of 
the receiving device to start sending the selected application.

When the Beam Status dialog box indicates that the transfer is complete, you can 
resume working on your handheld.

Copy-protected applications are 
indicated by a Lock icon.
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Receiving beamed information
To receive beamed information:

1 Turn on your handheld.

2 Point the IR port directly at the IR port of the transmitting handheld to open the 
Beam Status dialog box.

3 A dialog box will appear to confirm whether you want to accept the beamed record.

4 You can select a category for the incoming information, create a new category or 
leave it unfiled.

5 Tap Yes. 

6 Wait for the Beam Status dialog box to indicate that the transfer is complete, and 
then tap OK to display the new entry. 

NOTE: Incoming records, unless categorised, are placed in the Unfiled category.
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Turning off beaming
To turn beaming on or off

1 In the All or System category of Applications Launcher, tap the Prefs icon . 

2 In the pick list in the upper right corner, tap General.

3 In the General Preferences panel, tap the Beam Receive pick list, and then tap On or 
Off to select the option.

Tap here to toggle on or off the beam function.
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9 Exchanging and updating 
data using HotSync operations

HotSync® technology lets you synchronise—exchange and update—data between one 
or more Acer handhelds and Palm Desktop software or another PIM such as Microsoft 
Outlook. To synchronise data, you must connect your handheld and Palm Desktop 
software either directly, by placing your handheld in the cradle attached to your 
computer or using infrared communication, or indirectly, via LAN connection.

The HotSync process automatically synchronises data between your handheld and 
Palm Desktop software. Changes you make on your handheld or on your Palm 
Desktop software appear in both places after a HotSync operation. HotSync 
technology synchronises only the needed portions of files, thus reducing 
synchronisation time. 

Performing a HotSync operation 
The first time you synchronise your data, you must enter user information on both 
your handheld and Palm Desktop software. After you enter this information and 
synchronise, the HotSync Manager recognises your handheld and doesn’t ask for this 
information again.

Creating a user profile
If you are a System Administrator preparing several handhelds for a group of users, 
you may want to create a user profile. 

NOTE: You can create a user profile to load data into a handheld without associating that 
data with a user name, using the File Link feature. File Link lets system administrators to 
configure several handhelds with specific information (such as a company phone list) before 
distributing them to their actual users. Refer to "Using File Link" on page 229 for more 
information. 

To create a user profile
1 Open Palm Desktop.

2 From the Tools menu, choose Users.

3 In the Users window, click Profiles.
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4 Click New. 

5 Enter a name for the profile.

6 Click OK.

Performing a local HotSync operation
The following steps assume that you have already installed the Palm Desktop 
software. If you have not yet installed this software, refer to "To install the Palm 
Desktop software" on the Acer s50 and s60 Handhelds Quick Guide for instructions.

Click here. 

Click here. 

Enter new profile name. 
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To perform a local HotSync operation
1 Insert your handheld into the cradle.

2 If the HotSync Manager is not running (i.e., the HotSync Manager icon  is not visible 
in the bottom right corner of the Windows system tray) start it: 

• In the Windows taskbar, click the Start button then highlight Programs.
• Navigate to the Palm Desktop program group and choose HotSync Manager. 

Alternatively, you can start the Palm Desktop software which automatically 
opens the HotSync Manager.

3 Press the HotSync button on the cradle.
.

NOTE: If you are using an optional USB or Serial Sync Cable instead of a cradle, click the 
HotSync Manager icon in the bottom right corner of the Windows system tray, then select 
Local from the menu.

4 Enter your user name in the New User dialog box and click OK. 

The HotSync Progress dialog box appears and synchronization begins. 

IMPORTANT: Every handheld should have a unique name. To prevent loss of user’s records, 
never try to synchronise more than one handheld to the same user name.
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5 Wait for a message on your handheld’s screen indicating that the process is complete.

6 When the HotSync process is complete, you can remove your handheld from the 
cradle by gently tilting the handheld forward and then pulling it up to remove.

Selecting HotSync setup options
You can choose when you want HotSync Manager to run. If necessary, you can adjust 
the local and modem HotSync settings as well.

To set the HotSync options

1 Click the HotSync Manager icon  in the Windows system tray.

2 Choose Setup.
 

3 Click the General tab, and select one of the following options:

Click here. 



9 Exchanging and updating data using HotSync operations
Selecting HotSync setup options

 217

If you are not sure which option to use, keep the default setting.

4 If you are using a Serial Sync Cable, click the Local tab to display the settings for the 
connection between your computer and the cable.

NOTE: If you are using a cradle, you do not need to use the settings on the Local tab for a 
direct HotSync operation. 

5 Adjust the following options as needed:

Always available Default setting. Adds HotSync Manager to the Startup 
folder and constantly monitors the communication 
port for synchronisation requests from your handheld. 
With this option, the HotSync Manager synchronises 
data even when Palm Desktop is not running.

Available only when Palm 
Desktop is running 

Starts HotSync Manager and monitors requests 
automatically when you open Palm Desktop software.

Manual Monitors requests only when you select HotSync 
Manager from the Start menu.

 Serial Port Identifies the port that HotSync Manager uses to communicate with 
the Serial Sync Cable. The Palm Desktop software automatically 
detects the port to which you connected the cable. If necessary, you 
can change the port selection. 

NOTE: The selection should match the number of the port to which you 
connected the Serial Sync Cable. This port cannot be shared with an 
internal modem or another device. 
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6 Click the Modem tab to display the modem settings and adjust the options as needed.

7 If you are attached to a network, click the Network tab to display the network settings 
and adjust the options as needed. 

For more information on HotSync operations via network, refer to page 225.

8 Click OK.

Customising HotSync application settings
For each application, you can define a set of options that determines how records are 
handled during synchronisation. These options are called a "conduit". By default, a 
HotSync operation synchronises all files between your handheld and Palm Desktop 
software.

In general, you should leave the settings to synchronise all files. The only reason you 
might want to change these settings is to overwrite data on either your handheld or 
Palm Desktop software, or to avoid synchronising a particular type of file because you 
don’t use it.

In addition to the conduits for Date Book, Address Book, To Do List, and Memo Pad, 
Palm Desktop software includes System and Install conduits. 

The System conduit backs up the system information stored on your handheld, 
including Graffiti® ShortCuts. 

The Install conduit installs applications on your handheld. 

To customise HotSync application settings

1 Click the HotSync Manager icon  in the Windows system tray. 

2 From the HotSync Manager menu, choose Custom.

Speed Determines the speed at which data is transferred between your 
handheld and Palm Desktop software.
Try the As Fast As Possible rate first, and adjust downward if you 
experience problems. This setting allows Palm Desktop and your 
handheld to find and use the fastest speed.

Click here. 
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TIP: You can also click HotSync > Custom on the Palm Desktop software menu bar.

3 Select the appropriate user name from the list.

4 Select an application in the Conduit list. 

5 Click Change.

6 Click the direction in which you want to write data, or click Do Nothing to skip data 
transfer for an application.

7 Choose how long the setting will remain in effect:

• To have the setting affect only the next HotSync operation, deselect the 
Default button. Thereafter, the HotSync Actions revert to their default 
settings. 

• To use a new setting as the default, select the option. Thereafter, whatever 
you selected as the default setting is used when you click the Default button 
in the Custom dialog.

8 Click OK.

9 Repeat steps 4 through 8 to change conduit settings for other applications.

Click 
here. 

Select an 
application 
from the list. 



9 Exchanging and updating data using HotSync operations
IR HotSync operations

220   

10 Click Done to activate your settings.

IR HotSync operations
Your handheld is equipped with an infrared (IR) port that supports the IrCOMM 
implementation of the standards for infrared communication established by the 
Infrared Data Association (IrDA). This means that not only can you beam data to 
another Palm OS handheld but also to any other device that supports the IrCOMM 
implementation of the IrDA standards. 

But more importantly, your IR port allows you to perform HotSync operations without 
using a cradle. This is very useful if you travel with an infrared-enabled notebook 
computer. You simply enable infrared communication on your notebook computer 
and on your handheld, then follow the steps described in "Performing an IR HotSync 
operation" on page 223. 

Preparing your computer for infrared communication
Before you can perform a HotSync operation using the IR port, the computer you 
want to synchronise with must meet the following requirements:

• The computer must support the IrCOMM implementation of the IrDA 
standards.

• The computer must have an enabled infrared port built-in, or an enabled 
infrared device attached to the computer.
Desktop computers are likely to require an infrared device attached to a 
physical COM port. Notebook computers are likely to have a built-in IR port. 

NOTE: Check the documentation that came with your computer to determine if it supports 
infrared communication.

• Your computer must also have an installed infrared driver. If you have an 
external infrared device attached to your computer, a driver is probably 
included with the device. Consult the documentation that came with your 
device for information on installing the required driver. 

NOTE: Infrared communication is built into the operating system for Microsoft Windows 98 
and later versions. 

To enable your computer’s IR function
1 In the Windows taskbar, click the Start button.

2 Highlight Settings, and then choose Control Panel.

3 For Windows 98 users, look for the Infrared icon  in the Control Panel; for users of 
Windows Me and later Windows operating system versions look for the Wireless Link 

icon .
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• If the Infrared icon  is visible, perform the following steps: 

a Double-click the Infrared icon . 
b Click the Options tab.
c Select Enable infrared communication. 

The COM port listed is the port used for infrared communication. It 
should be different from the default serial port used by HotSync 
Manager for local serial HotSync operations. 

d Click Apply. 
e Click OK. 

• If the Wireless Link icon  is visible perform the following steps:

a Double-click the Wireless Link icon . 
b Click the Infrared tab.
c Select Enable infrared communication. 
d Click Apply. 

For systems running on Windows 2000 or Windows XP, perform the following 
additional configuration procedures: 

1 In the Windows taskbar, click the Start button.

2 Highlight Settings, and then choose Control Panel.

3 In the Control Panel double click the Wireless Link icon . 

4 Click the Image Transfer tab.

5 Deselect the check box for Use Wireless Link to transfer images from a digital camera 
to your computer function, if it is enabled.

6 Click Apply. 

7 Click OK. 

Configuring HotSync Manager for infrared communication
Next you need to configure HotSync Manager for infrared communication. 

To configure HotSync Manager for infrared communication
For systems running on Windows 95, Windows 98, or Windows Me, perform the steps 
below: 

1 Click the HotSync Manager icon  in the Windows system tray. 

2 Make sure Local Serial is checked on the pop-up menu.



9 Exchanging and updating data using HotSync operations
IR HotSync operations

222   

3 Choose Setup.

4 In the Setup window, click the Local tab.

5 In the Serial port drop-down box, select the port that your computer uses for infrared 
communication.

6 Click OK.

The HotSync Manager is now enabled to perform infrared communication between 
your computer and your handheld. 

For systems running on Windows 2000 or Windows XP, perform the steps below: 

1 Click the HotSync Manager icon  in the Windows system tray. 

Click here. 

Enable Local Serial. 

Click here. 
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2 In the pop-up menu, make sure Infrared is checked.

The HotSync Manager is now enabled to perform infrared communication between 
your computer and your handheld. 

Performing an IR HotSync operation
After you complete the steps to prepare for an IR HotSync operation it is easy to 
perform the actual operation.

To perform an IR HotSync operation

1 In Applications Launcher, tap the HotSync icon .

2 Tap Local.

3 Tap the pick list below the HotSync icon and select IR to a PC/Handheld.

4 Position the IR port of your handheld within a couple of inches of the infrared port of 
your computer.

5 Tap the HotSync icon  to start the IR HotSync operation.

Enable Infrared. 

Tap here. 
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Returning to using the cradle for local USB 
HotSync operations
If you are using the provided cradle, you can continue using it while HotSync Manager 
is configured for infrared communication. Perform the following procedures to return 
to Local USB cradle HotSync operations only when needed, such as when you have 
disconnected the cradle from the USB port. 

To return to local USB cradle HotSync operations
1 If needed, connect the cradle to the USB port on your computer used for HotSync 

operations. 

2 Click the HotSync Manager icon  in the Windows system tray.

3 Select Local USB if it is not already checked.

Reconfiguring HotSync Manager to return to local 
serial HotSync operations
If you are using the optional Serial Sync Cable, you have to reconfigure the HotSync 
Manager to perform local serial HotSync operations.

To reconfigure HotSync Manager to return to local serial 
HotSync operations

1 If needed, connect the Serial Sync Cable to the serial port on your computer used for 
HotSync operations. 

2 Follow steps of 1 to 4 of "To configure HotSync Manager for infrared communication" 
on page 221. 

3 In the Serial port drop-down box, select the COM port where your Serial Sync Cable is 
connected. 

4 Click OK.

Enable Local USB. 
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Performing a HotSync operation via a network
When you use the Network HotSync software, you can take advantage of the LAN and 
WAN connectivity available in many office environments. The Network HotSync 
technology lets you perform a HotSync operation by dialing in to a network or by 
using a cradle that is connected to any computer on your LAN or WAN (provided that 
the computer connected to the cradle also has the Network HotSync software 
installed, your computer is on, and the HotSync Manager is running).

To perform a HotSync operation via a network, you must meet the following 
requirements:

• Your computer has TCP/IP support installed.
• Both your company’s network system and its remote access server support 

TCP/IP. (Your system administrator has this information.)
• You have a remote access account. (If you don’t have an account, consult your 

system administrator.)
Everything you need to connect to your company’s dial-in server (network modem) is 
included in the Palm Desktop software and in your handheld. You need to activate the 
feature, however, on both Palm Desktop software and on your handheld.

To prepare your computer for a network HotSync operation:

1 Click the HotSync Manager icon  in the Windows system tray.

2 From the HotSync Manager menu, choose Network.

3 From the HotSync Manager menu, choose Setup.

Click here. 

Enable Network. 
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4 In the Setup window, click the Network tab, select the check box next to your user 
name.

5 Click OK.

6 Place your handheld in the cradle, then perform a HotSync operation.

The HotSync operation records network information about your computer on your 
handheld. With this information, your handheld can locate your computer when you 
perform a HotSync operation over the network.

To prepare your handheld for a network HotSync operation

1 In Applications Launcher, tap the HotSync icon . 

2 Tap the Menu icon .

3 From the Options menu, tap Modem Sync Prefs.

4 Tap Network.

5 Tap OK.

Select your user name. 

Tap here.

Tap here.
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6 On the HotSync screen, tap Modem.

7 Tap Select Service.

8 Tap the Service pick list to select a service.

9 Tap Done. 

10 Tap the Menu icon . 

Tap here. 

Tap here.

Tap here to select a service.
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11 Tap Options, then Conduit Setup.

12 In the Conduit Setup dialog box, tap the check boxes to deselect the files and 
applications that you do not want to synchronise during a network HotSync 
operation. The default setting is to synchronise all files. 

13 Tap OK. 

Performing a HotSync operation via a network
After you prepare your computer and your handheld, and select your Conduit Setup 
options, you are ready to perform a network HotSync operation.

To perform a network HotSync operation:

1 In Applications Launcher, tap the HotSync icon . 

2 Tap the HotSync Modem icon  to begin the operation.

3 Wait for the HotSync operation to complete.

Tap here. 
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Using File Link
The File Link feature lets you import Address Book and Memo Pad information into 
your handheld from a separate external file such as a company phone list. HotSync 
Manager stores the data in a separate category on your Palm Desktop software and 
on your handheld. You can configure the File Link feature to check for changes to the 
external file when you perform a HotSync operation. 

With File Link, you can import data stored in any of the following file formats:

• Comma delimited (.csv)
• Tab delimited (.tsv)
• Memo Pad archive (.mpa)
• Address Book archive (.aba)
• Text (.txt)

For information on how to set up a file link, see the Palm Desktop software online 
Help.
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10 Setting preferences 
for your Acer handheld
Using the Preferences dialog box, you can customise the configuration options of your 
handheld. These options include:

Alarm Set preferences for alarm reminders including settings for 
alarm volume, LED indicator function and alarm sound 
effects. 

Buttons Assign different applications to the buttons on the front 
panel of your handheld and to the HotSync button on the 
cradle. You can also configure the function of the Hot 
Button, and reassign the full-screen pen stroke command.

Connection Configure cradle, modem, and infrared communication 
settings.

Date & Time Set the date, time, time zone and Daylight Saving Time (DST) 
switch.

Digitizer Calibrate the display screen of your handheld.

Formats Set the country default and the formats for date, times, 
calendar, and numbers.

General Set the auto shut-off interval, the Stay on in Cradle feature, 
the system and game sounds; the Beam Receive feature, and 
the Backlight Power Saving function.

HiDensity Set the display density of add-on applications you installed in 
your handheld.

Network Configure your handheld for use with a network.

Owner Assign your name, phone number, and other owner 
information to your handheld.

Phone Select the connection type for your phone applications.

ShortCuts Define a list of Graffiti abbreviations.
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Opening Preferences 
You set preferences to customise your device. To access a Preferences panel, do the 
following:

1 In the All or System category of Applications Launcher, tap the Prefs icon . 

Screen shows the most recently accessed Preferences panel.

2 Tap the pick list in the upper right corner of the screen.

3 Select the Preferences option you want to view.

Alarm preferences
Alarm Preferences let you configure the volume, LED indicator function, and sound 
effects settings for alarm reminders. 

To set the alarm volume
• Tap the Alarm Volume pick list, then select the alarm volume level—Off, Low, 

Medium, and High.
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To set the alarm LED settings
You can set alarms in Date Book and Clock to remind yourself of important 
appointments or events. When you enable the LED settings, the LED indicator on the 
front panel of your handheld flashes red to notify you of alarms. This is useful for 
situations where you want the alarm sound to be off, but still be notified of alarms. 

• Tap the Alarm LED pick list and select On or Off.

Alarm Sound Manager
The Alarm Sound Manager displays a list of available background sounds you can use 
when an alarm is activated. Default sounds include Alarm, Alert, Bird, Concerto, 
Phone, Sci-Fi, and Wake-up.

For additional alarm background sounds for you handheld, go to www.acer.com.tw.

Tap here to listen to the 
selected background 
sound. 

Tap here to remove the 
selected background 
sound from the list. 

http://www.acer.com.tw
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Buttons preferences
Buttons Preferences let you assign different applications to the buttons on the front 
panel of your handheld, and to the HotSync button on the cradle. For example, if you 
find that you seldom use the To Do List and often use Mail, you can assign the To Do 
List button to start the Mail application.

You can also use the Buttons Preferences to configure the function of the 
Multi-function button on the left side panel of your handheld, and to determine 
whether the full-screen pen stroke activates the Graffiti Help application or one of 
your handheld controls.

To assign applications to the front panel application buttons
1 Tap the pick list next to the icon of the front panel application button you want to 

reassign.

2 Tap the application that you want to assign to that button.

To configure the function of the Multi-function button

1 Tap the pick list next to the Multi-function button icon . 
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2 Tap the function that you want the Multi-function button to serve.

• Back Function (default setting)
– When used in an open application, it switches the screen to the previous 

one. 
– When used in Applications Launcher, it toggles between the application 

categories.
• Record Function - launch Recorder and activate recording mode for Acer s60. 

You can also use the Multi-function button to perform specific third-party application 
functions. For configuration instructions, refer to the documentation of that 
application. 

To change what the full-screen pen stroke activates
1 Tap Pen... to display the Pen screen.

Tap here. 
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2 Tap the pick list and tap a function you want the full-screen pen stroke to activate. 

3 Tap OK.

To change the HotSync buttons preferences
1 Tap the HotSync... to display the HotSync Buttons screen.

Backlight Turns on the backlight.

Brightness Displays the Adjust Brightness screen. 

Keyboard Opens the onscreen keyboard for entering text characters.

Graffiti Help Opens a series of screens that show the complete Graffiti 
character set.

Turn Off & Lock Turns off and locks your handheld. You must assign a 
password to lock your handheld. When locked, you need to 
enter the password to use your handheld. Refer to "Locking 
your handheld" on page 23.

Beam Data Beams the current record to another IR-enabled device that 
is near your handheld. Refer to "8 Beaming information" on 
page 207.
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2 Tap the pick list next to the HotSync button you want to assign.

3 Tap the application you want to assign to that button. 

The default setting for each button is the HotSync setting, which means the cradle 
and the optional modem perform their normal HotSync functions.

4 Tap OK.

To restore all of the buttons to their factory settings, tap Default.

Connection preferences
Connection preferences allow you to create configurations for communicating with a 
computer, a modem, or a GSM mobile phone. Configurations, or profiles, once 
activated are available to various end-user applications running on your handheld. 

The list of available configurations in the Connection Preferences panel can be 
modified to reflect the required settings. This list will vary depending on the software 
available on your handheld.

Tap here. 
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Connection Types
There are five basic types of connections you can choose from when configuring your 
preferences. They are described here:

Standard Modem This connection type defines a connection between a 
modem attached to the versatile port of your handheld and 
a modem.

Cradle/Cable This connection type defines the direct cradle/cable 
connection between your handheld and your computer. It is 
used when performing a local HotSync operation. Your 
handheld is connected to the cradle/cable through the 
Versatile Connector. The cradle/cable is attached by its cable 
to a USB/serial port on your computer. 

IR to a PC/Handheld This connection type defines a connection between the IR 
port of your handheld and the infrared device of your 
computer or other devices.

IR to GSM Phone This connection type defines a connection between the IR 
port of your handheld and an infrared-enabled GSM mobile 
phone. 

Serial to GSM Phone This connection type defines a connection between the 
Versatile Connector of your handheld and a GSM mobile 
phone, using a special cable designed to match your phone.
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Other possible connection types: 

To modify Connection preferences
1 In the Connections Preferences panel, tap a connection option to select it. 

2 Tap Edit... to display the Edit Connection screen. 

3 Make the desired changes. 

4 Tap OK. 

Setting an Infrared to modem connection
You can create a modem connection that enables IR HotSync through an IR-enabled 
modem. This modem would then dial a modem attached to your computer to perform 
the remote HotSync operation.

Modem via Cradle/
Cable

This connection type defines a connection between your 
handheld’s Versatile Connector and a modem for dialing in 
a modem that is part of your computer.

Modem via Infrared This connection type defines a connection between the IR 
port of your handheld and a modem. The modem can be 
attached to or within a mobile phone or other devices 
supporting an IR port. (Some IR phones have modems.) 

Tap here. 
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To create an Infrared to Modem connection
1 In the Connection Preferences panel, tap New.

2 Enter a name for this configuration (default: Custom).

3 In the Connect to pick list make sure Modem is selected.

4 In the Via pick list, select Infrared.

5 In the Dialing pick list, tap TouchTone or Rotary. 

Select Rotary only if your telephone service does not support TouchTone dialing.

6 Tap the Volume pick list and select the speaker volume for the modem.

Tap here. 
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7 Tap Details at the bottom of the screen.

8 Tap the Speed pick list and select the maximum speed for your modem to 
communicate with your handheld. 

NOTE: This setting does not control the speed at which your modem communicates with 
your telephone service.

9 Tap the Flow Control (Flow Ctl) pick list, and select a flow control mode for the 
modem connection. 

Options include Automatic, On, or Off.

Tap here. 
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10 If necessary, edit the Init String text to change the modem setup string. 

11 Tap OK through each screen until you are returned to the Connection Preferences 
panel.

Date & Time preferences
The Date & Time Preferences panel lets you set the date, time, time zone and Daylight 
Saving Time (DST) options for your handheld.

To set the date
1 Tap the Set Date box to display the Set Date calendar screen.

2 Tap the arrows at the top of the Set Date calendar screen to select the current year.

3 Tap the month.

4 Tap the current date.

The screen closes and the dates you selected are displayed in the Set Date box.

Tap here. 
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To set the time
1 Tap the Set Time box to display the Set Time dialog box.

2 Tap the up/down arrows to change the hour. 

3 Tap the minute frames, then tap up/down arrows to change the number. 

4 If the time display mode is based on a 12-hour clock, tap AM or PM. 

5 Tap OK to set the new time. 

NOTE: To display time based on a 24-hour clock, change the time format. See "Formats 
preferences" on page 244. 

To set the time zone
1 Tap the Set Time Zone box to display the Set Time Zone dialog box.

2 Use the scroll arrows to scroll to your country and time zone. 

TIP: You can use the hardware scroll buttons to view the list a page at a time.

3 Tap your time zone to highlight it. 

Tap here. 

Tap here. 
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4 Tap OK.

TIP: Choose the time zone from the list that corresponds to where you are. When you 
travel, use this dialog to change time zones. If you are not sure what time zone you are in, 
find out what time it is, and select the time zone which shows the current time. Do not use 
the Time Zone dialog to switch between daylight savings time and standard time. Use the 
Daylight Savings pick list.

To set daylight saving time
• Tap on the Daylight Saving pick list to toggle this feature on or off.

Digitizer preferences
The first time you start your handheld, setup instructions appear onscreen. These 
instructions include a calibration screen, or Digitizer. Calibration aligns the internal 
circuitry of your handheld with its touch-sensitive screen so your handheld can detect 
the task you want to perform when you tap an element on the screen.

You can recalibrate your screen after a hard reset, or if your digitizer drifts. 

To calibrate your screen
• In the Digitizer screen, follow the onscreen instructions, tapping the screen 

where indicated.

Formats preferences
The Formats Preferences panel lets you choose a default country for your 
handheld. You can also set the display format for time, date, and numbers, as well as 
choose the starting day of the week. 
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Setting default country 
The default country adjusts the time, date, and number formats, as well as the 
starting day of the week.

To choose a default country
1 Tap the Preset To pick list. 

2 Tap a country name.

Setting time, date, week start, and number display formats
The Time setting defines the format for the time of the day. The time format that you 
select appears in all applications in your handheld. 

To change the formatting of the time, date, week start, 
and numbers

1 Tap the Time pick list and select a format, where H is hour and M is minute. 
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2 Tap the Date pick list and select a format, where D is day, M is month, and Y is year.

3 Tap the Week starts pick list, and select whether you want the first day of the week to 
be Sunday or Monday. 

NOTE: This time, date and week start settings controls the Day, Week, Month, and Agenda 
views in Date Book and all other aspects of your handheld that display a calendar.

4 Tap the Numbers pick list, and select formats for the decimal point and thousands 
separator.
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General preferences
The General Preferences panel enables you to set the auto shut-off interval; the Stay 
on in Cradle feature, sounds and volume, the Beam Receive feature, and the Backlight 
Power Saving function.

Setting the Auto-off interval time
You can set when your handheld automatically shuts off. Your handheld automatically 
turns off the power and backlight after a period of inactivity, to conserve battery 
power. If you find that your handheld shuts itself off before you finish reviewing the 
information on the screen, you can increase the automatic shutoff setting.

To set the Auto-off interval time
1 Tap the Auto-off After pick list. 

2 Tap an option—30 seconds, 1 minute, 2 minutes, or 3 minutes.
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Setting the sounds and volumes
Your handheld uses a variety of sounds. You can control the sound and volume for 
system alerts and game sounds using the General Preferences panel.

To set the system and game sounds
1 Tap the System Sound pick list and select the sound level—Off, Low, Medium, or High.

NOTE: When you turn off the System Sounds, you also turn off the 'chimes' tones associated 
with HotSync operations.

2 Tap the Game Sound pick list and select the sound level—Off, Low, Medium, or High.

NOTE: The Game Sound setting typically works only with newer games that are 
programmed to respond to it. Older games don’t usually respond to this setting.
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Turning Beam Receive on and off
You can choose to turn off the Beam Receive feature. This prohibits anyone from 
beaming information to your handheld. It also results to a slight saving in battery 
power. 

To change the Beam Receive feature
• Tap the Beam Receive pick list and select On or Off. 

For more information on using the beam function, refer to "8 Beaming 
information" on page 207.

Setting your Acer handheld to stay on while in the cradle
You can choose to leave your handheld on when it is in the cradle during a HotSync 
operation, or when you are recharging your battery, so you can continue viewing your 
data. 

To set your device to stay on while in the cradle
• Tap the Stay on in Cradle check box to allow your handheld to stay on while 

in the cradle. 
Deselecting this box will cause your handheld to shut off after the Auto 
shutoff time interval that you set. 
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Setting the backlight power saving mode 
You can choose to activate the power saving mode for the backlight to minimize 
battery consumption. 

To set the backlight power saving mode
• By default, the Backlight Power Saving check box is selected to enable the 

backlight’s power saving mode. Tap the check box to disable this function.

NOTE: The backlight automatically turns off after one minute of standby operation. Tap the 
screen or press any of the hardware buttons to turn the backlight back on. 

HiDensity preferences
Some add-on applications you might install on your handheld may not display 
properly on the screen. If this happens, use HiDensity Preferences to correct the 
situation. 

To set the display density settings
• Tap the check box before the add-on application to correct its display density. 

You can choose to tap Select All to set all add-on applications’ display density. 
In the same manner, you can tap Deselect All to display all add-on 
applications using their default display density settings. 

Tap here to enable 
the Stay on in Cradle 
option. 
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Network preferences
The TCP/IP software that is included in your handheld’s operating system lets you 
connect with remote Internet Service Providers (ISPs) or dial-in (remote access) servers, 
using applications that let you view the transmitted data. 

To use TCP/IP, you must first create a configuration in Connection Preferences and 
then define the Network preference settings. Then you connect to your ISP or dial-in 
server. 

Network Preferences lets you set a password, telephone number, DNS number, IP 
address, as well as create a login script for remote connections. You can use a preset 
service template for your ISP or dial-in server, and edit, save, and reuse settings. Or 
you can create your own service template.

Tap here to select all 
applications. 

Tap here to deselect 
all applications. 
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To set network preferences
1 Tap the Service pick list. 

2 Tap the predefined service template you want to use.

Service templates are a set of ISP and dial-in configuration settings that you can 
create, save and reuse.

3 In the User Name field, enter the user name that identifies you when logging in to 
your ISP or dial-in server.

Only two lines appear onscreen, but the field can contain multiple lines of text. The 
user name identifies the name you use when you log into your ISP or dial-in server. Do 
not enter spaces in your user name unless your dial-in server accepts them. 

4 Choose whether to use a password when logging onto your ISP or dial-up service:

• To not be prompted for a password during log-on, tap the Password field. 
Enter your password and tap OK. "Assigned" appears in the field. 

• To have your handheld prompt you for the password during log-on, leave 
"Prompt" in the Password field and do not enter anything. You should 
choose this option if you are concerned about security. 

Tap here.

Tap here.

Enter password.
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5 Tap the Connection pick list and select one. 

The list includes the configurations displayed in your Connection Preferences panel. 
Refer to "Connection preferences" on page 237. 

6 Tap the Phone Number field to display the Phone Setup dialog box.

Use this setting to define the telephone number you use to connect with your ISP or 
dial-in server. 

7 Enter the phone number you use to reach your ISP or dial-in server. 

8 If you need to enter a prefix or disable Call Waiting, proceed to the next steps. 
Otherwise, tap OK.

Tap here.

Tap here.

Enter your ISP phone number.
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9 To enter a prefix before the telephone number to access an outside line, tap the Dial 
Prefix check box, and enter the prefix.

A prefix is a number that you dial before the telephone number to access an outside 
line. For example, many offices require that you dial “9” to dial a number outside the 
building.

10 To turn off call waiting, tap the Disable call waiting check box, and enter the code to 
turn off Call Waiting. (If you don’t know the code, contact your local telephone 
company for the appropriate code.)

NOTE: The call waiting function can end your network session if you receive a call while you 
are connected.

11 To use a calling card to dial your ISP or dial-up service: 

a. Tap the Use calling card check box. 

b. In the Use calling card field, enter three commas. 

Each comma delays transmission of your calling card number for two seconds, to 
compensate for the delay before the number is entered.

Enter your prefix.Select to use a prefix.

Select to turn off 
Call Waiting.

Enter your disable code.
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c. Enter your calling card number. 

12 When you have finished setting up your phone number, tap OK.

Connecting to your ISP or dial-in service
Once you have set the Connection and Network preferences, you can easily connect to 
your ISP or dial-in server using PPP (Point-to-Point Protocol), SLIP (Serial Line Internet 
Protocol), or CSLIP (Compressed Serial Line Internet Protocol) protocols. 

You can make the connection using either Network Preferences commands or a 
third-party application. 

NOTE: TCP/IP provides the ability to connect to your ISP or dial-in server with third-party 
application, such as a Web browser or news reader, that lets you view the transmitted data. 

To establish a connection
• In the Network Preferences panel, tap the Connect button to dial the current 

service and display the Service Connection Progress messages. 

TIP: To see expanded Service Connection Progress messages, press the lower half of the 
Scroll button during login.

To close a connection
• Tap Disconnect to terminate the connection between your handheld and 

your service.

Customising service templates
You can create your own service templates from scratch or duplicate existing 
templates and edit the information. 

Select to use a 
calling card. Enter your calling 

card number.
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If you use one of the predefined service templates, you probably only need to enter 
your user name and telephone number. If you create a new service template, you may 
have to provide additional information.

To create a new service template

1 In the Network Preferences panel, tap the Menu icon . 

2 From the Service menu, tap New. 

A new service template (called Untitled) is added to the Service pick list. 

To duplicate an existing service template
1 In the Network Preferences panel, tap the Service pick list. 

2 Tap the predefined service template you want to duplicate.

3 Tap the Menu icon . 

4 From the Service menu, tap Duplicate. 

A copy of the service template is added to the Service pick list.

Tap here.

Tap here.
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To edit a service template
1 In the Network Preferences panel, select a service template. 

2 Tap Details.

3 Tap the Connection type pick list, and select a connection type.

Tap here.

Tap here.

PPP Point-to-Point Protocol
Select this type if you are unsure which protocol you need. If PPP 
doesn’t work, ask your ISP or your system administrator for the 
correct connection type.

SLIP Serial Line Internet Protocol

CSLIP Compressed Serial Line Internet Protocol
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4 Tap the Idle timeout pick list to specify how long will your handheld wait to drop your 
connection when you switch out of a TCP/IP application.

5 Enter a DNS number following the instructions on "To specify a primary and 
secondary DNS number" on page 259. 

6 Tap OK.

To delete a service template
1 Tap the Service pick list.

2 Tap the service template you want to delete.

3 Tap the Menu icon . 

Tap here.

1 minute Your handheld will wait for one minute for you to open another 
application before it drops the connection.

2 minutes Waits for two minutes.

3 minutes Waits for three minutes.

Never Your handheld will keep the connection until you turn off the 
device (or until it times out). 
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4 From the Service menu, tap Delete.
 

5 From the confirmation dialog box that appears, tap OK.

Entering DNS numbers and IP addresses
The Internet uses the Domain Naming System (DNS) to translate the names of host 
computers into IP addresses. A DNS number (or IP address) identifies a specific server 
that handles the translation services. 

Each DNS or IP address is a series of four numbers, from 0 to 255, separated by periods.

Anyone who logs onto the Internet must have a unique identifier—an IP address. This 
IP address can be either temporary—assigned automatically each time you log on—or 
permanent. 

Not all systems require that you enter a DNS number; check whether it is with your 
system administrator. If a DNS number is required but not entered, logging on to your 
network may appear successful. However, the connection will fail if you try to use an 
application or look up information.

If your system requires DNS numbers, ask your Internet Service Provider or system 
administrator what they are.

To specify a primary and secondary DNS number
1 In the Network Preferences panel with a service template selected, tap Details. 

2 Tap the Query DNS check box to deselect it.

Tap here.
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3 Choose one of the following options:

• If your system doesn’t require a DNS or you are not sure whether it does, 
leave the DNS field blank. 

• To enter the Primary DNS number: 
– Tap the space to the left of the first period in the Primary DNS field and 

enter the first section of the IP address using a number only, from 0 to 
255. 

4 Enter the second, third, and last sections of the Primary DNS field by repeating the 
procedures above. 

5 Enter the Secondary DNS number using the same procedures as for entering the 
Primary DNS number.

To specify the IP address

NOTE: Check with your system administrator whether your IP address is automatically 
(temporarily), or permanently assigned, and if it is permanent, get the address.

1 In the Network Preferences panel, with a service template selected, tap Details. 

2 Choose one of the following options:

• If your IP address is automatic and temporary, make sure that the IP Address 
check box is selected.

Tap to deselect.
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• If your IP address is permanently assigned: 
– Tap the IP Address check box to deselect it. 
– In the permanent IP address field, tap the space to the left of the first 

period, and enter the first section of the IP address using a number only, 
from 0 to 255. 

3 Enter the second, third, and last sections of the IP Address field by repeating the 
procedures above. 

4 Tap OK.

Creating a login script
A login script is a series of commands that automates logging into a network server, 
for example, your office LAN or your ISP. A login script is associated with a specific 
service template created in Network Preferences. 

You can create login script files in two ways: 
• In a text editor on your computer, in which you create a file with an 

extension pnc. You can then install this file in your handheld using the Install 
Tool. 

• In the Login Script dialog box, accessed from the Details dialog box in 
Network Preferences. 

NOTE: Some commands, such as Send, require additional information and have a parameter 
field to add the necessary data.

You can also use non-ASCII and literal characters in your login script. Refer to "Using 
non-ASCII characters in login scripts" on page 263.

To create a login script on your Acer handheld 
1 In the Network Preferences panel, with a service template selected, tap Details.

Tap to select an automatic 
IP address. 
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2 In the Details dialog box, tap the Script button.

3 In the Login Script screen, tap the End pick list.

4 In the pick list, tap any of the following commands to select them, and then enter 
additional information if a field appears.

Tap here.

Tap here.

Wait For Instructs your handheld to wait for specific characters from the 
TCP/IP server before executing the next command

Wait for Prompt Detects a challenge-response prompt coming from the server 
and then displays the dynamically generated challenge value. 
You then enter the challenge value into your token card, which 
in turn generates a response value for you to enter on your 
handheld. This command takes two arguments, separated by a 
vertical bar (|) on the input line. 

Send Transmits specific characters to the TCP/IP server to which you 
are connecting.

Send CR Transmits a carriage return or LF character to the TCP/IP server 
to which you are connecting.
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5 Repeat steps 3 and 4 until you have completed the login script.

6 Tap OK. 

7 Tap OK in the Details dialog box.

Using non-ASCII characters in login scripts
If you know how to write custom scripts with non-ASCII characters, you can 
incorporate the caret (^char) character, carriage returns and line feeds, and literal 
characters in your custom login scripts.

Caret (^ char)
Use the caret (^ char) character to transmit ASCII command characters. If you send 
^char, and the ASCII value of char is between @ and _, then the character is 
automatically translated to a single-byte value between 0 and 31. 

For example, ^M is converted to a carriage return. If char is a value between a and z, 
then the character sequence is translated to a single-byte value between 1 and 26. If 
char is any other value, then the character sequence is not subject to any special 
processing. Thus, the string “Joe^M” transmits Joe, followed by a carriage return.

Carriage return and line feed
You can include carriage return and line feed commands as part of the login script, 
when entered in the following format:

<cr> Sends or receives a carriage return

<lf> Sends or receives a line feed

Send User ID Transmits the User ID information entered in the User ID field of 
the Network Preferences dialog box.

Send Password Transmits the password entered in the Password field of the 
Network Preferences dialog box. If you did not enter a 
password, this command prompts you to enter one. 

NOTE: The Password command is usually followed by a Send CR 
command.

Delay Instructs your handheld to wait a specific number of seconds 
before executing the next command in the login script.

Get IP Reads an IP address and uses it as the IP address for your 
handheld. This command is used with SLIP connections. 

Prompt Opens a dialog box and prompts you to enter text of some kind, 
for example, a password or a security code.

End Identifies the last line in the login script.
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For example, the string “wait for Joe<cr><lf>” waits to receive Joe, followed by a 
carriage return and line feed from the remote computer, before executing the next 
command in the script.

Literal characters
You can use the backslash ( \ ) character to specify that the next character be 
transmitted as a literal character, and not be subject to any special processing 
ordinarily associated with that character. For example:

\^ Includes a caret as part of the string

\< Includes a < as part of the string

\\ Includes a backslash as part of the string

Plug-in applications
You can create a plug-in application containing script commands that extends the 
functionality of your handheld’s built-in script command. A plug-in application is a 
standard prc application that you install on your handheld just like any other 
application. After you install the plug-in application, you can use the new script 
commands in a login script. 

Plug-in applications have the following characteristics:
• Written in C language
• Compiled into a device executable
• Called properly from a login script
• Able to return control to a login script after it terminates
• Created using a development environment that supports Palm OS software, 

such as Metrowerks CodeWarrior for Palm Platform 

Troubleshooting TCP/IP connections
If you have problems connecting to a network using TCP/IP, you can display various 
information to troubleshoot the problem. These includes: 

Also, check with your system administrator whether a DNS number is required. If a 
number is required but not entered, the connection may fail. Refer to "Entering DNS 
numbers and IP addresses" on page 259 for more information. 

Expanded Service 
Connection Progress 
messages

Describes the current stage of the login procedure.
These messages are helpful in identifying at what point 
in the login procedure did the connection failed. 

Network Log Lists all the communication that occurs between your 
modem and dial-in server during the login procedure. 
This information can help your ISP or your system 
administrator identify where and why the login 
communication fails.
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To expand the display of progress messages during login
1 In the Network Preferences panel, tap Connect. 

2 To see the expanded Service Connection Progress messages, press the lower half of 
the Scroll button during login.

For more information refer to "Connecting to your ISP or dial-in service" on 
page 255. 

To view the Network Log

1 With the Network Preferences panel displayed, tap the Menu icon .

2 Tap Options, then tap View Log.

3 Tap the scroll bar to see the entire Network Log.

4 Tap Done.

Network Preferences menus
Network Preferences has a menu bar containing commands that will help you create 
and edit service templates. The menus are shown here for your reference. Features 
that are not explained in this section are discussed elsewhere in this User Manual.

Network Preferences has three menus: Service, Edit and Options. 

Owner preferences 
The Owner Preferences panel lets you record a name, company name, phone number, 
or any other information you want to include on your handheld.

If you use the Security application to turn off and lock your handheld with a 
password, information that you enter in the Owner Preferences dialog box appears 
the next time you turn on your handheld. 

Tap here.
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To change owner preferences on your Acer handheld 
• In the Owner Preferences panel, enter the text you want to associate with 

your handheld. 
If you enter more text than can fit on one screen, a scroll bar appears at the 
right side of the screen. 

NOTE: If you have assigned a password to your device using the Security application, you 
must unlock the Owner Preferences panel to change the information on it. 

To unlock the Owner Preferences panel
1 Display the Owner Preferences panel.

2 Tap Unlock. 

The Unlock Message dialog box appears. 

3 Enter your current password (the one you entered in the Security application).

4 Tap OK. 

Enter owner 
information here.

Enter your Security 
password.
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Phone preferences
Your handheld can be connected to a GSM mobile phone to give you wireless access to 
email and the Internet. Depending on the type and model of your phone, your 
handheld can communicate using the infrared port, or a cable. Here are a few 
guidelines:

• You must have digital services already activated on your phone.
• Your phone must have a driver.
• Your phone must have an enabled infrared capability that complies with the 

IrDA standard, or you must purchase a cable designed for your phone model.

Communicating with your mobile phone
Once you have set up your wireless account, you are ready to set up a connection to 
your GSM mobile phone. Your phone can then be used to connect to the Internet 
wirelessly, similar to a modem. In addition, you can manage the data on your mobile 
phone using your handheld. These include: 

• Access and exchange phone book records between your handheld and your 
mobile phone

• Use your handheld to look up and dial numbers
• Check the status of your phone, signal strength, and battery level.

Setting up related Network preferences
You use the Network Preferences panel to record information about your internet 
service provider (ISP) which includes your login information and connection profile: 

1 In the Network Preferences panel, tap the Connection pick list.

2 Select Infrared to GSM Phone or Serial to GSM Phone according to your connection 
setup.

3 Use information about your ISP to fill in the remainder of the screen, and the Details 
screen.

Setting up related Connection Preferences
You use the Connection Preferences panel box to select your mobile phone, and the 
connection profile.

1 In the Connection Preferences panel, select Infrared to GSM Phone, or Serial to GSM 
Phone, according to your hardware setup.

2 Tap the Edit button.

3 Tap on the Connect to pick list, and select Phone.

4 In the Via pick list, select Infrared or Serial according to your hardware setup.

5 Tap on the Details button. 

The phone driver will automatically fill in the speed and initialization string, and you 
will probably not have to adjust these parameters. 
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NOTE: The initialization string is dependent on the carrier hardware, rather than the type 
of phone.

6 Tap OK.

7 In the Confirmation screen, choose whether you want this configuration to be the 
default for your phone applications.

Setting up Phone preferences
Use the Phone Preferences panel to select the connection profile you configured in 
the Connection panel. These settings will be applied when you use Phonebook access 
and voice applications. 

1 In the Phone Preferences panel, tap the Connection pick list.

2 Select Infrared to GSM Phone or Serial to GSM Phone, according to your hardware 
setup. 

The details of you connection should already be set up, based on what you picked in 
the Connection pick list. However, you can edit this information from this pick list.

If no connection methods are available, then None is shown in the pick list. This means 
that no phone drivers exist on your handheld. In this case you must install the phone 
driver on your computer then HotSync it to your handheld.

If your phone is enabled and connected, you can test the connection by tapping on 
the Test button. This initiates a simple query of the phone to make sure the 
connection is working and the correct phone is being used.

ShortCuts preferences
You can use the ShortCut preferences to create Graffiti ShortCuts of up to 45 
characters. For example, you could create a ShortCut for your name or for the header 
of a memo. All ShortCuts you create appear on the list in the ShortCut Preferences 
dialog box and are available in any of your handheld applications. This list is backed 
up on your computer when you perform a HotSync operation. 

Tap here.
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For more information on how to use ShortCuts, refer to "Using Graffiti ShortCuts" on 
page 6.

To create a ShortCut
1 In the ShortCut Preferences panel, tap New to display the ShortCut Entry screen.

2 In the ShortCut Name line, enter the letter(s) you want to use to activate the ShortCut.

3 In the ShortCut Text line, enter the text that will appear when you write the ShortCut 
character(s). 

You can add a space character after the last word in your ShortCut text, so that a 
space automatically follows the ShortCut text.

4 Tap OK.

Tap here.

Tap here after entering name 
and text for new ShortCut.
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11 Frequently Asked 
Questions
If you encounter a problem with your Acer handheld, do not call Technical Support 
until you have reviewed the following list of frequently asked questions, and you have 
also reviewed the following:

• The README file located in the folder where you installed the Palm Desktop 
software on your Windows computer

• The Helpnote folder located in the folder where you installed the Palm 
Desktop software on your Windows computer

• The Palm Desktop online Help
• The most recent Acer handheld help on your regional Acer web site

If you are still having problems, contact your local dealer or distributor.  You may also 
access the Acer web site at http://www.acer.com/ for information on how and where 
to contact the service centers available in your area.

For software developers interested in designing applications for Acer handhelds, 
please visit http://handheld.acer.com.tw/ 

NOTE: Thousands of third-party add-on applications have been written for the Palm OS 
handhelds. Unfortunately, we are not able to support such a large number of third-party 
applications. If you are having a problem with a third-party application, please contact the 
developer or publisher of that software.

http://www.acer.com
http://handheld.acer.com.tw
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Software installation problems

Problem Solution

I cannot install the Palm Desktop 
software on my Windows computer.

Try the following:

1 Disable any virus scanning software on your computer.
2 Press Ctrl-Alt-Delete and end all tasks except Systray and 

Explorer.

NOTE: If a dialog box with buttons appears instead of a list of tasks, 
click the Task List button and then end all tasks except Systray and 
Explorer.

3 Make sure your computer has at least 30 MB of disk space 
available.

4 Delete all temporary files.
5 Run ScanDisk on your computer.
6 Reinstall Palm Desktop software.
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Operating problems

Problem Solution

I don’t see anything on my handheld 
screen.

Try each of these in turn:

• Press an application button to ensure your handheld is 
turned on.

• Tap the Brightness Control icon  on the upper-left 
corner of the Graffiti® writing area. In the Adjust 
Brightness dialog box, adjust the brightness level by 
holding down the up scroll button for a few seconds. If 
this doesn’t work, hold the down scroll button for a few 
seconds.

• If your handheld was exposed to the cold, make sure it is 
at room temperature.

• Recharge the unit.
• Perform a soft reset. If your handheld still doesn’t turn 

on, perform a hard reset. See "Resetting your Acer 
handheld" on the Acer s50 and s60 Handhelds 
Quick Guide for instructions. 

IMPORTANT: WIth a hard reset, all records and entries stored in your 
handheld are erased. Never perform a hard reset unless a soft reset 
does not solve your problem. You can restore any data previously 
synchronised with your computer during the next HotSync operation. 

I get a warning message telling me 
memory in my handheld is full.

• Purge records from Date Book and To Do List. This deletes 
To Do List items and past Date Book events from the 
memory of your handheld. See "Purging records" on 
page 32. 
You may need to perform a HotSync operation to recover 
the memory. Refer to "9 Exchanging and updating data 
using HotSync operations" on page 213.

• Delete unused memos and records. If necessary, you can 
save these records. See "Deleting records in your basic 
applications" on page 31.

• If you have installed additional applications on your 
handheld, remove them to recover memory. See "To 
remove an add-on application from your handheld" on 
the Acer s50 and s60 Handhelds Quick Guide.

My handheld keeps turning itself off. Your handheld is designed to turn itself off after a period of 
inactivity. This period can be set at one, two, or three minutes. 
Check the Auto-off setting on page 247.

My handheld is not making any sounds. Check the system and game sound settings. Refer to page 248. 
You can also check the alarm sound settings on page 232.
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Tapping and writing problems

Problem Solution

The LED indicator is not blinking when 
alarms occur.

Check the Alarm LED setting. See "To set the alarm LED settings" 
on page 233.

My handheld has frozen. Perform a soft reset. For instructions, refer to "Performing a soft 
reset" on the Acer s50 and s60 Handhelds Quick Guide.

Problem Solution

When I tap the buttons or screen icons, 
my handheld activates the wrong 
feature.

Calibrate the screen. See "Digitizer preferences" on page 244.

When I tap the Menu icon , nothing 
happens.

Not all applications or screens have menus. Try changing to a 
different application.

I cannot get my handheld to recognise 
my handwriting. 

• For your handheld to recognise handwriting input with 
the stylus, you need to use Graffiti writing. See "Entering 
data using Graffiti" on page 1.

• Make the Graffiti character strokes in the Graffiti writing 
area, not on the display part of the screen.

• Write Graffiti strokes for letters in the left-hand side, and 
the strokes for numbers in the right-hand side of the 
Graffiti writing area.

• Make sure that Graffiti is not shifted into extended or 
punctuation modes. See "Entering data using Graffiti" on 
page 1.

• See "Graffiti tips" on page 8 for tips on increasing your 
accuracy when you write Graffiti characters.
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Application problems

Problem Solution

I tapped the Today button, but it does 
not show the correct date.

Your handheld is not set to the current date. Make sure the Set 
Date box in the Date & Time Preferences panel displays the 
current date. See "Date & Time preferences" on page 242 for 
more information.

I know I entered some records, but they 
do not appear in the application.

• Check the Categories pick list (upper-right corner). 
Choose All to display all records for that application.

• Check Security and confirm that Private Records is set to 
Show private records.

• In To Do List, tap Show and see if Show Only Due Items is 
selected.

I am having problems listing memos the 
way I want to see them.

• If you cannot manually arrange the order of the memos 
in the list screen, check the Memo Preferences setting. 
Make sure that Sort by is set to Manual.

• If you choose to view your memos alphabetically on Palm 
Desktop software and then perform a HotSync operation, 
the memos on your handheld still appear in the order 
defined in the Memo Preferences setting. In other words, 
the sort settings you use with Palm Desktop software are 
not transferred to your handheld.

I created an event in Date Book, but it 
doesn’t appear in the Week View.

In the Week View, you cannot select overlapping events that have 
the same start time. If you have two or more events with the same 
start time, choose the Day View to see the overlapping events.

I entered the euro symbol, but after a 
HotSync operation it doesn’t appear in 
my Palm Desktop software.

You must have fonts that include the euro symbol on your 
computer. Check this web site for additional information:
http://www.microsoft.com/windows/euro.asp/.

www.microsoft.com/windows/euro.asp/
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HotSync problems

Problem Solution

I cannot do a HotSync operation; what 
should I check to make sure I am doing 
it correctly?

• Make sure the cradle/cable is connected securely.

On a Windows computer, try these steps:

• Check the Windows system tray to make sure the HotSync 

Manager is running (i.e., the HotSync Manager icon  is 
visible in the bottom right corner of the Windows system 
tray). If it is not, open Palm Desktop software.

• Make sure you selected Local USB or Local Serial, as 
appropriate, from the HotSync Manager menu.

• If you are using the optional Serial Sync Cable, make sure 
you selected the correct serial port on the Local tab in the 
Setup dialog. It should be set to the port where you 
connected the cable.

I did a HotSync operation, but one of 
my applications did not synchronise.

On a Windows computer, click the HotSync Manager icon  and 
choose Custom. Check that the correct conduit is active.

I am using Microsoft Outlook as my PIM, 
but I cannot do a HotSync operation. • Click the HotSync Manager icon  and choose Custom. 

Check that the correct conduit is active.
• Check that Intellisync Lite (conduit for Microsoft Outlook) 

is installed and properly configured. If it is not, use the 
Acer s50 and s60 Handhelds Installation CD to install and 
configure Intellisync Lite in your computer. 

I cannot launch the HotSync Manager. • If you are using the optional Serial Sync Cable, make sure 
you are not running another program, such as America 
Online, CompuServe, or WinFax, that uses the serial port 
you selected in the Setup dialog box.

• Backup the Palm Desktop software, uninstall it, then 
reinstall it.
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I tried to do a local HotSync operation, 
but it did not complete successfully.

• Make sure your handheld is properly seated in the cradle.
• Check the connection between the cradle and the USB (or 

serial port, if you are using the optional Serial Sync Cable) 
on your computer.

• Make sure the user name you selected in Palm Desktop 
software matches the user name assigned to your 
handheld.

• Make sure the date on your computer matches the date 
on your handheld.

• Read the HotSync Log for the user account for which you 
are performing a HotSync operation.

On a Windows computer, try each step in turn:

• Make sure HotSync Manager is running. If it is running, 
close it, and restart it.

• Make sure you selected Local USB or Local Serial, as 
appropriate, from the HotSync Manager menu.

• If you are using a Serial Sync Cable: 
– Make sure you selected the correct serial port on the 

Local tab in the Setup dialog. It should be set to the 
port where you connected the cable.

– Try a lower baud rate setting on the Local tab in the 
Setup dialog.

– Make sure you are not running a program, such as 
America Online, CompuServe, or WinFax, that uses 
the serial port you selected in the Setup dialog box.

I cannot perform an IR HotSync 
operation.

• On a Windows computer, be sure the HotSync Manager is 
running and the Serial Port for local operations is set to 
the simulated port for infrared communication. See "IR 
HotSync operations" on page 220 for details.

• On your handheld, be sure the HotSync application is set 
to Local, with the option IR to PC/Handheld.

• Be sure the IR port of your handheld is aligned directly 
opposite to, and within a few inches of, the infrared 
device of your computer.

• IR HotSync operations do not work after you receive a 
low battery warning, check the battery power of your 
handheld. Recharge the unit.

My handheld seems to freeze when I 
place it near my computer.

Move your handheld away from the computer’s infrared port.

When I press the HotSync button on the 
cradle, nothing happens on Palm 
Desktop software and my handheld 
times out.

• Make a copy of your Palm folder. Uninstall, then reinstall 
Palm Desktop software.

• Turn on your handheld and tap the Applications icon . 

Tap the HotSync icon , then tap Local.

Problem Solution
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Beaming problems

When I perform a HotSync operation, 
my information does not transfer to 
Palm Desktop software.

• If you have performed a HotSync operation successfully, 
but you cannot find the data from your handheld on 
Palm Desktop software, check to see you have the correct 
user name selected for viewing data.

• On the Windows system tray, click the HotSync Manager 

icon  and choose Custom. Check that all conduits are 
set to synchronise files.

My handheld displays the message 
"Waiting for sender" when it’s near my 
computer’s infrared port.

• Your computer’s infrared port may be set to search 
automatically for the presence of other infrared devices. 
Consult the documentation for your operating system for 
information about turning off this option.

• In some cases, simply moving your handheld away from 
the computer’s infrared port solves the problem.

I want to synchronise my computer with 
more than one handheld.

If the computer running Palm Desktop software synchronised with 
more than one handheld, each handheld must have a unique 
name. Assign a user name to your handheld the first time you 
perform a HotSync operation. See "Creating a user profile" on 
page 213. 

IMPORTANT: Please be aware that synchronising more than one 
handheld with the same user name causes unpredictable results and, 
potentially, loss of information on your handheld.

Problem Solution

Problem Solution

I cannot beam data to another Palm OS 
handheld.

• Confirm that your handheld and the other Acer handheld 
are between ten centimeters (approximately 4”) and one 
meter (approximately 39”) apart, and that the path 
between the two handhelds is clear of obstacles. Beaming 
distance to other Palm OS handhelds may be different.

• Move your handheld closer to the receiving handheld.

When someone beams data to my 
handheld, I get a message, telling me it 
is out of memory.

• Your handheld requires at least twice the amount of 
memory available as the data you are receiving. For 
example, if you are receiving a 30K application, you must 
have at least 60K free.

• Perform a soft reset. Refer to "Performing a soft reset" 
on the Acer s50 and s60 Handhelds Quick Guide.
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Recharging problems

Password problems

Problem Solution

When I place my handheld in the cradle, 
the LED indicator does not go on.

• Confirm that your handheld is well seated in the cradle, 
• Confirm that your AC adapter is properly connected to 

the back of the cradle’s power jack. 
• Confirm that your AC adapter is plugged into an AC 

outlet that has power.
• Confirm that the cradle is properly connected to a USB 

port in your computer.

Problem Solution

I forgot the password, and my handheld 
is not locked.

First, use the password hint to try and remember the password. If 
this does not help, or if you do not have a password hint, you can 
use Security to delete the password, but all entries marked as 
private are deleted. However, if you perform a HotSync operation 
before you delete the password, the HotSync process backs up all 
entries, whether or not they are marked private. Then, you can 
follow these steps to restore your private entries:

1 Use the Palm Desktop software and the cradle or infrared 
communication to synchronise your data.

2 Tap Forgotten Password in Security to remove the 
password and delete all private records.

3 Perform a HotSync operation to synchronise your data 
and restore the private records by transferring them from 
your computer to your handheld.

I forgot the password and my handheld 
is locked.

First, use the password hint to try and remember the password. If 
this does not help, or if you do not have a password hint, you must 
perform a hard reset to continue using your handheld. For 
instructions, see "Performing a hard reset" on the Acer s50 
and s60 Handhelds Quick Guide.
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Technical support
If, after reviewing the sources listed at the beginning of this appendix, you cannot 
solve your problem, contact us at http://www.acer.com/. 

Before requesting support, please experiment a bit to reproduce and isolate the 
problem. When you do contact support, please be ready to provide the following 
information:

• The name and version of the operating system you are using
• The actual error message or state you are experiencing
• The steps you take to reproduce the problem
• The version of the Acer handheld you are using and available memory
• The product ID of your Acer handheld (the 12-digit number indicated on your 

handheld’s rear panel)

Finding version and memory information
1 In Applications Launcher, tap the Menu icon  to display the menu bar. 
2 Tap App, then select Info.
3 Tap Version to see version numbers, and tap Size to see the amount of free 

memory in kilobytes.

NOTE: Thousands of third-party add-on applications have been written for the Palm OS 
handhelds. Unfortunately, we are not able to support such a large number of third-party 
applications. If you are having a problem with a third-party application, please contact the 
developer or publisher or that software

http://www.acer.com
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